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Introduction

Welcome  Welcome to Gentran:Server® for Windows®, the Sterling Commerce Electronic
Data Interchange (EDI) software for the Windows operating system.

Gentran:Server provides you with the easy-to-use tools you need to electronically
exchange data with your trading partners, including:

» Data translation

» Process control

» Communications system

We believe that you will find this software and the supporting materials easy to
use and directly beneficial to your business.
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What’s in this Manual

Introduction  This manual is intended to support the online Help by assisting you in performing
various tasks in Gentran:Server. This task-oriented approach is intended to answer
any questions you may have about Gentran:Server with step-by-step instructions.

Intended  This manual is intended for the staff responsible for the following:

audience

Implementing EDI

Setting up trading partner relationships
Creating and using EDI documents
Sending and receiving documents
Acknowledging documents

Tracking document flow

Configuring and using unattended processing

Prerequisite  This manual assumes that you are familiar with using a PC and with Microsoft®
knowledge = Windows or Windows 2000 functions.

Description of  This User s Guide contains the following chapters:

contents

Chapter 1, Getting Started, explains the content, organization, and
conventions in this guide. This chapter also describes how to get technical
support introduces Gentran:Server for Windows.

Chapter 2, Using Translation Objects, explains how to register (install),
delete, and view translation objects.

Chapter 3, Using Partners, explains how to set up a complete partner profile.
This chapter describes how to import and export a partner profile and partner
tables, and describes how to copy a partner profile.

Chapter 4, Using Documents, explains all facets of managing your
documents.

Chapter 5, Using Communications, explains how to send, receive, and resend
documents, and how to view the Send Queue.

Chapter 6, Using Interchanges, explains how to view interchanges and the
documents within interchanges, how to filter the display of interchanges, how
to attach (link) an interchange to a partner, and how to resend interchanges.

Chapter 7, Using External Data, explains how to view and print external data
files.

Gentran:Server for Windows User’s Guide Gentran:Server for Windows — November 2005 (



Description of
contents
(contd)

Online Help

Chapter 8, Using Acknowledgements, explains how to manually set a
document, group, or interchange to acknowledged, how to define inbound and
outbound acknowledgement criteria for document reconciliation, and how to
check for overdue acknowledgements.

Chapter 9, Using Tracking, explains how to view and print tracking
information.

Chapter 10, Using Archive and Restore, explains how to archive data and
restore archived data to the system.

Chapter 11, Using Process Control, explains how to create, edit, delete,
activate, and suspend automatic process control events. This chapter also
describes how to use sessions and calendars.

The Glossary contains definitions of EDI and Gentran:Server terms and
concepts.

The majority of the documentation for Gentran:Server is contained in the Online
Help system. This includes all dialog box element definitions, detailed processing
information, and the “how to” information that is contained in this manual.

6
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Getting Support

Introduction  The Sterling Commerce Gentran:Server software is supported by trained product
support personnel who are available to help you with product questions or
concerns.

Note

Gentran:Server Customer Support does not support non-Sterling Commerce
products (such as SQL Server and Oracle), but can assist you in configuring
non-Sterling Commerce products to work with Gentran:Server.

Phone number  For assistance, please refer to the Getting Started Guide to determine which
support phone number you should use.

Before calling  To help us provide prompt service, we ask that you do the following:

support )  Attempt to recreate any problem that you encounter and record the exact
sequence of events.

»  When you call product support, you should be prepared to provide us with the
information below.

Information Description

Identification Your company name, your name, telephone number
and extension, and the case number (if the question
refers to a previously reported issue)

System Configuration The Gentran:Server version (and any service packs
installed) and information about the primary
Gentran system controller and all machines
experiencing problems, including the Windows
operating system version, amount of memory,
available disk space, database version, Microsoft
Data Access (MDAC) version, and Internet Explorer
version

Also, please describe any recent changes in your
hardware, software, or the configuration of your
system.

System Data Store Which machines contain folders in the system data
store?

(Continued on next page)
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Information Description

Error Messages Record the exact wording of any error messages you
receive and the point in the software where the error
occurred, as well as any log files.

Attempted Solutions Record any steps that you took attempting to resolve
the problem and note all the outcomes. Provide an
estimate on how many times the problem occurred
and whether it can be reproduced.

Accessing the  The Sterling Commerce Customer Support Web Site contains valuable

Sterling  information about getting support for Gentran:Server for Windows, including the

Commerce following:
Support Web  »  Scope of support services
Site ,  Customer support policies

» Call prioritizing
» Customer support phone directory
» Creating new Support on Demand cases
» Checking the status of Support on Demand cases

» Adding information to Support on Demand cases

The Customer Support Web site is constantly updated and all Sterling Commerce
customers have access to it. This web site also contains the most recent product
updates and is a valuable source of product information.

Reference
Refer to the Getting Started Guide for information about how to access the
Customer Support Web site.

Documentation  The Customer Support Web site contains a documentation library, which contains
the entire Gentran:Server for Windows documentation set. You can download the
product manuals in PDF format from this library at any time.

( Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide
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Introducing Gentran:Server for Windows Getting Started

Introducing Gentran:Server for Windows

Overview

System

components

Database

System data store

Gentran:Server for Windows is a combined data translation, process control, and
communication system that operates within the Microsoft Windows environment.
This product is primarily designed for the translation and communication of EDI
and other similar types of data.

Through the process control system, you can integrate Gentran:Server with a wide
variety of business applications in a manner that makes it a complementary
extension of the applications, rather than a cumbersome add-on.

The Gentran:Server system consists of several logical components.
Gentran:Server can be deployed in many ways in this environment through a
combination of a database, system data store, process controllers, communication
controllers, and user interface clients.

Mandatory components
Each system must have a primary Gentran system controller, system data store,
and a database.

The database is the relational database that Gentran:Server uses to store system
data. This database enables multiple users to access the same data. The other
components of the product interact with this database using ODBC™ (Open
Database Connectivity), which allows for many different database management
systems on the database controller.

Reference
See the Getting Support card to determine which database management systems
have been certified for use with Gentran:Server.

The system data store serves as the repository of all shared Gentran:Server data.
The system data store may reside on any machine that is a file server to the
machines in the Gentran:Server system. There is only one system data store in the
Gentran:Server system, but the associated folders and files may be distributed
across multiple machines, if necessary.

Note
The machines where the system data store resides must be accessible by all
machines in the Gentran:Server system.

( Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Getting Started Introducing Gentran:Server for Windows

Process  There are two types of controllers in the Gentran:Server system:
Controllers , A single primary system controller

» One or more secondary controllers (if required)

Primary system  The primary system controller controls the management and dispatching of
controller  processing requests within the system, manages the audit functionality, and
controls all other system components.

Secondary  If you purchased a distributed license, you can deploy additional controllers

controllers  (secondary controllers) across the Windows network to allow the processing load
to be distributed for fast and efficient throughput. The secondary controller can be
either or both of the following:

Process controller

The process controllers provide similar functions to the primary system controller.
They are controlled by the primary system controller and are used to distribute
processes across multiple machines in a Windows network.

Communication controller

The communication controllers regulate communication between Gentran:Server
and the organizations (value-added networks (VANSs) or trading partners) with
whom data is exchanged. The communication controllers can support leased or
dialed connections, as well as interaction with third-party communication
packages using the file interface capability.

A communication controller is installed via a communications gateway.

User interface  The user interface clients provide the functions that are necessary to monitor and
clients control the system. The main data management component provides a graphical
user interface to the following:

» Document locations

» Partner profiles

» Communication setup and logs
» System Audit Log

» Process control setup and management

Gentran:Server for Windows User’s Guide Gentran:Server for Windows — November 2005 ()



Introducing Gentran:Server for Windows Getting Started

User interface
client
components

Logical
components

The five main components of the Gentran:Server user interface client are the
following:

» The Electronic Commerce (EC) Manager window is a data management
component that serves as a high-level navigation tool, as well as a document
management tool. The EC Manager also provides access to the Partner Editor,
the Document Editor, Application Integration, and Forms Integration.

» Partner Editor allows you to define, edit, and delete all partner information
for your company and for all of your trading partners.

» Document Editor is your data entry tool. It allows you to create, modify, and
view documents.

» Application Integration is a subsystem that enables you to generate import,
export, and document turnaround translation objects.

» Forms Integration is a subsystem that enables you to generate screen entry
and print translation objects.

The user interface client and controller components are the logical components of
the Gentran system. These components can be deployed on a single machine or
over a number of machines, depending on your needs.

Typical system

Typically, your system initially consists of a small number of machines operating
as Gentran:Server user interface clients, and a larger, more powerful machine
operating as a combined primary system controller/communication controller/
process controller.

After you complete the necessary translation objects for your installation (using
Application Integration), you can add other process controllers and
communication controllers as required, to distribute the processing workload.

6
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Getting Started

Logical
components
(contd)

Multiple Controllers

Introducing Gentran:Server for Windows

System component interaction diagram

The following diagram illustrated the interaction of the logical components of the
Gentran:Server system:

Installed Components:

B Process Controller (default)
m Client Access Components
B Integration Components

Primary Gentran System Controller

FSystem T N 7 .

Database Gentran:

Data Server
Store

Windows 2003, Enterprise Edition

Secondary Controller 1

User Interface

User Interface

Secondary Controller 2

Client Client
Gentran: Gentran: Gentran: Gentran:
I Server Server Server Server 4 I
‘é‘ﬁﬂf’é’f 2003, Standard Windows 2000 Windows XP Windows 2000 Server
Professional Professional

L 94

Installed Components:

m Client Access Components
m Integration Components

Installed Components:
W Process Controller
M Client Access Components

Gentran:Server for Windows User’s Guide
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B Process Controller (default)
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Navigating in Gentran:Server Getting Started

1-6

Navigating in Gentran:Server

Overview  The Gentran:Server Electronic Commerce (EC) Manager window allows you to
access its functionality in the following ways:

» Select the menu option from the Main Menu Bar.

»  Click the appropriate button on the Main Toolbar.

»  Click the appropriate button on the Browser Toolbar.

» Click the appropriate part of The Desk.

» Click the appropriate button within a chosen browser window.
Note

The Electronic Commerce Manager display is refreshed when you press F5 or
click Refresh (available on most browsers).

Electronic = The following illustrates the Gentran:Server EC Manager window:

Commerce

Manager window

Control Menu Title Bar Minimize/Maximize Buttons

‘ G entran:Server Windows on system GENSYS1 ol =l
[

— g Edit View Document Commands Tools Options Window Help

| SE &8s BI@IJ A [Cl-wB] T | 8] ¢

In ¥

Waorkspace
Transmit
Process Control
External Data

Partners

Restored Dala
Help Exit

Status Bar The Desk

Main Toolbar

—— Main Menu Bar

Browser Toolbar
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Getting Started Navigating in Gentran:Server

Components  The following are the components of the main Gentran:Server window:

Control menu
The Control Menu contains the following commands: Restore, Move, Size,
Minimize, Maximize, and Close.

Title Bar

The Title Bar contains the name of the application and, on the Gentran:Server
desktop, it displays the name of the system you are logged in to. You can use this
to move the position of the Gentran:Server EC Manager window on your desktop.

Minimize/Maximize buttons
The Minimize button reduces the window to an icon. The Maximize button
enlarges the window to its maximum size.

Main menu bar

The Main Menu Bar contains the drop-down menus. Detailed descriptions of each
of the commands on these menus are found in the Online Help. Unavailable items
are dimmed.

Main toolbar

The Main Toolbar gives you access to some of the most common browsers and
functions in Gentran:Server. Unavailable items are dimmed. The Main Toolbar is
a dockable toolbar, so you can affix it to any edge of the EC Manager window.
The following illustrates the Main Toolbar.
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Browser toolbar

The Browser Toolbar gives you access to the functions that are available from
browsers in Gentran:Server. Unavailable items are dimmed. The Browser Toolbar
is a dockable toolbar, so you can affix it to any edge of the EC Manager window.
The following illustrates the Browser Toolbar:
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The Desk

The Desk is a graphic representation of the Gentran:Server components and
document locations. It provides a quick and easy way to access some of the most
commonly used browsers, functions, and subsystems of Gentran:Server. You can
click the appropriate part of The Desk any time you need to access a browser,
function, or subsystem represented on The Desk.

Some of the browser icons display a graphic representation of paper if the
document location contains documents. The Desk also allows you to access the
Partner Editor subsystem, the Help system, the Process Control function (clock
icon), and the Send/Receive functions (phone icon), and allows you to quit
Gentran:Server (Exit/door icon).

Status bar

The Status Bar displays status information about a selection, command, or
process, defines menu items as you highlight each item in the menu, and indicates
any current keyboard-initiated modes for typing (e.g., CAP for the “Caps Lock”
key, NUM for the “Num Lock” key).

6
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Gentran:Server Data Translation Process

Translating  The following illustrates the inbound translation process:
inbound data

diagram
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-
Temporary
Storage
-
[ Temporary |
| . Storage |\
> /
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Translator
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Translating  The system uses the following process to translate inbound data:.

inbound data

process Stage

Description

1

The Communicator receives interchanges from your trading partners
via a network.

The Communicator passes the interchanges to the translator.

The translator uses a system interchange break translation object to
unwrap the interchange envelopes and separate each group into
temporary storage.

The translator uses a system group break translation object to
unwrap the group envelopes and separate each transaction set into
temporary storage.

The translator uses a system transaction break translation object to:
» Unwrap the transaction envelopes.

» Separate each document into a separate file on the system data
store.

» Write a record to the database with reference information about
the document.

Does the translator locate a trading relationship for each document?

» Ifyes (atrading relationship is located), the translator attempts
to identify the export, document turnaround, or print translation
object associated with that relationship. If the translator does
locate a trading relationship and translation object, it uses that
translation object to compliance check the document.

» Ifno (the translator does not locate the trading relationship or
translation object), the document is marked as not compliant and
is moved in the ?In Documents.

Is the document is compliant with the EDI standard?

» Ifyes, the translator changes the document status to compliant
and moves the document in the In Documents.

» Ifno, the document remains in the ?In Documents. The
translator writes a detailed error report to help you to determine
the problem that was encountered.

(Continued on next page)
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Stage Description

8 In the trading relationship, if you specify that the system needs to
generate a functional acknowledgement for a document, the
translator uses the system acknowledgement translation object to
generate the acknowledgement.

» Compliant acknowledgements are moved to the Out Documents
to be sent.

» Non-compliant acknowledgements are moved to the ?Out
Documents. If an error occurred with the acknowledgement
translation object, the acknowledgement is also moved to the
?0ut Documents.

The translator also reconciles acknowledgements if you receive an
acknowledgement-type transaction (such as 997 or CONTRL).

9 If you specified either automatic export or automatic turnaround in
the trading relationship, the translator uses the specified export or
document turnaround translation object to either export or generate
the appropriate response document.
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Translating  The following illustrates the outbound translation process:

outbound data
diagram
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Gentran:Server Data Translation Process

Translating  The system uses the following process to translate outbound data:

outbound data
process Stage

Description

1

Use one of the following processes to initiate outbound translation:

» Import a file through the process control system using a timed or
polled session. This writes all valid documents to the database
with a compliant status and locates the documents in the Out
Documents. Invalid documents are marked with a
non-compliant status and located in the ?Out Documents.

» Import an application file. Documents that you import manually
are located in the Workspace.

» Use the Document Editor to enter documents (if there is an
appropriate data entry translation object registered with
Gentran:Server). These documents are located in the Workspace.

If you import a file, the translator checks the import definitions from
the system configuration to match the file name with a system
import translation object.

The translator uses the system import translation object to determine
which trading relationship (established in Partner Editor)
corresponds to each document in the application file, so the system
knows which import map to use to process the document.

After the translator determines which trading relationship
corresponds with a document in the file, it ascertains which import
translation object is specified in that relationship.

The translator uses the import translation object to compliance check
the document. If the document is compliant (valid), it is marked
“OK.” If the document is not compliant (invalid), it is marked
“NotOK.”

If there is another document remaining in the import file, the
translator repeats steps 3 - 5 until all documents are processed.

If you manually import a file through the EC Manager or use the
Document Editor, you need to post the compliant document to the
Out Documents.

Note

Once documents are located in the Out Documents, they can be sent
using the process control system or by using the EC Manager
transmit option.

Gentran:Server for Windows User’s Guide
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Getting Started

Changing your Password

Introduction  Your Gentran:Server password is stored in your User Access profile.

Notes

»  You must know your old password to change it. If you have forgotten your
password, please contact your system administrator.

» Ifyou are using Integrated security, you may also need to change your
Gentran:Server and database passwords if you change your Windows
password.

Reference

See your system administrator if you have any questions about which security
mode you use.

Procedure  Use this procedure to change your password.

Step

Action

1

From the Options menu, select Preferences.

System response
The Preferences dialog box is displayed.

Select the Change Password tab to access that option.

In the Old Password box, type your old password.

In the New Password box, type your new password.

In the Confirm New Password box, type your new password again.

Note
If the Confirm New Password does not match the New Password,
you will be prompted to type it again.

Once complete, click OK to save the changes.

System response
The system is updated and the next time you log on to the system
you will need to enter the new password.
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Overview

Overview

In this chapter

Translation
object definition

Creating
translation
objects

Types of
translation
objects

Using Translation Objects

This chapter describes how to use translation objects with Gentran:Server.

A translation object is a set of definitions, links, and rules that combine to provide
the translator with all the information necessary to convert data from one format
to another. Translation objects are used in Gentran:Server to control the
processing of the translator subsystem.

Translation objects are created by compiling an application map or a form
definition using the Application or Forms Integration subsystem in
Gentran:Server.

Reference
See the Application Integration Users Guide and Forms Integration Users
Guide more information about those subsystems.

There are two types of translation objects:

System translation objects

System translation objects control the creation and separation of
interchanges, functional groups, and transaction sets. They are also used to
generate and reconcile functional acknowledgements.

User translation objects

User translation objects control screen entry, importing, exporting, and
creating printed reports. All required system translation objects are
automatically installed with the Gentran:Server system.
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EDI Translation Object Browser

Introduction  The following lists the system components that comprise the EDI Translation
Object feature.

Browser or
Dialog box Function

EDI Translation | Allows you to view, print, delete, or register translation

Object objects.

Register Allows you to select translation objects to be registered with
Translation the system.

Object

EDI Translation  The following illustrates the EDI Translation Object browser.

Object browser
* EDI Translation Object - 443 M= E3

diagram
Type | Diezcription | Uzed
FZEwvild G5 Build Templa...  5YS ;
FGELld GS Buid Templa... 55 Pl
FGEwild G5 Build Templa... 5SS Delete
FGEwild ACD_Grp Bl S5 _ |
FGBRuild G5 Buld Templa...  SYS Mew. ..
|mpaort PETE 211NV, “es —
|mpaort PET T ANADDT ... “Yes
|mpaort 310junk2 Mo
|mpaort PET_&10 Mo
|mpaort PET = 3030 810... “Yes
|mpaort Flat_File_To_*C... Mo
|mpaort PET = 3030 810... “es
|mpaort PETE 921 IMNYV... “es
|mpaort PET T AMADDT ... Mo
|mport Flat_File_To_®=C... “es - Refresh
“| | H -
Cloze
443 Translation = 1 selected
- Help

Parts and  The following lists the parts of the EDI Translation Object browser and their
functions  functions.

Part Function

Type Describes the type of translation object defined, such as export,
import, or system import.

Description | Displays a description that further identifies the translation object.

(Continued on next page)
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Part

Function

Used

Indicates whether the translation object is currently
associated with an Inbound or Outbound Partner
Relationship. Valid values are:

» Yes—Indicates the translation object is in use.
» No—Indicates the translation object is not in use.
» SYS*—Indicates a system translation object that is in use.

» SYS—Indicates a system translation object that is not in use

Note

If a translation object is currently used (associated with an
Inbound or Outbound Partner Relationship), you cannot delete it.
Also, the system prevents you from deleting translation objects
that are designated as system translation objects (SYS* or SYS).

System Translation Objects are all translation objects except
Import, Export, Data Entry, Screen Entry, Turn Around, and Print.
Also, any translation object with “system” in the description is a
system translation object.

View

Displays a window containing descriptive information for the
selected translation object, including the following:
Description of the translation object

Type of translation object (for example, Export)

Input and output agency (for example, X for ANSI X12)
Input and output version (for example, 003030)

Input and output transaction ID (for example, 850)

Input and output release (for TRADACOMS only)

File name of the translation object (for example, 3030.tpl)

Print

Displays the Print Choice dialog box, which allows you to specify
whether you want to print the selected translation objects or print a
summary list of the selected translation objects.

Note
The Formatted option is unavailable because a formatted
version is always printed when for a translation object.

Use this table to determine your next step.

Delete

Removes the selected translation object or objects.

New

Displays the Register Translation Object Dialog Box, which
allows you to identify a translation object to the system.

Refresh

Refreshes the browser display.

(Continued on next page)
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EDI Translation Object Browser

Part

Function

Close

Exits the EDI Translation Object browser.

Help

Accesses Online Help.
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Register Translation Object Dialog Box

Introduction  The Register Translation Object dialog box enables you to register a selected
translation object file with Gentran:Server (identify the translation object to the
system).

Diagram  The following illustrates the Register Translation Object dialog box:

Lockin: | TransObj =] cf

File name: I

Files of tpe: ITransIatiu:un Obijects [*.tpl] j Cancel |

Parts and  The following lists the parts of the Register Translation Object dialog box and
functions their functions:

Part Function
Look in Specify the drive and folder where the file is located.
File name Specify the name of the file that you want to register.
Files of type Specify the type of file that you want to access.
Note
The file extension for translation objects is .TPL.
Open Selects the chosen file and exits the Open dialog box.
Cancel Exits the Open dialog box without selecting a file.
Help Accesses Online Help.
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Registering New Translation Objects

Introduction  The Register Translation Object function enables you to register your translation
object file with Gentran:Server so the system can identify the translation object.

Automatic  You can set the auto-register feature to automatically register translation objects
registration  when they are compiled. See How to Set the Auto-register option in chapter 2 of
the Application Integration User s Guide.

Procedure  Use this procedure to register a translation object.

Step Action

1 From the View menu, select Translation Objects.

System response
The system displays the EDI Translation Object browser.

2 Click New.

System response
The system displays the Register Translation Object dialog box.

3 Select the translation object file that you want to register with the
system from the list or type it in the File name box.

Note

To highlight a group of translation objects, click on the first
translation object and then press the SHIFT key and then click
on the last translation object in the group. To highlight several
translation objects that are not adjacent to each other, press the
CTRL key and click on the translation objects.

4 Click Open.

System response
The system registers the translation object files exits the
Register Translation Object dialog box.

Note

If the selected file is invalid, you receive a warning message.
Only valid Gentran:Server translation object files can be
installed.

If the translation object is a duplicate, you are prompted with a
message asking whether or not you want to overwrite the
existing translation object.
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Deleting Translation Objects

Introduction  You can delete old or unused translation objects from the system only if they are
not currently associated with an Inbound or Outbound Partner Relationship (“No”
in the Used column on the EDI Translation Object browser).

The system prevents you from deleting translation objects that are designated as
“system translation objects” (SYS” or SYS).

Procedure  Use this procedure to delete a translation object.

Step Action

1 From the View menu, select Translation Objects.

System response
The EDI Translation Object browser is displayed.

2 Select the translation object or objects you want to delete.

3 Click Delete.

System response
The Delete confirmation dialog box is displayed.

4 Do you want to delete these translation objects?
» Ifyes, click Yes to confirm the delete.

» Ifno, click No to cancel the delete request.
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Using Partners Introduction

Introduction

In this chapter  This chapter explains how to use the Gentran:Server Partner Editor, including:
» Using partner profiles
» Routing partner profiles
» Using partner tables

» Using partner locations

Partner Editor  The Partner Editor allows you to define, edit, and delete all partner relationship
information for your company and all of your trading partners. Partner
relationships allow you to send and receive data to and from your trading partners.

The Partner Editor also allows you to use an internal system partner (Internal
System User) to define your company to the system.

Gentran:Server  See “Using Partner Editor with Gentran:Server for RosettaNet” in the
for RosettaNet  Gentran:Server for RosettaNet User s Guide for more information about defining
partners for use with RosettaNet®.
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Using Partner Profiles

Overview

Introduction  You can set up your partner profiles using any of three methods: importing,
copying, and creating them yourself. The method you use depends on whether you
have a partner profile to use as a starting point, as shown in the following table:

Partner profile

creation method When to use
Import existing Use this method if you receive partner profiles from
profile Sterling Commerce or if you have an existing profile

from which you can import partner details. The profile
can be exported from another copy of the
Gentran:Server system.

Reference
See Importing Partner Profiles on page 3 - 85 for more
information.

Copy existing profile | Use this method when you have an existing profile that
you can copy and then enter a unique partner definition
and key enveloping information for the copied partner.

Reference
See Copying Partner Profiles on page 3 - 88 for more
information.

Create a new profile | Use this method when you do not have a profile to
import or copy.

Reference
See Process of defining a partner profile on page 3 - 5
for more information.

Partner A partner profile begins with a partner definition. The partner definition contains
definition the basic information about that partner that the system needs before you define
the rest of the partner profile. You need to create a partner definition for each
partner with whom you are going to exchange data.
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Partner profile  To complete the partner profile, you need to define an inbound or outbound
relationship or both:

» Ifyou are receiving and processing information from this trading partner, you
need to define an appropriate inbound relationship.

» Ifyou are sending information to this trading partner, you need to define an
outbound relationship.

You need to create a partner profile for each partner with whom you are going to
exchange data.

Process of  The following describes the partner profile creation process:

defining a
partner profile Stage Description

1 Create the partner definition.

Reference
See Creating a Partner Definition on page 3 - 56.

2 If necessary, create the inbound relationship.

Reference
See Creating an Inbound Relationship on page 3 - 58.

3 If necessary, create the outbound relationship.

Reference
See Creating an Outbound Relationship on page 3 - 66.

4 Do you need to use a cross-reference or lookup table with the partner
relationship to supplement or convert data you enter or receive?

» Ifyes, see Creating Partner Tables on page 3 - 103.
» Ifno, continue with stage 5.

5 Do you need to use locations to contain address- and contact-related
information about the partner?

» Ifyes, see Creating Partner Locations on page 3 - 117.
» Ifno, you have completed the partner profile definition process.
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Partner Editor Dialog Box

Introduction  The Partner Editor enables you to define, edit, and delete all partner information
for your company and all of your trading partners.

Diagram  The following illustrates the Partner Editor dialog box:

w- Partner Editor =
Select a Partner:
Internal System L ser
FETZOMET Edit
PETZONEZ ;l
FETZOME Mew
Delete |
Inbound. .. |
Outbound... |
Tahbles... |
Locations... |
Befresh |
Help |
— Proceszes
Copy... Import Export |

Parts and  The following lists the parts of the Partner Editor dialog box and their functions:
functions

Part Function

Select a Partner Displays the list of partner profiles to select from.

Copy Displays the Partner Copy Dialog Box, which allows you
to copy a partner profile.

Import Displays the Import File Select Dialog Box, which allows
you to import a partner profile.

(Continued on next page)
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Partner Editor Dialog Box

Part Function

Export Displays the Export File Build Dialog Box, which allows
you to export a partner profile.

Exit Exits the Partner Editor dialog box.

Edit Displays the Partner Definition (New/Edit) Dialog Box,
which allows you to change information about the selected
partner.

New Displays the Partner Definition (New/Edit) Dialog Box,
which allows you to create a partner definition.

Delete Removes the selected partner profile from the system.

Inbound Displays the Inbound Relationship Dialog Box for the
selected partner.

Outbound Displays the Outbound Relationship Dialog Box for the
selected partner.

Tables Displays the Partner Tables Dialog Box for the selected
partner.

Locations Displays the Location Select Dialog Box for the selected
partner.

Refresh Refreshes the dialog box display.

Help Accesses Online Help.

Gentran:Server for Windows User’s Guide
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Using Partners

Partner Definition (New/Edit) Dialog Box

Introduction  The Partner Definition dialog box enables you to create a new partner definition
or, if you select a previously defined partner definition, it allows you to edit it.
Diagram  The following illustrates the Partner Definition - New dialog box:
Profile D | -
Mame: | Exit
EDI Code: | Help
Application Code; |
Defauk Malbox | GENTRAN Application ] MewMaibos |
Default it b 5
E-mail &ddress I Ml
Parts and  The following lists the parts of the Partner Definition dialog box and their
functions  functions:
Part Function
Profile ID Specify a unique identifier for the selected partner.
Name Specify a unique name for the partner.
Note
Make this name as descriptive as possible, because this is
the name displayed in the partner selection list.

EDI Code Specify the EDI identifier for this partner. The system uses
this value during inbound processing to select the correct
trading partner definition.

Application Code | Specify an application code used to identify this partner.
The system uses this value during outbound import
processing to select the correct trading partner definition.

(Continued on next page)
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Partner Definition (New/Edit) Dialog Box

Part

Function

Default Mailbox

Select a default mailbox to use to identify this partner for
non-RosettaNet EDI relationships.

Reference
See the Communications User s Guide for more
information.

Default E-mail
Address

Specify a default e-mail address to use to identify this
partner for non-RosettaNet EDI relationships.

Reference
See the Communications User s Guide for more
information.

Save

Saves the modified information.

Exit

Exits the Partner Definition dialog box.

Help

Displays Online Help.

New Mailbox

Displays the Create New Mailbox wizard, which allows
you to create a new mailbox.

Reference
See the Communications User s Guide for more
information.

Edit Mailbox

Displays the Mailbox Properties dialog box, which allows
you to edit the mailbox.

Reference
See the Communications User s Guide for more
information.
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Inbound Relationship Dialog Box

Using Partners

Introduction  Inbound relationships define the parameters the system needs to receive an EDI
document from a trading partner. The Inbound Relationship dialog box controls
other subordinate dialogs that allow you to define everything that is necessary to

establish the relationship.

You are required to specify exactly which document is to be received. You also
define which translation objects are used to define the turnaround documents,

export rules, or printing requirements.

Diagram  The following illustrates the Inbound Relationship dialog box with the Advanced

options displayed:

Inbound Relationship - PETZ0ME

Relationship Description:
fInbound Purchase Order ANSI 3030 =]

Standard [x312 |

Wersion: I Q03030 v I

Save

Exit

Delete

Transaction Set; IBSD

HEeleaze: IEI vI

ik

j Tranzlation...

[™ Tranzaction iz an Acknowledgemer

Groups | [ Inbaund 2030 PO Grp

Interchanges | [ Inbound 33030 PO Int

Seguence Checking Last Used Confrel Mumber:

Generate Acknowledgments

& Mone I':'D':'EI
"~ Duplicate

" Incremental
" Chronclogical | [T Skip Compliance Check

[ Duplicate Documents

T ezt Indicatar: " Test & Production

= pio
" Yes - No Enar Detail
" Yes - With Enor Detail

Acknowledgement Processing

" Deferred & Immediate
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Inbound Relationship Dialog Box

The following lists the parts of the Inbound Relationship dialog box and their

Function

Select the existing inbound relationship.

Specifies the EDI standard to be used in this
relationship.

Note

Only standards for which you have existing translation
objects are displayed. This box cannot be changed for an
existing relationship. Selection of this box is mandatory.

Valid values
A - TRADACOMS

C-CI

D - NCPDP

E - EDIFACT

O - ODETTE

P - OTHER

R - ROSETTANET
T-TDCC
U-UCS

V - VDA

X-X12

Parts and
functions functions:
Part
Relationship
Description
Standard
Version

Select the EDI standard version to be used in this
relationship.

Note

Only versions of the selected standard for which you
have existing translation objects are displayed. If this
box is changed for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

Transaction Set

Select the transaction set to be used in this relationship.

Note

Only transaction sets for the selected version for which
you have existing translation objects are displayed. If
this box is changed for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

(Continued on next page)
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Part

Function

Release

Select the release number to be used in this relationship.

Note

Only releases for the selected transaction set for which
you have existing translation objects are displayed. This
box is currently only used for messages defined in the
TRADACOMS standard. Selection of this box is
mandatory for all TRADACOMS messages.

Transaction is an
Acknowledgement

Specify if the transaction defined in this partner
relationship is an acknowledgement.

Groups

Accesses the Inbound Group Select Dialog Box.

Interchanges

Accesses the Inbound Interchange Select Dialog Box.

Sequence Checking

Specify if the system will use sequence checking and
whether sequence checking will be incremental or
chronological. You can also indicate that the system
must check for duplicate control numbers.

» None Do not use sequence checking.

» Duplicate Check for duplicate control
numbers.

» Incremental The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or
detects incremental or chronological control numbers
that are out of sequence, those documents will be put in
the ?In Documents.

Last Used Control
Number

Specify a value that is used to sequence check the next
transaction set control number or message reference.
This value is replaced with the sequence number of the
last transaction set or message received. This box is
initially set to zero.

Note
This box is disabled if Sequence Checking is None.

(Continued on next page)
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Part

Function

Duplicate
Documents

Specify if the system will check for duplicate document
names.

Notes
» Ifthe system detects duplicate document name it
will locate those documents in ?In Documents.

» Ifduplicate document checking is activated for a
relationship the translation object used in this
relationship must update the document name via a
standard or extended rule.

Reference
See the Application Integration User's Guide for more
information about using standard and extended rules.

Skip Compliance
Check

Specify if you want the system to compliance check the
documents for this relationship.

Generate
Acknowledgements

Instructs the system to generate a functional
acknowledgement to this trading partner when you
receive the transaction set (message) defined in this
relationship. The default value for this box is No. Valid
values:

» No
Do not generate acknowledgements.
» Yes - No Error Detail
Generate acknowledgements without error detail.

» Yes - With Error Detail
Generate acknowledgements with error detail.

Note

This entire box is inactive (dimmed) if the document
(transaction set) in this relationship is an
acknowledgement.

Test Indicator

Specify if this relationship definition is in test or
production mode. The default value is Production.

Acknowledgement | Specify if acknowledgement reconciliation will occur

Processing during the inbound break session (Immediate) or during
its scheduled interval (Deferred). The default is
Immediate.

Save Saves the modified information.

Exit Exits the Inbound Relationship dialog box.

(Continued on next page)
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Part Function

New Accesses the New Inbound Relationship dialog box,
which allows you to create a new relationship.

Delete Removes the specified inbound relationship from the
system.

Translation Accesses the Inbound Translation Object Dialog Box.

Advanced Toggles the display of the advanced options.

Help Displays Online Help.
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Inbound Translation Object Dialog Box

Introduction = The Inbound Translation Objects dialog box is used to specify which translation
objects will be used to process the data defined by this relationship.

The following lists the inbound translation levels (from the lowest level up):

Translation Level

Description

Document

Validate the document against the specified translation
object to verify if the document is compliant with the
standard and translate from EDI to print or application
format.

Transaction

Remove the EDI-specific enveloping around a single
document.

Group

Remove the EDI-specific enveloping around a set of
related transactions (the transactions do not have to be
the same type).

Interchange

Remove the EDI-specific enveloping around groups
destined for the same trading partner.
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Diagram  The following illustrates the Inbound Translation Object dialog box with the
Advanced options displayed:

Inbound Translation Objects - PETZ0ONE

Select Translation Objects

Turn Around I j = Eute Save

Ewport File  [PET 3030 850 Export | T Au Edl

Erint I j

Export File Mame
E xport to Mailbox

v Export to Mailbox
[ Use Partrer Default Mailbax and E -mail &ddress

Recipient Mailbos | ] New Maibox |
Recipient E-mail Address I Edit Mailbos |

Content Type/SubType I

i

Help |

Application [D: I

Application &lias Yalue: |85E|

Additional Translation Objects

Impart | =]
DataEnty | =l
Transaction | ST Break Template =~
Acknowledge | =]
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Parts and  The following lists the parts of the Inbound Translation Object dialog box and
functions their functions:

Part Function

Turn Around/ | Displays all turnaround document options. When a document
Auto is received, the turnaround document created is the natural
response document that contains as many elements from the
received document as possible.

Note

Select the Auto check box if you want the defined turnaround
process to be automatic. If the Auto box is not selected, the
received document will remain in the In Documents until it is
selected for processing.

Export File/ Displays all registered Export translation objects relative to
Auto the Standard, Version, Transaction Set and Release defined
by this relationship. This allows you to specify that when an
EDI document is received, it will be exported into an output
file.

Notes

» Select the Auto check box if you want the export file
created automatically upon receipt of the document. If
the Auto box is not selected, the received document will
remain in the In Documents until it is selected for
processing.

» Ifthe Export File Name is defined for this relationship,
each document can be exported individually to a unique
file. If you use formatting characters in the file name, the
document key changes for each document that is
exported, the Process ID stays the same (for all
documents exported from the same interchange), and the
unique ID changes. Therefore, using the “document key”
and “unique ID” special characters (defined below), a
unique file name can be derived.

Reference
See Export File Name on page 3 - 18 for more
information about these values.

Print Displays all print translation objects on the system for the
Standard, Version, Transaction Set, and Release defined by
the relationship. The selected translation object will be used
to print documents received from this partner.

(Continued on next page)
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Part

Function

Export File
Name

Specify the name of the file to be created or appended to as a
result of performing an export operation. This file name can
contain a mix of alphanumeric characters and formatting
characters, which are replaced by the translator with the
runtime value they represent.

Formatting characters supported

%y (two-digit year)

%Y (four-digit year)

%m (abbreviated month name)

%M (month as a decimal number)

%d (abbreviated weekday name)

%D (day of the month as a decimal number)

%H (hour in 24-hour format)

%N (minutes)

%S (seconds)

%K (document key)

%P (process identifier)

%U (unique number derived using the current time, export
filename, process identifier, and the rand() function)

Note
The runtime file name is generated once per export.

Example
The following is an example of a runtime file name using
formatting characters:

d:\GENSRVNT\exports\dockey$Kprocid%$Puniqueid%U.dat

(Continued on next page)
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Inbound Translation Object Dialog Box

Part

Function

Export to
Mailbox

Invokes the "Export to Mailbox" function, which delivers the
output of an inbound translation to the Mailbox Server
Manager. This allows the Mailbox Server Manager to act as a
message broker responsible for delivering the data to its final
destination.

Note

If you specified the Export File Name, it is still valid and will
become the Attachment Filename. Formatting characters are
still valid for the filename and could cause multiple
attachments to be created if document key is used. For
example, if the following filename is used:

d:\gensrvnt\exports\dockey$Kprocid%$Puniqueid%U.dat
a new attachment is created for each document because the
document key creates a unique name for each document
processed.

To set up an export to a mailbox, you must complete the
following components on the Inbound Translation Objects
dialog box:

» In the Export File Name box, type the file name.

» Select the Export to Mailbox checkbox.

» From the Recipient Mailbox list, select the mailbox (the
Recipient E-mail Address is optional).

» Inthe Content Type/SubType box, type a content type
(content subtype is optional).

Use Partner
Default
Mailbox and
E-mail Address

Specify if the output of the inbound translation is exported to
the default mailbox and e-mail address configured for this
partner.

Recipient
Mailbox/
New Mailbox

Select the mailbox to which the output of an inbound
translation is delivered.

Or, click New Mailbox to display the Create New Mailbox
wizard, which allows you to create a new mailbox.

Reference

See the Communications User's Guide for more information.

(Continued on next page)
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Part

Function

Recipient
E-mail
Address/

Edit Mailbox

Specify the e-mail address to which the output of an inbound
translation is delivered.

Or, click Edit Mailbox to display the Create New Mailbox
wizard, which allows you to edit the mailbox.

Reference
See the Communications User's Guide for more information.

Content Type/
SubType

Specify the content type/sub type of the message containing
the output of the inbound translation.

Reference
See the Communications User's Guide for more information.

Application ID

Specify the application identifier that indicates the
destination of the documents.

Application
Alias Value

Specify criteria for this relationship definition that is used
during the application import function.

Example

The application contains data that can generate either an
invoice or a credit memo. Use one relationship definition for
invoices and another for credit memos.

There is a box in the application that defines whether this is
an invoice or a credit memo. The box will display CREDIT if
a credit memo is created and INVOICE if an invoice is
created. Type CREDIT in the Application Alias Value for the
relationship defining the credit memo and type INVOICE for
the invoice.

Note
This box is only used if you receive translation objects that
are defined to use the Application Alias Value.

(Continued on next page)
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Part

Function

Import

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use translation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select a translation object from the Import list if
you have created a specific import translation object for this
relationship and if you want to change the way the system
behaves for this partner relationship. Import translation
objects may not be appropriate for an Inbound Relationship.

Data Entry

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use translation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select a translation object from the Data Entry list if
you have created a specific data entry translation object for
this relationship and if you want to change the way the
system behaves for this partner relationship (e.g., if you want
to change the formatted view of Inbound data).

Transaction

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use translation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select a translation object from the Transaction list
if you have created a specific Transaction Break translation
object for this relationship and if you want to change the way
the system behaves for this partner relationship.

(Continued on next page)
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Part Function

Acknowledge | Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document translation
level. This allows you to use translation objects that are as
partner-specific as required and/or perform as many
functions as required.

Note

You must select a translation object from the Acknowledge
list if you have created a specific translation object for this
relationship and if you want to change the way the system
behaves for this partner relationship.

When the system reconciles an acknowledgement, it maps
the acknowledgement to an internal file and then processes it.
If you need the system to process acknowledgements
differently, you should select an additional translation object
from the Acknowledge list.

If the transaction set is an acknowledgement and you choose
an Acknowledge additional translation object, the system will
use the additional translation object in place of the export
translation object for acknowledgement reconciliation.

Save Saves the modified information.

Exit Exits the Inbound Translation Object dialog box.
Advanced Toggles the display of the advanced options.
Help Displays Online Help.
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Inbound Group Select Dialog Box

Introduction  The Inbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. It can also be used to
initiate the definition of a new functional group or to modify or delete an existing
definition. The groups available to you are determined by the version you selected
on the Inbound Relationship dialog.

Note
Functional groups are required for ANSI X12, TDCC, and UCS standards,
optional for EDIFACT and ODETTE, and not specified for TRADACOMS.

Diagram  The following illustrates the Inbound Group Select dialog box:

Inbound Group Select - PETZ0NE |

Groups: Select |

<hones

Inbound E xit |
Hew... |

Delete |
Help |

Parts and  The following lists the parts of the Inbound Group Select dialog box and their
functions  functions:

Part Function
Groups Displays all functional group definitions established for
this trading partner.
Select Selects the indicated functional group to be used with this
relationship.
Note

Select <none> if the standard you are using does not
require groups and you do not want to use one.

Exit Exits the Inbound Group Select dialog box.

New Displays the Inbound Group Entry Dialog Box, which
allows you to create a new group.

(Continued on next page)
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Part Function
Edit Displays the Inbound Group Entry Dialog Box, which
allows you to edit the selected group.
Delete Removes the selected group from the system.
Help Displays Online Help.
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Inbound Group Entry Dialog Box

Introduction  The Inbound Group Entry dialog box is used to specify a functional group
definition.

Diagram  The following illustrates the Inbound Group Entry dialog box with the Advanced
options displayed:

Inbound Group Entry - PETZ0MNE1

i |

Description: I Save
Standard: E-EDIFACT Ewit
Wersion: 092001

Functional Group 1D I Help |

Seguence Checking Last eed Group Control Humber:

¥ Acknowledge Group

* 0

Nm? I Ack Transaction Set [D:
" Duplicate

" Incremental I j
" Chronological

Group Transl. Obg; I j

Acknowledge Transl. Ob; | ACKBUILD_CONTRL =]

Parts and  The following lists the parts of the Inbound Group Entry dialog box and their
functions  functions:

Part Function
Description Specify the name of the functional group description.
Standard Displays the EDI standard the system is using for this

relationship definition.

Version Displays the version of the EDI standard the system is
using for this relationship.

(Continued on next page)
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Part

Function

Functional Group
ID

Specify the functional group. These identification boxes
are defined by each appropriate standards group to group
like documents. The standard defines which functional
group ID should be used with each document type. This is
a mandatory box.

Examples

IN 810 X12 Invoice

PO 850 X12 Purchase Order
1G 830 UCS Invoice

oG 875 UCS P. O.

INVOIC EDIFACT INVOIC

ORDERS EDIFACT ORDERS
INVOIC Tradacoms INVOIC
ORDERS Tradacoms ORDERS

This element is located in:

ANSI X12: GS01
EDIFACT: UNGO1
TRADACOMS:BAT

Sequence
Checking

Specify if inbound sequence checking will be used and
whether the type of sequence checking will be incremental
or chronological. You can also indicate that the system
must check for duplicate control numbers.

» None Do not use sequence checking.

» Duplicate Check for duplicate control numbers.

» Incremental The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out
of sequence, those documents will be put in the ?In
Documents.

Last Used Group
Control Number

Specifies a value that the system will use to sequence
check the group control number. The number will be
replaced by the group control number that the system
receives. This box will initially be set to zero.

(Continued on next page)
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Part

Function

Acknowledge
Group

Instructs the system to send a functional acknowledgement
to this trading partner when you receive the group defined
in this relationship. The default value for this box is not
checked (do not expect an acknowledgement).

Note
This check box is dimmed (inactive) if the transaction set
is an acknowledgement.

Ack Translation
Set ID

Select the acknowledgement you want generated for this
group.

Example

ANSI X12 = 997 Functional Acknowledgement
UCS/EDIA = 999 Acceptance/Rejection Advice
EDIFACT = CNTRL

Group Transl.
Ob;.

Select a partner-specific Group Break Map translation
object if this trading partner group deviates from the
normal system behavior. You must select a translation
object from this list if you want the system to perform
partner-specific grouping.

Warning

We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

(Continued on next page)
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Part Function
Acknowledge Select an Acknowledgement Break Map if one exists on
Transl. Obj. the system.
Note

You must select a translation object from the Acknowledge
Transl. Obj. list if you have created a specific translation
object for this relationship and if you want to change the
way the system behaves for this partner group. When the
system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and
Acknowledge Transl. lists, unless you have a specific
reason for doing so.

Save Saves the modified information.

Exit Exits the Inbound Group Entry dialog box.
Advanced Toggles the display of the advanced options.
Help Displays Online Help.
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Inbound Interchange Select Dialog Box

Introduction  The Inbound Interchanges Select dialog box is used to select an existing
interchange definition to be associated with this relationship. You can also use it
to initiate the definition of a new interchange or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Inbound Relationships dialog. Interchanges are required for
EDIFACT, ODETTE, TRADACOMS, and UCS, and optional for ANSI X12 and
TDCC.

Diagram  The following illustrates the Inbound Interchange Select dialog box:

Inbound Interchange 5Select - PETZ0ME |
Interchanges: Calect |

<honer

E it |
Inbound #3040 PO Int
MNew... |

Delete |
Help |

Parts and  The following lists the parts of the Inbound Interchange Select dialog box and
functions their functions:

Part Function
Interchanges Displays all Interchange definitions established for this
trading partner.
Select Selects the indicated interchange to be used with this
relationship.
Note

Select <none> if the standard you are using does not
require interchanges and you do not want to use one.

Exit Exits the Inbound Interchange Select dialog box.

New Displays the Inbound Interchange Entry Dialog Box,
which allows you to create a new interchange.

(Continued on next page)
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Part Function
Edit Displays the Inbound Interchange Entry Dialog Box,
which allows you to edit the selected interchange.
Delete Removes the selected interchange from the system.
Help Displays Online Help.
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Inbound Interchange Entry Dialog Box

Introduction  The Inbound Interchange Entry dialog box is used to specify a new interchange

definition.

Note

EDIFACT version 4 defines the infrastructure necessary to support the creation
(and processing) of interchanges that have been encoded using a character set
other than 8-bit ASCII. Gentran:Server for Windows supports the processing of an
encoded interchange as long as the encoding of the interchange matches the
default code page of the operating system where Gentran:Server is running.

Diagram  The following illustrates the Inbound Interchange Entry dialog box with the

Inbound Interchange Entry Dialog Box

Advanced options displayed:

Inbound Interchange Entiy - PETZ0NE

Interchange D
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Parts and  The following lists the parts of the Inbound Interchange Entry dialog box and their

functions functions:

Part

Function

Description

Contains the name of the interchange description.

Standard

Displays the EDI standard the system is using for this
relationship definition.

Version

Displays the version of the EDI standard the system is
using for this relationship.

Interchange ID

Select the type of interchange. The standard defines which
interchange ID should be used with each standard. This is a
mandatory box.

Example

ANSI X12 -ISA
- ICS

UcCs - BG

EDIFACT - UNB
Tradacoms - STX

Sequence
Checking

Specify if the system will use sequence checking and
whether the sequence checking will be incremental or
chronological. You can also indicate that the system must
check for duplicate control numbers.

» None Do not use sequence checking.
» Duplicate Check for duplicate control numbers.

» Incremental The control number must be one
greater than the last number.

» Chronological The control number must be greater
than the last number.

Note

If the system detects duplicate control numbers or detects
incremental or chronological control numbers that are out
of sequence, those documents will be put in the ?In
Documents.

(Continued on next page)
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Part

Function

Last Used
Control Number

Specifies a value that will be used to sequence check the
next interchange control number. The number will be
replaced by the control number on the last interchange
received. This box will initially be set to zero.

Note
This box is disabled if Sequence Checking is None.

Acknowledge
Interchange

Instructs the system to send a functional acknowledgement
to this trading partner when you receive the interchange set
defined in this relationship. The default value for this box
is not checked (do not expect an acknowledgement).

Ack Translation
Set ID

Select the acknowledgement you want generated for this
interchange.

Example
ANSI X12 = 997 Functional Acknowledgement

UCS/EDIA = 999 Acceptance/Rejection Advice
EDIFACT = CNTRL

Interchange
Transl. Obj.

Select a partner-specific Interchange Break Map
translation object if this trading partner interchange
deviates from the normal system behavior. You must select
a translation object from this list if you want the system to
perform partner-specific interchanging.

Warning

We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

(Continued on next page)
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Part Function
Acknowledge Select an Acknowledgement Break Map if one exists on
Transl. Obj. the system.

You must select a translation object from the Acknowledge
Transl. Obj. list if you have created a specific translation
object for this relationship and if you want to change the
way the system behaves for this partner interchange. When
the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

Save Saves the modified information.

Exit Exits the Inbound Interchange Entry dialog box.
Advanced Toggles the display of the advanced options.
Help Displays Online Help.
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Outbound Relationship Dialog Box

Introduction  Outbound relationships define the parameters needed to send an EDI document to
a trading partner. The Outbound Relationship dialog box controls other
subordinate dialogs that allow you to define everything that is necessary to
establish the relationship.

You are required to specify exactly which document the system sends. You must
also specify which translation objects will be used to define the data entry dialogs,
import rules, or printing requirements. In addition, you need to define the specific
EDI-enveloping requirements that you agreed on with your trading partner.

Diagram  The following illustrates the Outbound Relationship dialog box with the
Advanced options displayed:

DOutbound Relationzhip - PETZOME E3

Relationship Description:
| Outbound Acknowledgment ANS 3030 7 ] Exit

Standard: iz [
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The following lists the parts of the Outbound Relationship dialog box and their

Function

Select the relationship description.

Specifies the EDI standard to be used in this
relationship.

Note

Only standards for which you have existing translation
objects are displayed. This box cannot be changed for an
existing relationship. Selection of this box is mandatory.

Valid values
A-TRADACOMS

C-Cll

D-NCPDP
E-EDIFACT
O-ODETTE
P-OTHER
R-ROSETTANET
T-TDCC

U-UCS

V-VDA

X-X12

Parts and
functions functions:
Part
Relationship
Description
Standard
Version

Select the EDI standard version to be used in this
relationship.

Note

Only versions of the selected standard for which you
have existing translation objects are displayed. If this
box is changed for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

Transaction Set

Select the transaction set to be used in this relationship.

Note

Only transaction sets for the selected version for which
you have existing translation objects are displayed. If
this box is changed for an existing relationship, all of the
information defined below it is cleared and must be
reselected. Selection of this box is mandatory.

(Continued on next page)
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Part

Function

Release

Select the release number to be used in this relationship.

Note

Only releases for the selected transaction set for which
you have existing translation objects will be displayed.
This box is currently only used for messages defined in
the TRADACOMS standard. Selection of this box is
mandatory for all TRADACOMS messages.

Groups

Accesses the Outbound Group Select Dialog Box.

Interchanges

Accesses the Outbound Interchange Select Dialog Box.

Last Used Control
Number

Specify a value that will be used to generate the next
transaction set control number or message reference.
The number generated will always be one more than the
number in this box. Initially, this box will be set to zero.

Expect
Acknowledgement

Instructs the system to expect a functional
acknowledgement to be received from this trading
partner as a result of your partner receiving the
transaction set (message) defined in this relationship.
The default value for this box is not checked (do not
expect an acknowledgement).

Hours Overdue

Defines how many hours must elapse before an
expected functional acknowledgement is considered
overdue. This box is only valid if the Expect
Acknowledgement box is checked. The default value for
this box is “48,” indicating that the acknowledgement
will be considered overdue in two days. If you enter a
value of zero in this box, the acknowledgement will be
immediately considered overdue.

Note
This box is disabled if Expect Acknowledgement is not
checked.

(Continued on next page)
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Part

Function

Duplicate
Documents

Instructs the system to check for duplicate document
names.

Notes

» Ifyou manually import documents into the
Workspace, this function checks for duplicate
documents. Duplicate documents remain in the
Workspace until they are deleted. If you try to move
or post a duplicate document, a warning message is
displayed. If you use the Process Control import
feature to import documents, the duplicate
document is located in ?0ut Documents.

» Ifduplicate document checking is activated for a
relationship, the translation object used in this
relationship must update the document name via a
standard or extended rule.

Reference
See the Application Integration User's Guide for more
information about using standard and extended rules.

Test Indicator

Specify if this relationship definition is in test or
production mode. The default value is production.

Save

Saves the modified information.

Exit

Exits the Outbound Relationship dialog box.

New

Accesses the New Outbound Relationship dialog box,
which allows you to create a new relationship.

Delete

Removes the specified outbound relationship from the
system.

Translation

Accesses the Outbound Translation Object Dialog Box.

Envelope

Accesses one of the following Outbound Envelope
dialog boxes depending on which version you specified:

» Outbound UNH Envelope
» Outbound MHD Envelope
» Outbound ST Envelope
Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.

(Continued on next page)
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Part Function

Advanced Toggles the display of the advanced options.

Help Displays Online Help.
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Outbound Translation Object Dialog Box

Introduction  The Outbound Translation Objects dialog box is used to specify which translation
objects are used to process the data defined by this relationship.

The following lists the outbound translation levels (from the lowest level up):

Translation Level Description
Document Translate from import format or data entry to EDI.
Transaction Build the EDI-specific enveloping around a single
document.
Group Build the EDI-specific enveloping around a set of

related transactions (the transactions do not have to be
the same type).

Interchange Build the EDI-specific enveloping around groups
destined for the same trading partner.

Diagram  The following illustrates the Outbound Translation Object dialog box with the
Advanced options displayed:

Dutbound Translation Objects - PETZ0NE E3

Select Translation Objects

Import [scxeuiLn_ss7 =l
Frint I ﬂ
Data Entry I ﬂ
Application [0; I

Application Alias Yalue: |E|E!?

Additional Translation Objects

Turndround I

Expart |

Transaction | 5T Build Template - ANS|

L Lo L L

Acknowledge |
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Outbound Translation Object Dialog Box

Parts and  The following lists the parts of the Outbound Translation Object dialog box and

functions their functions:

Part

Function

Import

Displays all import translation objects in the system for the
Standard, Version, Transaction Set, and Release defined by
the relationship.

Print

Displays all print translation objects in the system for the
Standard, Version, Transaction Set, and Release defined by
the relationship. The selected translation object will be
used to print documents sent to this partner.

Data Entry

Displays all screen entry translation objects in the system
for the Standard, Version, Transaction Set, and Release
defined by the relationship.

Application ID

Specify the application identifier that indicates the
destination of the documents.

Application Alias
Value

Specify the criteria for this relationship definition, which
will be used during the application import function.

Example

The application contains data that can generate either an
invoice or a credit memo. Use one relationship definition
for invoices and another for credit memos.

There is a box in the application that defines whether this is
an invoice or a credit memo. The box will display CREDIT
if a credit memo is created and INVOICE if an invoice is
created. Type CREDIT in the Application Alias Value for
the relationship defining the credit memo or INVOICE for
the invoice.

Note
This box will only be used if you receive translation
objects that are defined to use the Application Alias Value.

(Continued on next page)
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Part

Function

TurnAround

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select a translation object from the TurnAround
list if you have created a specific turnaround translation
object for this relationship and if you want to change the
way the system behaves for this partner relationship.

Note
TurnAround translation objects may not be appropriate for
an Outbound Relationship.

Export

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select a translation object from the Export list if
you have created a specific export translation object for
this relationship and if you want to change the way the
system behaves for this partner relationship. Export
translation objects are used to export an outbound
document to a file.

Transa

ction

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select a translation object from the Transaction
list if you have created a specific Transaction Build
translation object for this relationship and if you want to
change the way the system behaves for this partner
relationship.

(Continued on next page)
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Outbound Translation Object Dialog Box

Part

Function

Acknowledge

Select other translation objects associated with the
relationship, which gives you the capability to change the
system behavior at the transaction and document
translation level. This allows you to use translation objects
that are as partner-specific as required and/or perform as
many functions as required.

You must select a translation object from the Acknowledge
list if you have created a specific translation object for this
relationship and if you want to change the way the system
behaves for this partner relationship. When the system
generates an acknowledgement, it writes the
acknowledgement to an internal file containing the
acknowledgement details and then maps that internal file.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Save

Saves the modified information.

Exit

Exits the Outbound Translation Object dialog box.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Outbound Group Select Dialog Box

Introduction  The Outbound Group Select dialog box is used to select an existing functional
group definition to be associated with this relationship. You can also use it to
initiate the definition of a new functional group or to modify or delete an existing
definition. The groups that are available to you are determined by the version you
selected on the Outbound Relationship dialog box.

Functional groups are required for ANSI X12, TDCC, and UCS standards, are
optional for EDIFACT and ODETTE, and are not specified for TRADACOMS.

Diagram  The following illustrates the Outbound Group Select dialog box:

Outbound Group Select - PETZO0OME |

Groups: Select |
Outbnd *3030 FA Gip Exit |
Outbnd %3030 IM Grp

Hew... |

Delete |
Help |

Parts and  The following lists the parts of the Outbound Group Select dialog box and their
functions  functions:

Part Function
Groups Displays all functional group definitions established for
this trading partner.
Select Selects the indicated functional group as the one the

system uses for this relationship.

Exit Exits the Outbound Group Select dialog box.

New Displays the Outbound Group Entry Dialog Box, which
allows you to create a new group.

Edit Displays the Outbound Group Entry Dialog Box, which
allows you to edit the selected group.

Delete Removes the selected group from the system.

Help Displays Online Help.
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Outbound Group Entry Dialog Box

Introduction  The Outbound Group Entry dialog box is used to specify a new functional group
definition.

Diagram  The following illustrates the Outbound Group Entry dialog box with the
Advanced options displayed:

Outbound Group Entry - PETZ0OME [ x|

Description: | Save |
Standard: w12 E it |
“Yersion: 003030 Envelope... |
Functional Group |D: IFA— : ;

\ = ,

Laszt Uzed Group Control Mumber: [ Expect &cknowledgement
ID Hiaurs Dverdie; IU

Tranzaction Contral Mumbers

™ Sequence From Group Farmat

& el
LLast [ sed Eamtra] Humben B/
ID (g

) 5/3
Group Tranzl Obj: IGS Build Template - AMSI

L L]

Acknowledge Transl. Obj; I

Parts and  The following lists the parts of the Outbound Group Entry dialog box and their
functions  functions:

Part Function
Description Specify the name of the functional group description.
Standard Displays the EDI standard the system is using for this

relationship definition.

(Continued on next page)
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Part

Function

Version

Displays the version of the EDI standard the system is
using for this relationship.

Functional Group
ID

Specifies the functional group. These identification boxes
are defined by each appropriate standards group to group
like documents. The standard defines which functional
group ID should be used with each document type. This is
a mandatory box.

Examples

IN 810 X12 Invoice

PO 850 X12 Purchase Order
1G 830 UCS Invoice

oG 875 UCS P. O.

INVOIC EDIFACT INVOIC

ORDERS EDIFACT ORDERS
INVOIC Tradacoms INVOIC
ORDERS Tradacoms ORDERS

This element is located in:

ANSI X12: GS01
EDIFACT: UNGO1
TRADACOMS:BAT

Last Used Group
Control Number

Specify a value that is used to generate the next
interchange control number. The number generated will
always be one more than the number in this box. This box
will initially be set to zero.

Note

To ensure that functional acknowledgements work
correctly, you must define a unique control number for
each group relationship that exists for the same partner
relationship.

Expect
Acknowledgement

Instruct the system to expect a functional
acknowledgement to be received from this trading partner
as a result of your partner receiving the group defined in
this relationship. The default value for this box is not
checked (do not expect an acknowledgement).

(Continued on next page)
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Part

Function

Hours Overdue

Specify how many hours must elapse before an expected
functional acknowledgement is considered overdue. This
box is only valid if the Expect Acknowledgement box is
checked. The default value for this box is “48,” indicating
that the acknowledgement will be considered overdue in
two days. If you enter a value of “0” (zero) in this box, the
acknowledgement will be immediately considered
overdue.

Note
This box is disabled if Expect Acknowledgement is not
checked.

Sequence From
Group

Specify if the transaction set control number options for
this group setup should be controlled at the group level. If
this box is not checked, the following two fields are
disabled.

Last Used
Control Number

Specify a value that will be used to generate the next
transaction set control number for the sets defined within
this functional group. The number generated will always
be one more than the number in this box. This box will
initially be set to zero.

Note
This box is disabled if Sequence From Group is not
checked.

(Continued on next page)
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Part

Function

Format

Select the format of the transaction set control number that
will be generated:

Normal The number will be generated by incrementing the
last used control number. The length of the number
will be defined by the standard.

6/3 The number will be a composite of two numbers.
The first six digits are the last six digits of the
functional group control number. The last three
digits are a counter beginning at “1” within the
functional group. Use this format only as
instructed by your trading partner.

5/4 The number will be a composite of two numbers.
The first five digits are the last five digits of the
functional group control number. The last four
digits are a counter beginning at “1”” within the
functional group. This is the normal TDCC
numbering convention. It is used by the Motor,
Rail, and Ocean transportation industries.

5/3 The number will be a composite of two numbers.
The first five digits are the last five digits of the
functional group control number. The last three
digits are a counter beginning at “1” within the
functional group. This is the normal UCS
convention, which is used by the Grocery and
Warehousing industries.

Note
This box is disabled if Sequence From Group is not
checked.

Group Transl.
Ob;.

Select a partner-specific Group Build Map translation
object if this trading partner group deviates from the
normal system behavior. You must select a translation
object from this list if you want the system to perform
partner-specific grouping.

Warning

We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

(Continued on next page)
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Part

Function

Acknowledge
Transl. Obj.

Select an Acknowledgement Build Map if one exists on the
system.

You must select a translation object from the Acknowledge
Transl. Obj. list if you have created a specific translation
object for this relationship and if you want to change the
way the system behaves for this partner group. When the
system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
translation objects in the Group Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

Save

Saves the modified information.

Exit

Exits the Outbound Group Entry dialog box.

Envelope

Accesses one of the following Outbound Functional Group
Envelope dialog boxes depending on which version you
specified on the Outbound Relationship Dialog Box:

» Outbound GS Functional Group

» Outbound UNG Functional Group

» Outbound BAT Functional Group

Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Outbound Interchange Select Dialog Box

Introduction  The Outbound Interchange Select dialog box is used to select an existing
interchange definition to be associated with this relationship. It can also be used to
initiate the definition of a new interchange, or to modify or delete an existing
definition. The interchanges available to you are determined by the version you
selected on the Outbound Relationship dialog box. Interchanges are required for
EDIFACT, ODETTE, TRADACOMS, and UCS, and are optional for ANSI X12
and TDCC.

Diagram  The following illustrates the Outbound Interchange Select dialog box:

Outbound Interchange Select - PETZ0ONE |

Interchanges: Select |
Cnone:

E xit |
COutbid #3030 1M 1rt
Outhnd #3040 FA Int Mew... |
Outbid #3040 1M 1t —

Delete

Help |

Parts and  The following lists the parts of the Outbound Interchange Select dialog box and
functions their functions:

Part Function
Interchanges Displays all interchange definitions established for this
trading partner.
Select Selects the indicated interchange to be used with this
relationship.
Note

Select <none> if the standard you are using does not
require interchanges and you do not want to use one.

Exit Exits the Inbound Interchange Select dialog box.

New Displays the Outbound Interchange Entry Dialog Box,
which allows you to create a new interchange.

(Continued on next page)
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Part Function
Edit Displays the Outbound Interchange Entry Dialog Box,
which allows you to edit the selected interchange.
Delete Removes the selected interchange from the system.
Help Displays Online Help.
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Outbound Interchange Entry Dialog Box

Introduction  The Outbound Interchange Entry dialog box is used to specify a new interchange

definition.

Note

EDIFACT version 4 defines the infrastructure necessary to support the creation
(and processing) of interchanges that have been encoded using a character set
other than 8-bit ASCII. Gentran:Server for Windows supports the processing of an
encoded interchange as long as the encoding of the interchange matches the
default code page of the operating system where Gentran:Server is running.

Diagram  The following illustrates the Outbound Interchange Entry dialog box with the

Advanced options displayed:

Outbound Interchange Entiy - PETZ0NE

[NEsCptioh: IDuthnd #3030 FA Int

Standard: K12
Wersion: 003030
|rterctatae [0 |Sd -

Save |
Euit |
Envelope... |

Help |

W Use the default Mailbox and E-mail &ddress

M il JGENTRAN Application |

E-mail Address I

(=2 = |
Bt el b |

Content Type: I.-’-'n.pplic:atiu:um"EDl

fl & W umben af [Macuments Genlrterchatae:

[ Set Max Mumber of Documents per Interchange

—

Laszt Used Control Number:
Q00000000

[ Expect &cknowledgement

Hiours Mwerdiie: IU

|nterchange Transl Obj. IISA Build Template - AM5|

Acknowledge Tranzl. Obij. I

~
=
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Parts and  The following lists the parts of the Outbound Interchange Entry dialog box and
functions their functions:

Part Function
Description Displays the name of the interchange description.
Standard Displays the EDI standard the system is using for this
relationship definition.
Version Displays the version of the EDI standard the system is

using for this relationship.

Interchange ID

Displays the type of interchange you specified. The
standard defines which interchange ID should be used with
each standard. This is a mandatory box.

Example

ANSI X12 - ISA
ICS

UcCs - BG

EDIFACT - UNB
Tradacoms - STX

Use the default
Mailbox and
E-mail Address

Specify that the system will use the default Mailbox and
E-mail address specified on the Partner Definition (New/
Edit) Dialog Box.

Mailbox/
New Mailbox

Specify a mailbox to use to identify this partner for
RosettaNet relationships.

Or, click New Mailbox to display the Create New Mailbox
wizard, which allows you to create a new mailbox.

Reference
See the Communications User s Guide for more
information.

E-mail Address/
Edit Mailbox

Specify an e-mail address to identify this partner for
RosettaNet relationships.

Or, click Edit Mailbox to display the Mailbox Properties
dialog box, which allows you to edit the mailbox.

Reference
See the Communications User s Guide for more
information.

Content Type

Specify the content type of the interchange.

(Continued on next page)
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Part Function
Set Max Number | Instruct the system to only allow the specified maximum
of Documents per | number of documents per interchange for this relationship.
Interchange
Max Number of | Specify the maximum number of documents allowed per
Documents per interchange for this relationship.
Interchange
Last Used Specify a value that will be used to generate the next

Control Number

interchange control number. The number generated is
always one more than the number in this box. Initially, this
box will be set to zero.

Expect
Acknowledgement

Instruct the system to expect a functional
acknowledgement to be received from this trading partner
as a result of your partner receiving the interchange set
defined in this relationship. The default value for this box
is not checked (do not expect an acknowledgement).

Hours Overdue

Specify how many hours must elapse before an expected
functional acknowledgement is considered overdue. This
box is only valid if the Expect Acknowledgement box is
checked. The default value for this box is “48,” indicating
that the acknowledgement will be considered overdue in
two days. If you enter a value of zero in this box, the
acknowledgement will be immediately considered
overdue.

Note
This box is disabled if Expect Acknowledgement is not
checked.

Interchange
Transl. Obj.

Select a partner-specific Interchange Build Map translation
object if this trading partner interchange deviates from the
normal system behavior. You must select a translation
object from this list if you want the system to perform
partner-specific interchanging.

Warning

We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

(Continued on next page)

Gentran:Server for Windows — November 2005

Gentran:Server for Windows User’s Guide



Using Partners

Outbound Interchange Entry Dialog Box

Part

Function

Acknowledge
Transl. Obj.

Select an Acknowledgement Build Map if one exists on the
system.

You must select a translation object from the Acknowledge
Transl. Obj. list if you have created a specific translation
object for this relationship and if you want to change the
way the system behaves for this partner interchange. When
the system reconciles an acknowledgement, it maps the
acknowledgement to an internal file and then processes it.
If you need the system to process acknowledgements
differently, you should select an additional translation
object from the Acknowledge list.

Warning

We strongly recommend that you do not change the
translation objects in the Interchange Transl. Obj. and
Acknowledge Transl. Obj. lists, unless you have a specific
reason for doing so.

Save

Saves the modified information.

Exit

Exits the Outbound Interchange Entry dialog box.

Envelope

Accesses one of the following Outbound Interchange
Envelope dialog boxes depending on which version you
specified on the Outbound Relationship Dialog Box:

» Outbound ISA Envelope

» Outbound ICS Envelope

» Outbound BG Envelope

» Outbound UNB Envelope

» Outbound UNA Envelope

» Outbound STX Envelope

» Outbound VDA Envelope

» Outbound NCPDP Envelope

» Outbound Envelope PIP Initiation
Reference

Refer to the Partner Editor online help for specific
information about the envelope dialog boxes.

Advanced

Toggles the display of the advanced options.

Help

Displays Online Help.
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Creating a Partner Definition

Introduction  The partner definition contains the basic information about the trading partner that
the system needs before you define the rest of the partner profile.

Prerequisite  Before setting up a new partner definition, you must have the following
knowledge  information:

» The communication profile name you use to communicate with this partner
» The EDI code for this partner

» The application code used to identify this partner in the import file
This application code is needed only if the transactions are processed using

the file

Procedure To create a

Import facility.

partner definition, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

Click New.

System response
The system displays the Partner Definition (New/Edit) Dialog Box.

In the Profile ID box, type a unique alphanumeric Profile ID for this
partner.

Note
Do not use special characters.

In the Name box, type the partner name.

In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses this identifier during inbound processing to select
the correct partner.

(Continued on next page)
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Creating a Partner Definition

Step

Action

If necessary, in the Application Code box, type an application code to
identify this partner.

Note
The system uses this identifier during outbound import processing, to
select the correct partner.

» Select the appropriate mailbox from the Default Mailbox list.

OR
» Click New Mailbox to create a new mailbox.

Note
See the Communications User s Guide for more information about
creating mailboxes.

After you enter all the partner definition information, click Save.

Click Exit to return to the Partner Editor dialog box.

Note
To complete the partner profile, you need to define an inbound or
outbound relationship or both.

» Ifyouare receiving and processing information from this trading
partner, you need to define an appropriate inbound relationship
established.

» Ifyou are sending information to this trading partner, you need to
define an outbound relationship.
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Creating an Inbound Relationship

Introduction

Necessary
parameters

Translation
objects

Inbound groups
and interchanges

To correctly receive and process information from a trading partner, you must
have an appropriate inbound relationship established that defines the parameters
needed to receive data files from that partner. Each inbound relationship defines
which business documents are received from a partner.

You must set up several parameters that are used to create an inbound relationship.
These parameters tell the system the following information:

» The type of data received
» The criteria the system uses to validate the information it receives

» The functional groups and interchanges in which you expect to receive the
documents

Each inbound relationship must have one or more associated inbound translation
objects. These translation objects determine how the received data is processed.
You need to specify which translation objects are used to define the rules for
exporting, printing, and creating turnaround documents. At a minimum, one
translation object must be available.

Note

If this relationship requires a new translation object, you must register that
translation object with the system before creating the inbound relationship. See
Registering New Translation Objects on page 2 - 7 for instructions.

You must define or select an inbound interchange and/or inbound functional group
before the system allows you to complete the setup of an inbound relationship.
The inbound functional group defines the format of the functional group and the
parameters that should be used to verify it. The inbound interchange defines the
format of the interchange and the parameters that should be used to verify it.

However, for some transactions, the functional group or interchange is optional
and if your trading partner has chosen not to use it then it is not necessary for you
to select one. Refer to the following standards to determine whether or not you are
required to select an inbound functional group or interchange:

» For some ANSI X12 documents, the interchange is optional and the
functional group is required. However, for most documents, both an
interchange and functional group are required.

» For TDCC, the interchange is optional and the functional group is required.
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Inbound groups
and interchanges
(contd)

Before you begin

Inbound
relationship
dialog box

Process of
defining an
inbound
relationship

Creating an Inbound Relationship

» For UCS, the interchange is required and the functional group is also
required.

» For EDIFACT, the interchange is required and the functional group is
optional.

» For ODETTE, the interchange is required and the functional group is
optional.

» For TRADACOMS, the Interchange is required and there is no functional
group.

Note

If you do not want to use an optional functional group or interchange, you must

still select <none> from the appropriate dialog box to alert the system that you are
not using a group.

Before setting up an inbound relationship, you must know the following
information to plan the implementation of this partner:

» The EDI standard you expect from this trading partner (such as ANSI)

» The standard version you expect from this trading partner (such as 003020 for
ANSI or 090001 for EDIFACT)

» The code for the transaction set you expect from this trading partner (such as
““INVOIC” for an EDIFACT invoice)

» The type of functional group and interchange the transaction set is wrapped in
when it is received from this partner

After you complete your implementation planning for this partner, you can set up
the inbound relationship by using the Inbound Relationship dialog box. The
Inbound Relationship dialog box controls other subordinate dialog boxes, where
you define everything that is necessary to establish the relationship.

The following describes the process for defining an inbound relationship:

Stage Description
1 Create a new inbound relationship.
2 Create and register the inbound translation object to be used with this
relationship.
Reference

See the Application Integration User’s Guide for more information
about creating a translation object. Also see Registering New
Translation Objects on page 2 - 7 for more information.

(Continued on next page)
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Stage Description
3 Select at least one inbound translation object.
4 Create and select at least one inbound group to define how the

document is received from this partner.

Note

Depending on the standards you are using, either the functional group
or interchange may be optional. (See Inbound groups and
interchanges on page 3 - 58 to determine what is optional for the
standard you are using.)

5 Create and select at least one inbound interchange to define how the
document is received from this partner.

Note

Depending on the standards you are using, either the functional group
or interchange may be optional. (See Inbound groups and
interchanges on page 3 - 58 to determine what is optional for the
standard you are using.)

6 If you are generating functional acknowledgements as a result of
receiving documents for an inbound relationship, you must set up the
corresponding outbound relationship to generate the
acknowledgements your partner requests.

Reference
See Creating an Outbound Relationship on page 3 - 66 for more
information.
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Creating an Inbound Relationship

Procedure To create an inbound relationship, complete the following steps:

Step

Action

Creating a new inbound relationship

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile for which you want to create an
inbound relationship.

» Click Inbound.

System response
The system displays the Inbound Relationship Dialog Box.

Note
You must have already created a partner definition for this partner.

Reference
See Creating a Partner Definition on page 3 - 56 for more
information.

Click New.

System response
The system displays the New Inbound Relationship dialog box.

In the description box, type a unique relationship name (such as
Inbound Invoice).

Click Save.

System response
The system creates an inbound relationship and returns to the
Inbound Relationship dialog box.

(Continued on next page)
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Step

Action

From the appropriate drop-down lists on the Inbound Relationship
dialog box, select the following:

» Standard

» Version

» Transaction Set

» Release (for TRADACOMS only)

Notes

» The contents of these lists are displayed from the translation
objects registered in Gentran:Server. For example, if there are no
translation objects for ANSI X12 version 003040 registered with
Gentran, you will not be able to select that version on this dialog
box.

» The information required for this dialog box should be provided
to you by your trading partner when this partner defines the
details of the transactions they send you.

If you need to define parameters to comply with the processing needs
of your partner (such as Sequence Checking, Last Used Control,
Duplicate Documents, or Generate Acknowledgement), click
Advanced.

System response
The system displays the Advanced fields on the Inbound
Relationship dialog box.

Selecting an inbound translation object

On the Inbound Relationship dialog box, click Translation.

System response
The system displays the Inbound Translation Object Dialog Box.

From the drop-down lists, select the translation objects required for
this inbound relationship.

Note

» The lists display all translation objects registered in the system
that are appropriate for the type of translation object (such as
Export or Print) and the transaction set.

» If'there are no translation objects displayed in the drop-down
lists, no translation objects of that type are registered for the
version of the document defined in the relationship.

(Continued on next page)
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Creating an Inbound Relationship

Step

Action

If you selected an Export File translation object and you want to
export to a specific file, type the universal naming convention (UNC)
name of that file in the Export File Name box.

Do you want to use the “Export to Mailbox™ function to specify a
mailbox and E-mail address so the output of the inbound translation
object can be delivered directly back to the Mailbox Server Manager?

» Ifyes, select Export to Mailbox and complete the appropriate
boxes. Continue with the next step.

Reference
See Inbound Translation Object Dialog Box on page 3 - 15 for
more information.

» If no, continue with the next step.

Click Save to save your selections and return to the Inbound
Relationship dialog box.

Selecting an inbound functional group

On the Inbound Relationship dialog box, click Groups to display a
list of existing groups.

System response
The system displays the Inbound Group Select Dialog Box.

Is the required group in the Groups list?

» If yes, select the group. Or, if you are not using groups, select
<none>.

Then, click Select. Continue with Selecting an inbound
interchange on page 3 - 64.

System response
This action selects the highlighted group and returns you to the
Inbound Relationship dialog box.

» If no, continue with the next step to create the group.

On the Inbound Group Select dialog box, click New.

System response
The system displays the Inbound Group Entry Dialog Box.

In the Description box, type the group description.

(Continued on next page)
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Step Action

5 In the Functional Group ID box, type the identification of the
functional group you are specifying.

Note
The EDI standards define which functional group ID should be used
for each type of document.

6 If you have more complex requirements for processing the functional
group, click Advanced to display the full list of functional group
setup options.

System response
The system displays the Advanced fields on the Inbound Group
Entry dialog box.

7 After you set up the required parameters in this dialog box, click
Save to store the information and return to the Inbound Group Select
dialog box.

8 » Highlight the new group.
» Click Select.

System response
Selects the group and returns to the Inbound Relationship dialog box.

Selecting an inbound interchange

1 On the Inbound Relationship dialog box, click Interchanges to
display a list of existing interchanges.

System response
The system displays the Inbound Interchange Select Dialog Box.

2 Is the required interchange in the Interchanges list?

» Ifyes, select the group. Or, if you are not using groups, select
<none>.

Then, click Select. Continue with Finalizing the inbound
relationship on page 3 - 65.

System response
This action selects the highlighted interchange and returns you to
the Inbound Relationship dialog box.

» If no, continue with the next step to create the interchange.

(Continued on next page)
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Creating an Inbound Relationship

Step

Action

On the Inbound Interchange Select dialog box, click New.

System response
The system displays the Inbound Interchange Entry Dialog Box.

In the Description box, type the interchange description.

In the Interchange ID box, type the identification of the interchange
you are specifying.

Note
The EDI standards define which interchange ID should be used for
each type of document.

If you have more complex requirements for processing the
interchange, click Advanced to display the full list of interchange
setup options.

System response
The system displays the Advanced fields on the Inbound Interchange
Entry dialog box.

After you set up the required parameters in this dialog box, click
Save to store the information and return to the Inbound Interchange
Select dialog box.

» Highlight the new interchange.
» Click Select.

System response
Selects the interchange and returns to the Inbound Relationship
dialog box.

Finalizing the inbound relationship

On the Inbound Relationship dialog box, click Save to save the
inbound relationship.

Click Exit to return to the Partner Editor dialog box.
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Creating an OQutbound Relationship

Introduction

Necessary
parameters

Translation
objects

Outbound
groups and
interchanges

To correctly send information to a trading partner, you need to define an outbound
relationship. Outbound relationships define the parameters needed to send a data
file to a trading partner. Each outbound relationship defines the format of a single
business document, and how that business document is formatted and sent to the
specified trading partner.

You must set up several parameters that are used to create an outbound
relationship. These parameters tell the system the following information:

» How to create the required message
» The criteria that the system uses to validate the information entered

» How to create the functional group and interchange envelopes in preparation
for sending

Each outbound relationship must have one or more associated outbound
translation objects. These translation objects determine how the sent data is
formatted. You need to specify which translation objects are used to define the
rules for screen entry or file import. At a minimum, one translation object must be
available.

Note

If this relationship requires a new translation object, you must register that
translation object with the system before creating the outbound relationship. See
Registering New Translation Objects on page 2 - 7 for instructions.

You must define or select an outbound interchange and/or outbound functional
group before the system allows you to complete the setup of an outbound
relationship. The outbound functional group defines the format of the functional
group and the parameters that should be used to verify it. The outbound
interchange defines the format of the interchange and the parameters that should
be used to verify it.

However, for some transactions, the functional group or interchange is optional,
and if your trading partner has chosen not to use it, it is not necessary for you to
select one. Refer to the following standards descriptions to determine whether or
not you are required to select an outbound functional group or interchange:

» For some ANSI X12 documents, the interchange is optional and the
functional group is required. However, for most documents, both an
interchange and functional group are required.
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Outbound
groups and
interchanges
(contd)

Before you begin

Outbound
relationship
dialog box

Process of
defining an
outbound
relationship
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Creating an Outbound Relationship

» For TDCC, the interchange is optional and the functional group is required.

» For UCS, the interchange is required and the functional group is also
required.

» For EDIFACT, the interchange is required and the functional group is
optional.

» For ODETTE, the interchange is required and the functional group is
optional.

» For TRADACOMS, the Interchange is required and there is no functional
group.

Note

If you do not want to use an optional functional group or interchange, you must

still select <none> from the appropriate dialog box to alert the system that you are
not using a group.

Before setting up an outbound relationship, you must know the following
information to plan the implementation of this partner:

» The EDI standard this trading partner expects (such as ANSI X12)

» The standard version that this partner expects (such as 003020 for ANSI or
090001 for EDIFACT)

» The code for the transaction set you use (such as “INVOIC” for an EDIFACT
invoice)

» The type of functional group and interchange envelope the transaction set is
wrapped in when it is sent to this partner

After you complete your implementation planning for this partner, you can set up
the outbound relationship by using the Outbound Relationship dialog box. The
Outbound Relationship dialog box controls other subordinate dialog boxes, where
you define everything that is necessary to establish the relationship.

The following describes the process of defining an outbound relationship.

Stage Description

1 Create a new outbound relationship.

2 If you are using the EDIFACT, ODETTE, or TRADACOMS
standard, you must complete the envelope (header) information for
this type of document. For the ANSI, UCS, and TDCC standards, the
envelope information is optional.

(Continued on next page)
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Stage

Description

Create and register the inbound translation object to be used with this
relationship.

Reference

See the Application Integration User’s Guide for more information
about creating a translation object. Also see Registering New
Translation Objects on page 2 - 7 for more information.

Select at least one outbound translation object.

Create and select at least one outbound group (including enveloping
information) to define how the document is received from this
partner.

Note

Depending on the standards you are using, either the functional
group or interchange may be optional. (See Outbound groups and
interchanges on page 3 - 66 to determine what is optional for the
standard you are using.)

Create and select at least one outbound interchange (including
enveloping information) to define how the document is received
from this partner.

Note

Depending on the standards you are using, either the functional
group or interchange may be optional. (See Outbound groups and
interchanges on page 3 - 66 to determine what is optional for the
standard you are using.)

If you will receive functional acknowledgements for the outbound
documents, set up the corresponding inbound relationship to receive
the acknowledgements you expect from your partner.

Reference
See Creating an Inbound Relationship on page 3 - 58 for more
information.
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Creating an Outbound Relationship

Procedure To create an outbound relationship, complete the following steps:

Step

Action

Creating a new outbound relationship

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile for which you want to create an
outbound relationship.

» Click Outbound.

System response
The system displays the Outbound Relationship Dialog Box.

Note
You must have already created a partner definition for this partner.

Reference
See Creating a Partner Definition on page 3 - 56 for more
information.

Click New.

System response
The system displays the New Outbound Relationship dialog box.

In the description box, type a unique relationship name.

Click Save.

System response
The system creates an outbound relationship and returns to the
Outbound Relationship dialog box.

(Continued on next page)
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Step Action

6 From the appropriate drop-down lists on the Outbound Relationship
dialog box, select the following:

» Standard

» Version

» Transaction Set

» Release (for TRADACOMS only)

Notes

» The contents of these lists are displayed from the translation
objects registered in Gentran:Server. For example, if there are no
translation objects for ANSI X12 version 003040 registered with
Gentran, you will not be able to select that version on this dialog
box.

» The information required for this dialog box should be provided
to you by your trading partner when this partner defines the
details of the transactions they send you.

7 If you need to define parameters to comply with the processing needs
of your partner (such as Last Used Control Number, Expect
Acknowledgement, Hours Overdue, Duplicate Documents, or Test
Indicator), click Advanced.

System response
The system displays the Advanced fields on the Outbound
Relationship dialog box.

Selecting a transaction envelope (mandatory for EDIFACT, ODETTE, and
TRADACOMS standards—optional for ANSI, UCS, and TDCC)

1 If you are using the EDIFACT, ODETTE, or TRADACOMS
standard, click Envelope to complete the envelope (header)
information.

Note
For the ANSI, UCS, and TDCC standards, the envelope information
is optional.

System response

The system displays one of the following dialog boxes:
» Outbound UNH Envelope dialog box

» Outbound MHD Envelope dialog box

» Outbound ST Envelope dialog box

(Continued on next page)
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Creating an Outbound Relationship

Step

Action

Enter the appropriate information and click Save.

System response
Saves the information and returns to the Outbound Relationship
dialog box.

Selecting an outbound translation object

On the Outbound Relationship dialog box, click Translation.

System response
The system displays the Outbound Translation Object Dialog Box.

From the drop-down lists, select the translation objects required for
this outbound relationship.

Note

» The lists display all translation objects registered in the system
that are appropriate for the type of translation object (such as
Import or Print) and the transaction set.

» If there are no translation objects displayed in the drop-down
lists, no translation objects of that type are registered for the
correct version of the document defined in the relationship.

If you selected an Import translation object, you may need to define
the following:

» Inthe Application ID box, type the application identifier that
indicates the destination for the documents.

» Inthe Application Alias Value box, type criteria that the system
will use to distinguish this relationship from others during the
application import function.

Click Save to save your selections and return to the Outbound
Relationship dialog box.

Selecting an outbound functional group

On the Outbound Relationship dialog box, click Groups to display a
list of existing groups.

System response
The system displays the Outbound Group Select Dialog Box.

(Continued on next page)
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Step

Action

Is the required group in the Groups list?

» Ifyes, select the group. Or if you are not using groups, select
<none>.

Then, click Select. Continue with Selecting an outbound
interchange on page 3 - 73.

System response
This action selects the highlighted group and returns you to the
Outbound Relationship dialog box.

» If no, continue with the next step to create the group.

On the Outbound Group Select dialog box, click New.

System response
The system displays the Outbound Group Entry Dialog Box.

In the Description box, type the group description.

In the Functional Group ID box, type the identification of the
functional group.

Note
The EDI standards define which functional group ID should be used
for each type of document.

If you have more complex requirements for processing the functional
group, click Advanced.

System response
The system displays the Advanced fields on the Outbound Group
Entry dialog box.

Recommendation

Do not change the translation objects in the Group Transl. Obj. and
Acknowledge Transl. Ob;j. lists, unless you have a specific reason to
do so.

(Continued on next page)
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Creating an Outbound Relationship

Step

Action

Click Envelope to set up the parameters for the generation of the
Functional Group segment.

System response

The Outbound Functional Group dialog box displayed is one of the
following depending on the standard you selected on the Outbound
Relationship dialog box:

» Outbound GS Functional Group

» Outbound UNG Functional Group

» Outbound BAT Functional Group

After you set up the required parameters in the enveloping dialog
box, click Save to store the information and return to the Outbound
Group Entry dialog box.

Click Save to store the information about the Outbound Group Entry
dialog box and return to the Outbound Group Select dialog box.

10

» Highlight the new group.
» Click Select.
System response

Selects the group and returns to the Outbound Relationship dialog
box.

Selecting an outbound interchange

On the Outbound Relationship dialog box, click Interchanges.

System response
The system displays the Outbound Interchange Select Dialog Box.

Is the required interchange in the Interchanges list?

» If yes, select the interchange. Or if you are not using groups,
select <none>.

Then, click Select. Continue with Finalizing the outbound
relationship on page 3 - 75.

System response
This action selects the highlighted interchange and returns you to
the Outbound Relationship dialog box.

» Ifno, continue with the next step to create the interchange.

(Continued on next page)
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Step

Action

On the Outbound Interchange Select dialog box, click New.

System response
The system displays the Outbound Interchange Entry Dialog Box.

In the Description box, type the interchange description.

In the Interchange ID box, type the identification of the interchange.

Note
The EDI standards define which interchange ID should be used for
each type of document.

If you have more complex requirements for processing the
interchange, click Advanced.

System response
The system displays the Advanced fields on the Outbound
Interchange Entry dialog box.

Recommendation

Do not change the translation objects in the Interchange Transl. Ob;.
and Acknowledge Transl. Obj. lists, unless you have a specific reason
to do so.

Do you want to use the default Mailbox and E-mail Address?
» Ifyes, continue with step 9.

» If no, continue with the next step.

» Select the appropriate mailbox from the Default Mailbox list.

OR
» Click New Mailbox to create a new mailbox.

Note
See the Communications User s Guide for more information about
creating mailboxes.

(Continued on next page)
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Creating an Outbound Relationship

Step

Action

Click Envelope to set up the parameters for the generation of the
interchange segment.

System response

The Outbound Interchange dialog box displayed is one of the
following depending on the standard you selected on the Outbound
Relationship dialog box:

» Outbound ISA Envelope

» Outbound ICS Envelope

» Outbound BG Envelope

» Outbound UNB Envelope

» Outbound UNA Envelope

» Outbound STX Envelope

» Outbound Envelope PIP Initiation

10

After you set up the required parameters in the enveloping dialog
box, click Save to store the information and return to the Outbound
Interchange Entry dialog box.

11

Click Save to store the information about the Outbound Interchange
Entry dialog box and return to the Outbound Interchange Select
dialog box.

12

» Highlight the new interchange.
» Click Select.

System response
Selects the interchange and returns to the Outbound Relationship
dialog box.

Finalizing the outbound relationship

On the Outbound Relationship dialog box, click Save to save the
outbound relationship.

Click Exit to return to the Partner Editor dialog box.
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Editing and Deleting Partner Definitions

Introduction  The partner definition contains the basic partner profile information to which the
system associates the rest of that partner’s records. You can edit nd delete the
partner definition from the Partner Editor dialog box.

Editing a partner  To edit a partner profile, complete the following steps:
profile

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the appropriate partner from the Select a Partner list.
» Click Edit.

System response
The system displays the Partner Definition (New/Edit) Dialog Box
for that partner.

3 » Make the necessary changes.
» Click Save.

System response
The system returns to the Partner Editor dialog box.

Note

» You can also edit other aspects of a partner relationship (such as
inbound relationship or outbound relationship) by clicking the
appropriate button (Inbound or Outbound) on the Partner
Editor dialog box.

» You are not able to edit any boxes that are grayed; these are the
“keys” to the relationship. In this case, you must create a new
inbound or outbound relationship for that partner.

Reference
See Creating an Inbound Relationship on page 3 - 58 and Creating
an Outbound Relationship on page 3 - 66 for more information.
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Editing and Deleting Partner Definitions

Deleting a  To delete a partner profile, complete the following steps:

partner profile

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the appropriate partner from the Select a Partner list.
» Click Delete.

System response
You are prompted to confirm the deletion.

Warning
» When you delete a partner relationship, the documents and
interchanges associated with that partner are also deleted.

» If any documents or interchanges exist for a partner you choose
to delete, you are warned before the actual deletion.

Click Yes to delete the selected partner profile.

System response
The partner profile and all associated records are deleted.
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Routing Partner Profiles
Import File Select Dialog Box
Introduction  The Import File Select dialog box enables you import a partner into the system.

Diagram  The following illustrates the Import File Select dialog box:

Import File Select K E3

Look im: |E Fartners j ﬁl

File hame: I*.par

Filez of tppe: IImpthiIes[*.pal] j Cancel |
Help |

Parts and  The following lists the parts of the Import File Select dialog box and their
functions  functions:

Part Function

Look in Select the folder where the system should look for the file.
Displays the current folder.

File name Specify the name of the file to be imported.

Files of type Select the type of file.
Note
The default file extension for partners is .par.

Open Begins the import process for the selected partner file.

Cancel Cancels the action and exits the dialog box.

Help Displays Online Help.
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Export File Build Dialog B

Introduction  The Export File Build
export file and begins

Export File Build Dialog Box

0X

dialog box enables you to specify the name of a partner
the export process.

Diagram  The following illustrates the Export File Build dialog box:

Export File Build

(7] ]

Save I 5] Partners

= & = [=E

File name:  [PETZONE.par

Save as type: IE:-:pDrl Files

[* par) j - Cancel |
Help |

Parts and  The following lists the parts of the Export File Build dialog box and their

functions functions:

Part

Function

Save in

Select the folder where you want to save the file. Displays
the current folder.

File name

Specify the name of the file to be exported.

Note

The Partner Name field is used to generate the file name. If
the Partner Name contains any Windows reserved
characters (/, \, :, *, 2, ", <, >, |), the file drops those
characters and pads the file name with spaces (one space
for each reserved character in the name).

Example
If the Partner Name is AB/CD-TEST, the file name will be
AB CD TEST.par.

(Continued on next page)
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Part Function
Save type Select the type of file.
Note
The default file extension for partners is .par.
Save Begins the export process.
Cancel Exits the dialog box without making a selection.
Help Displays Online Help.
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Partner Copy Dialog Box

Introduction  The partner copy feature allows you to copy partner information. Once you copy
the partner, this dialog enables you to change the partner definition and other
identifying boxes for the copied partner.

Note

You must export the partner profile before you copy it. See Exporting Partner
Profiles on page 3 - 87 for more information. If you do not know which EDI
standard that partner profile uses, check the profile to obtain that information
before you export and copy it.

Diagram  The following illustrates the Partner Copy dialog box:

FErofile 10: I

Sawe

Mame: | Clear |
EDI Code: | Exit |
Application Code; | Help |
Default Mailbox: I j

Group Receiver Qualifier: I— E difact with UNG only

Group Receiver |D: | AMSI/Edifact/UCSTDCC

Interchange Receiver Qualifier; I— AMSI/Edifact/UCS/TDCC

Interchange Receiver 10: AMSI/Edifact/UCS/TDCC

Interchange Communication 10: I IICS
Interchange Paszsword: | CS
Recipignt Code: I Tradacoms
Recipient Mame: | Tradacoms
Receiver DLIMNS+4: | RosettaMet
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Parts and
functions

Using Partners

The following lists the parts of the Partner Copy dialog box and their functions:

Part

Function

Profile ID

Specify a unique identifier for the selected partner.

Select Partner

Accesses the Import File Select Dialog Box, which allows
you to select a partner profile to copy.

Name

Specify a unique name for the partner.

Note
Make this name as descriptive as possible because this is
the name displayed in the partner selection list.

EDI Code

Specify the EDI identifier for this partner. The system uses
this value during inbound processing to select the correct
trading partner definition.

Application Code

Specify an application code used to identify this partner.
The system uses this value during outbound import
processing to select the correct trading partner definition.

Default Mailbox

Select the mailbox to identify this partner.

Reference
See the Communications User s Guide for more
information.

Group Receiver
Qualifier

Specify your partner's Qualifier as it will appear on the
UNG group header. Qualifiers are predefined by the EDI
standards.

Note

If the partner profile uses the EDIFACT or ODETTE
standard, you must complete this box. If you do not
complete this box, the system uses the value from the
copied partner profile's envelope information.

Group Receiver
ID

Specify your partner's Group ID. The value can be up to 15
characters.

Note

If the partner profile uses the ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must complete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envelope information.

(Continued on next page)
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Partner Copy Dialog Box

Part

Function

Interchange
Receiver
Qualifier

Specify your partner's Qualifier as it will appear on the
interchange header. Qualifiers are predefined by the EDI
standards. The value can be up to four characters.

Note

If the partner profile uses the ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must complete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envelope information.

Interchange
Receiver ID

Specify your partner's Interchange ID. The value can be up
to 15 characters.

Note

If the partner profile uses the ANSI, EDIFACT, ODETTE,
UCS, or TDCC standard, you must complete this box. If
you do not complete this box, the system uses the value
from the copied partner profile's envelope information.

Interchange
Communication
ID

Specify your BG communication identifier. This ID will
appear on the BG Interchange Header.

Note

If the partner profile uses the UCS standard, you must

complete this box. If you do not complete this box, the
system uses the value from the copied partner profile's
envelope information.

Interchange
Password

Specify a password that is agreed upon by you and your
trading partner. This password will appear on the BG
Interchange Header.

Note

If the partner profile uses the UCS standard, you must

complete this box. If you do not complete this box, the
system uses the value from the copied partner profile's
envelope information.

Recipient Code

Specify the code agreed on by you and your partner.

Notes

» Ifthe partner profile uses the TRADACOMS standard,
you must complete this box. If you do not complete
this box, the system uses the value from the copied
partner profile's envelope information.

» The Recipient Code is mandatory if you do not
complete the Recipient Name box.

(Continued on next page)
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Part Function

Recipient Name | Specify your partner's name.

Notes

» Ifthe partner profile uses the TRADACOMS standard,
you must complete this box. If you do not complete
this box, the system uses the value from the copied
partner profile's envelope information.

» The Recipient Name is mandatory if you do not
complete the Recipient Code box.

Receiver Specify the DUNS number of your partner.
DUNS+4

Note

This value is mandatory.
Save Saves the modified information.
Clear Clears the information from the dialog box.
Exit Exits the Partner Copy dialog box.
Help Displays Online Help.
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Importing Partner Profiles

Introduction  The partner profile defines the parameters that control the processing and
structure of inbound and outbound data. As a result, the partner profiles may
become complex and may require you to define a significant number of
parameters.

To simplify this process, Gentran:Server includes the import partner feature,
which enables you to import partner details from a file. The file of partner details
can originate from a partner profile that was exported from another copy of the
Gentran:Server system.

You can also use the import facility to update information for existing partners. If
you import to an existing partner profile, you can add new trading relationships.
Existing relationships are not modified.

Note
Any tables (cross-reference, lookup, or location) attached to the partner profile are
also imported.

Reference
See the Partner File Layouts appendix in the Administration Guide for more
information.

Before you begin  You must create a mailbox for the partner prior to loading the partner profile.
Please see the Communications Guide for more information.

Procedure  To import a partner profile, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Click Import.

System response
The system displays the Import File Select Dialog Box.

3 Select the partner file by doing the following:
» Navigate to the folder using the Look in drop-down list.

» Select the file or type the file name in the File name box.

(Continued on next page)
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Step

Action

Click Open.

System response
The system displays the Import dialog box.

Note
This dialog box allows you verify this partner is the correct one.

Click Save to continue.

If you are prompted to enter additional partner information, enter that
information and click Save.

System response

The system imports the partner details (if they do not already exist on
the system) and any relationships for which there are translation
objects. During this process, the system prompts you for any
additional information it needs by displaying the appropriate Partner
Editor dialog box. You are prompted with dialog boxes when you
would normally be required to provide information about your site.
This is usually restricted to your EDI identifiers, which the system
uses to generate outbound EDI envelopes. The system continues
displaying Partner Editor dialog boxes until it has all the information
it needs.

When the import is complete, the system displays the following
message:

Import process completed. Please note any warnings or
errors.

Click OK to return to the Import dialog box.

Click Exit to return to the Partner Editor dialog box.

6

Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Partners Exporting Partner Profiles

Exporting Partner Profiles

Introduction  Gentran:Server includes a feature that enables you to export existing partner
details to a file. You can also export your partners to disk to use as a backup of
your partner system.

Note
Any tables (cross-reference, lookup, or location) attached to the partner profile are
also exported.

Reference
See the Partner File Layouts appendix in the Administration Guide for more
information.

Procedure  To export a partner profile, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select a partner.
» Click Export.

System response
The system displays the Export File Build Dialog Box.

3 Name the export file by doing the following:

» Navigate to the correct folder using the Look in list.
» Type the name in the File name box.

Note

The system automatically prompts you to name the export file with
the name of the partner and the .par extension.

4 Click Save to export the partner.
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Copying Partner Profiles

Introduction  The partner copy function enables you to copy partner information so you do not
have to type in similar partner profiles from scratch. Instead, you can copy from
an existing profile and enter unique partner definition and key enveloping
information for the copied partner.

The partner copy function provides a quick method for establishing partners that
have similar or identical trading relationships.

Note

You must export the partner profile before you copy it. If you do not know which
EDI standard that partner profile uses, check the profile to obtain that information
before you export and copy it.

Reference
See Exporting Partner Profiles on page 3 - 87 for more information.

Procedure To copy a partner profile, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

Click Copy.

System response
The system displays the Partner Copy Dialog Box.

Click Select Partner.

System response
The system displays the Import File Select Dialog Box.

Select the file you want to copy by doing the following:
» Navigate to the folder using the Look in list.

» Type the file name in the File name box.

Click Open to copy that partner.

Note

The system displays the model partner profile name in the title bar of
the Partner Copy dialog box. The default file extension for exported
partners is .par.

(Continued on next page)
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Copying Partner Profiles

Step

Action

On the Partner Copy dialog box, type a unique profile identifier in the
Profile ID box.

In the Name box, type the partner name.

In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses this identifier during inbound processing to select
the correct partner.

If necessary, in the Application Code box, type an application code to
identify this partner.

Note
The system uses this identifier during outbound import processing to
select the correct partner.

10

Select the appropriate mailbox from the Default Mailbox list.

Note
See the Communications User s Guide for more information.

11

Complete the appropriate boxes in the enveloping section of the
dialog box.

Note

» You should only complete those boxes that are necessary for the
standard the copied partner profile uses. The standards are listed
to the right of each box.

» If'the partner profile you copied uses a standard, you must
complete all the necessary enveloping boxes for that standard. If
you do not complete the necessary boxes for the standard, the
system takes the necessary information from the copied partner
profile envelope.

Example
If the copied partner profile uses the UCS standard, you must
complete the Interchange Communication ID box, among others.

12

After you enter all the partner information, click Save.

System response
The system displays the Outbound Interchange Entry Dialog Box.

(Continued on next page)
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Step

Action

On the Partner Copy dialog box, type a unique profile identifier in the
Profile ID box.

In the Name box, type the partner name.

In the EDI Code box, type the EDI identifier for this partner.

Note
The system uses this identifier during inbound processing to select
the correct partner.

If necessary, in the Application Code box, type an application code to
identify this partner.

Note
The system uses this identifier during outbound import processing to
select the correct partner.

10

Select the appropriate mailbox from the Default Mailbox list.

Note
See the Communications User s Guide for more information.

11

Complete the appropriate boxes in the enveloping section of the
dialog box.

Note

» You should only complete those boxes that are necessary for the
standard the copied partner profile uses. The standards are listed
to the right of each box.

» If'the partner profile you copied uses a standard, you must
complete all the necessary enveloping boxes for that standard. If
you do not complete the necessary boxes for the standard, the
system takes the necessary information from the copied partner
profile envelope.

Example
If the copied partner profile uses the UCS standard, you must
complete the Interchange Communication ID box, among others.

12

After you enter all the partner information, click Save.

System response
The system displays the Outbound Interchange Entry Dialog Box.

(Continued on next page)
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Step

Action

13

Do you need to change the default mailbox?

» Ifyes, select the appropriate mailbox from the Default Mailbox
list. Or click New Mailbox to create a new mailbox

Then, click Save.

» Ifno, click Save.

System response
The system completes the partner copy operation, displays a
completion message.

14

Click OK.

System Response
The system returns to the Partner Copy dialog box.

15

Click Exit to return to the Partner Editor dialog box.
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Using Partners

Using Partner Tables

Overview

Introduction

Table use

Using tables

The translation process allows you to set up tables to use information in the
Partner database when a document is entered into the system, either from a file or
from the Document Editor facility.

The Partner Editor allows you to use an internal system partner (Internal System
User) to define your company to the system. Tables may be set up to be used
either with a trading partner or with the special system partner.

» Tables that you establish under a specific partner are valid only for that
partner.

» Tables that you set up under the internal system user can be used globally.

The use of partner or system partner tables is defined in the translation objects at
design time. This allows commonly used items such as names and addresses to be
inserted into the outbound data without the need to type it. It also allows you to
use Lookup and Cross-reference tables to supplement or convert data that you
either enter or receive.

You can create cross-reference and lookup tables in Gentran:Server, or you can
import and export existing tables to and from your system.

Notes
» You can only import and export Gentran:Server partner tables.

» Tables are used only if you create a translation object that specifically
accesses those tables.

6

Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Partners Partner Tables Dialog Box

Partner Tables Dialog Box

Introduction  The Partner Tables dialog box enables you to create, edit, or delete cross-reference
or lookup tables. Tables are only used with translation objects that are designed to
incorporate that data. When you receive a translation object from Sterling
Commerce, you will be informed if you need to create tables to be used with that
translation object.

Diagram  The following illustrates the Partner Tables dialog box:

Partner Tables - PETZ0ME E3

Tables: Exit

2
Edit...

Delete
Import

Ewport

A

Help

Parts and  The following lists the parts of the Partner Tables dialog box and their functions:

functions
Part Function
Tables Displays all currently defined partner tables.
Exit Exits the Partner Tables dialog box.
New Accesses the New Table Dialog Box, which allows you to

create a new table.

Edit Accesses either the CrossRef Select Dialog Box or the
Lookup Select Dialog Box, which allows you to edit the
selected table.

Delete Removes the selected partner table from the system.

Import Accesses the Table Import File Select Dialog Box, which
enables you to import a partner table.

Export Accesses the Table Export File Build Dialog Box, which
enables you to export a partner table.

Help Displays Online Help.
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New Table Dialog Box

Introduction  The New Table dialog box enables you to create a cross-reference or lookup table.

Diagram  The following illustrates the New Table dialog box:

Mew Table ER

Table Marme: I

Tahle Tupe
’75' Cross Reference ¢ Lookup

Parts and  The following lists the parts of the New Tables dialog box and their functions:
functions

Part Function

Table Name | Specify the name of the table.

Note

The table name must be the same as the name used in the
translation object that requires the table. If your database is
case-sensitive, when you reference the table using standard or
extended rules, you must type the exact name of the table
(including case).

Reference
See the Application Integration User s Guide for more
information about standard and extended rules.

Table Type | Specify the type of table. Valid values:

Cross-Reference Used to convert your values to your trading
partner's values during outbound processing,
and to convert your trading partner's values to
your values during inbound processing.

Lookup Used to find values in inbound or outbound
data.
Save Saves the modified information.
Exit Exits the New Table dialog box.
Help Displays Online Help.
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CrossRef Select Dialog Box

Introduction  The CrossRef Select dialog box contains all cross-reference partner tables.

Diagram  The following illustrates the CrossRef Select dialog box:

CrossRef Select - PETZONE E3

Table Mame: PRODCODE

673301 23456739 «--» 555666413 Help

Items: Mew...
2345678901 2345 <--»> BEREEEETT Edit...
345678901 23456 <--» BEDEEEI08 ;l
4ARETRI01 234567 <--» BERRER3 Delete |
BE78901 2345678 <--» BODEEE2ET7 —

Parts and  The following lists the parts of the CrossRef Select dialog box and their functions:

functions
Part Function

Items Displays a list of table items.

Exit Exits the CrossRef Select dialog box.

New Accesses the CrossRef Entry Dialog Box, which allows
you to create a new table item.

Edit Accesses the CrossRef Entry Dialog Box, which allows
you to edit the selected table item.

Delete Removes the selected table item.

Help Displays Online Help.
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CrossRef Entry Dialog Box

Introduction

Diagram

Parts and
functions

Using Partners

The CrossRef Entry dialog box enables you to create a new table item.

The following illustrates the CrossRef Entry dialog box:
CrossHef Entiy - PETZONE

Table Marme: FRODCODE

by W alue: I

Partrnier Walue: I

Dezcription:

eference Data:

—_ 4 /] M

The following lists the parts of the CrossRef Entry dialog box and their functions:

Part Function
My Value Specify your data value that corresponds to your partner's
data value.
Partner Value Specify your partner's data value that corresponds to your
data value.
Description Specify a description of the codes.

Reference Data Specify up to four values that can be mapped when they
are associated with a specific code value.

?l?etsz boxes are not currently used by Gentran:Server.
Save Saves the modified information.
Exit Exits the CrossRef Entry dialog box.
Help Displays Online Help.
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Lookup Select Dialog Box

Introduction  The Lookup Select dialog box contains all lookup partner tables.

Diagram  The following illustrates the Lookup Select dialog box.

Lookup Select - PETZONE |

Table Mame: PRODCODE

Itemz:

2
B Edit...

Delete

Help

Hew.
_ Do |
[ b |

Parts and  The following lists the parts of the Lookup Select dialog box and their functions:

functions
Part Function

Items Displays a list of table items.

Exit Exits the Lookup Select dialog box.

New Accesses the Lookup Entry Dialog Box, which allows you
to create a new table item.

Edit Accesses the Lookup Entry Dialog Box, which allows you
to edit the selected table item.

Delete Removes the selected table item.

Help Displays Online Help.
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Lookup Entry Dialog Box

Introduction  The Lookup Entry dialog box enables you to create a new table item.

Diagram  The following illustrates the Lookup Entry dialog box:

Lookup Entiy - PETZO0OME [ x|

Table Mame: PRODCODE

Lookup Y alue: | Exit

Help |
Drescription:

eference D ata;

B
|
|
|
|

Parts and  The following lists the parts of the Lookup Entry dialog box and their functions:
functions

Part Function

Lookup Value Specify the value that will be looked up in the data during
inbound or outbound processing.

Description Specify a description of the code.

Reference Data Specify up to four values that can be mapped when they
are associated with a specific code value.

"lltllfetsee boxes are not currently used by Gentran:Server.
Save Saves the modified information.
Exit Exits the CrossRef Entry dialog box.
Help Displays Online Help.
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Table Export File Build Dialog Box

Introduction  The Table Export function allows you to export partner cross-reference and
lookup tables to a sequential file. This allows you to define a table for one trading
partner and copy that table to another partner profile.

Notes

» You can only export Gentran:Server partner tables.

» The default file extension for cross-reference tables is .xrf. The default file
extension for lookup tables is .1kp.

Diagram  The following illustrates the Table Export File Build dialog box:

Save in: |El Partners j ﬁl

File name: IPETZDNEPHDDEDDE.Ikp

Save az lype: IE:-:pu:urt Files [*.lkp) ﬂ Canicel |

Help |

Parts and  The following lists the parts of the Table Export File Build dialog box and their

functions functions:

Part

Function

Save in

Select the folder where you want to save the file. Displays
the current folder.

File name

Specify the name of the file to be exported.

Save as type

Select the type of file.

Note
The default file extension for cross-reference tables is .xrf
and for lookup tables is .1kp.

(Continued on next page)

Gentran:Server for Windows User’s Guide

Gentran:Server for Windows — November 2005 ()



Table Export File Build Dialog Box

Using Partners

Part

Function

Save

Begins the table export process.

Cancel

Exits the dialog box without making a selection.

Help

Displays Online Help.

6
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Table Import File Select Dialog Box

Introduction

Diagram

Parts and
functions

The Table Import function allows you to import partner cross-reference and
lookup tables from a sequential file. This allows you to import tables created for
another partner profile, share tables with other users of Gentran:Server, and build
tables outside of Gentran:Server by formatting your data in the export file layout.

Notes
» You can only import Gentran:Server partner tables.

» The default file extension for cross-reference tables is .xrf. The default file
extension for lookup tables is .1kp.

The following illustrates the Table Import File Select dialog box:

Table Import File Select K E3

Lock ir |E Partners j ﬁl

File name: |".Hrf

Filez af pe: IEmss Reference Files [*.xif) j Cancel |
Help |

The following lists the parts of the Table Import File Select dialog box and their
functions:

Part Function

Look in Select the folder where you want the system to look for the
file. Displays the current folder.

File name Specify the name of the file to be imported.
Files of type Select the type of file.
Note

The default file extension for cross-reference tables is .xrf
and for lookup tables is .1kp.

(Continued on next page)
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Part Function
Open Begins the import process for the selected partner table
file.
Cancel Cancels the action and exits the dialog box.
Help Displays Online Help.
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Creating Partner Tables

Procedure  To create a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to create a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

Click New.

System response
The system displays the New Table Dialog Box.

In the Table Name box, type the unique table name.

Note

The table name must be the same as the name used in the translation
object that requires the table. If your database is case-sensitive, when
you reference the table using standard or extended rules, you must
type the exact name of the table (including case).

Reference
See the Application Integration User’s Guide for more information
about standard and extended rules.

In the Table Type section, select the Cross-reference or Lookup table
option.

Click Save.

System response

Saves the information you entered and accesses either the CrossRef
Select Dialog Box or Lookup Select Dialog Box depending on which
type of table you selected in Step 5.

(Continued on next page)
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Step

Action

Click New.

System response
Displays either the CrossRef Entry Dialog Box or Lookup Entry
Dialog Box depending on which type of table you selected in Step 5.

Type the following table values:

» Two values for a cross-reference and one value for a lookup table
» A description

Note

How your data is used depends on how the translation object is

defined. Consult with the translation object designer if you are
unclear about what is required.

Click Save after each entry to save the information and enter another
table record.

10

Once you finish typing all entries, click Exit to return to the
Cross-reference or Lookup Select dialog box.

11

Click Exit to return to the Partner Editor dialog box.

6
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Editing Partner Tables

Procedure  To edit a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to modify a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

» Select the table you want to modify.
» Click Edit.

System response
Displays either the CrossRef Select Dialog Box or Lookup Select
Dialog Box (depending on the type of table).

» Select the item you want to modify.
» Click Edit.

System response
Displays either the CrossRef Entry Dialog Box or Lookup Entry
Dialog Box depending on the type of table.

Modify the entry.

After you finish modifying all necessary table entries, click Save.

System Response
The system returns to the Cross-reference or Lookup Select dialog
box.

Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Deleting Entries in a Partner Table

Procedure  To delete entries in a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to delete a table entry.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

» Select the table you want to modify.
» Click Edit.
System response

The system displays either the CrossRef Select Dialog Box or
Lookup Select Dialog Box depending on the type of table.

» Select the item you want to modify.
» Click Delete.

System response
The system displays the Confirm Delete dialog box.

Click Yes to complete the deletion.

System response
The system returns to either the CrossRef Select Dialog Box or
Lookup Select Dialog Box depending on the type of table.

Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Deleting Partner Tables

Procedure  To delete a partner table, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile for which you want to delete a table.
» Click Tables.

System Response
The system displays the Partner Tables Dialog Box

3 » Select the table you want to delete.
» Click Delete.

System response
The system displays the Confirm Delete dialog box.

4 Click Yes to complete the deletion.

System Response
The system returns to the Partner Editor dialog box.
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Exporting Partner Tables

Introduction

Export file layout

The Table Export function allows you to export partner cross-reference and
lookup tables to a sequential file. This allows you to define a table for one trading
partner and copy that table to another partner profile.

Reference
See the Partner File Layouts appendix in the Administration Guide for more
information.

Typically, you export and then import tables created for another partner profile.
However, if necessary, you can build tables outside of Gentran:Server by
formatting your data in the export file layout.

The export file layout is a free-format ASCII text file. Each field must be
delimited (separated) with Hex01 because the field lengths are variable.

Note

You can create the file with a text editor (such as Notepad). The default file
extension for a lookup export file is .lkp. The default file extension for a
cross-reference file is .xrf.

Lookup table fields
The following table identifies the fields in lookup tables. Mandatory ficlds are
designated with an asterisk (*).

Field Description
PartnerKEY* Unique identifier for the partner
TableCode For lookup, this value is “L”.
TableName* Descriptive name for the table

This value is displayed in the table selection list.

Item* Value that is looked up in the data during inbound
or outbound processing

Description Brief comment about the item

Textl, Text2, Text3, Text4 | Additional reference information as required by
the translation object using this table
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Export file layout  Cross-reference table fields
(contd)  The following table identifies the fields in cross-reference tables. Mandatory
fields are designated with an asterisk (*).
Field Description
PartnerKEY* Unique identifier for the partner
TableCode For cross-reference, this value is “C”.
TableName* Descriptive name for the table
This value is displayed in the table selection list.
Myltem* Your data value that corresponds to your partner’s
data value
Partnerltem* Your partner’s data value that corresponds to your
data value
Description Brief comment about the item
Textl, Text2, Text3, Text4 | Additional reference information as required by
the translation object using this table
Procedure  To export a partner table, complete the following steps:
Step Action
1 From the Tools menu, select Partner Editor.
System Response
The system displays the Partner Editor Dialog Box.
2 » Select the partner profile or the system partner (Internal System

table.

» Click Tables.

User) for which you want to export a Cross-reference or Lookup

System Response
The system displays the Partner Tables Dialog Box.

3 Click Export.

System response
The system displays the Table Export File Build Dialog Box.

(Continued on next page)
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Step Action
4 From the Save in drop-down list, select the location of the exported
table file.
Note

You can only export Gentran:Server partner tables.

5 » Type the export file name in the File name box.

OR
» Select it from the list.

Note
The default file extension for cross-reference tables is .xrf. The
default file extension for lookup tables is .lkp.

6 Click Save to begin the export process.

Note
When the export process is complete the system displays an
informational dialog box.

7 Click OK.

System Response
The system returns to the Partner Tables dialog box.

8 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Importing Partner Tables

Introduction  The Table Import function allows you to import partner cross-reference and
lookup tables from a sequential file. This allows you to import tables created for
another partner profile and build tables outside of Gentran:Server by formatting
your data in the export file layout.

Reference
See the Partner File Layouts appendix in the Administration Guide for more
information.

Procedure  To import a partner table, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to import a Cross-reference or Lookup
table.

» Click Tables.

System Response
The system displays the Partner Tables Dialog Box.

Click Import.

System response
The system displays the Table Import File Select Dialog Box.

From the Look in drop-down list, select the location of the table file.

» Type the import file name in the File name box.

OR
» Select it from the list.

Notes
» You can only import Gentran:Server partner tables.

» The default file extension for cross-reference tables is .xrf. The
default file extension for lookup tables is .lkp.

(Continued on next page)
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Step Action

6 Click Open to begin the import process.

Note
When the export process is complete the system displays an
informational dialog box.

7 Click OK.

System Response
The system returns to the Partner Tables dialog box.

8 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Overview

Using Partner Locations

Overview

Introduction

Necessary
parameters

Before you begin

Each partner profile may have many associated location tables. The location
tables may contain address- and contact-related information about the partner.
You can use location tables in many different ways. Locations are referenced in
translation objects through one of the location keys (reference codes). Locations
are used only if you use a translation object that specifically accesses those
locations.

Example
You may need a list of a partner’s store addresses, warechouse addresses, or
“invoice to” addresses. Any or all of these can be stored in a location table.

You must set up two parameters that contain the following information:
» The name of the trading partner location

» The reference codes that the system uses to identify this location

These parameters are used to create a partner location.

Before setting up a partner location, you must know the following information to
plan the implementation of this partner:

» The unique name that identifies this partner location

» At least one reference code to identify the location
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Location Select Dialog Box

Introduction  The Location Select dialog box allows you to add, edit, and delete partner-specific
name and address information. Locations are only used with translation objects
that are designed to incorporate that data.

Diagram  The following illustrates the Location Select dialog box:

Location Select - PETZ0ONE E3

Locationz: E it |

Edif.. |
[elete |
Help |

Parts and  The following lists the parts of the Location Select dialog box and their functions:

functions
Part Function
Locations Displays all defined locations.
Exit Exits the Location Select dialog box.
New Accesses the Location Entry Dialog Box, which allows

you to create a new location.

Edit Accesses the Location Entry Dialog Box, which allows
you to edit the selected location.

Delete Removes the selected location from the system.

Help Accesses Online Help.
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Location Entry Dialog Box

Location Entry Dialog Box

Introduction  The Location Entry dialog box enables you to create and edit location

information.

Diagram  The following illustrates the Location Entry dialog box:

Location Entry - PE TZONE ]|

Mame: I
Reference Codel:

Reference Codez:

LContact:

Address1

Address3

|

:
Addresss: I
-

|

City:

State: I £ip Code; I
Country: I

Fhone: I

Parts and  The following lists the parts of the Location Entry dialog box and their functions:

functions

Part

Function

Name

Specify the name of this trading partner location. This
name should accurately describe the location because this
box will be displayed in the location selection list.

Note
This box is mandatory.

Reference Codel

Specify a reference code to identify the location being
defined (such as a DUNS number).

Note
This box is mandatory.

(Continued on next page)
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Part

Function

Reference Code2

Specify a reference code to identify the location being

defined (such as a DUNS number).

Contact

Specify the name of a personal contact.

Address1
Address2
Address3

Specify the partner’s business address.

City

Specify the partner’s city.

State

Specify the partner’s state.

Zip Code

Specify the partner’s zip or postal code.

Country

Specify the partner’s country.

Phone

Specify the partner’s phone number.

Fax

Specify the partner’s fax number.

Save

Saves the modified information.

Exit

Exits the Location Entry dialog box.

Help

Displays Online Help.

6
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Creating Partner Locations

Creating Partner Locations

Procedure  To create partner locations, complete the following steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to create a location.

» Click Locations.

System Response
The system displays the Location Select Dialog Box.

Click New.

System response
The system displays the Location Entry Dialog Box.

In the Name box, type a unique identifier that defines this location
within the partner.

In the Reference Code 1 box, type the unique identifier for the
location you are defining.

Example
The DUNS number for the location.

Complete the remaining boxes, as necessary.

Note
If you use Reference Code 2, it must also be unique.

Click Save.

System response
Saves the location information and displays a blank Location Entry
dialog box.

If you want to enter additional locations for this partner, repeat steps
4 through 7 as many times as necessary.

Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Editing Partner Locations

Procedure To edit a partner location, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 » Select the partner profile or the system partner (Internal System
User) for which you want to create a location.

» Click Locations.

System Response
The system displays the Location Select Dialog Box.

3 » From the Locations list, select a location.
» Click Edit.

System response
The system displays the Location Entry Dialog Box.

4 Make any necessary changes.

Note
The Reference Codel box must be completed.

5 » Click Save to save the location information and return to the
Location Select dialog box.

OR
» Click Exit to return to the Location Select dialog box without
saving changes.

6 Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Delete Partner Locations

Procedure  To delete a partner location and all associated records, complete the following

steps:

Step

Action

1

From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

» Select the partner profile or the system partner (Internal System
User) for which you want to create a location.

» Click Locations.

System Response
The system displays the Location Select Dialog Box.

» From the Locations list, select a location.
» Click Delete.

System response
The system displays the Delete Confirmation dialog box.

Click Yes to confirm the delete.

Click Exit.

System Response
The system returns to the Partner Editor dialog box.
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Using Documents

Introduction

In this chapter

EDI documents

Document Editor

Introduction

This chapter explains how to use the Gentran:Server document functions,
including:

» creating and editing documents

» managing documents

» routing documents

Gentran:Server tracks the relationship between an EDI document and the
corresponding application data. For import processing, the system makes a
persistent copy of the application data at the start of processing. For inbound
(export) processing, the system assigns a unique identifier to the document, which
is then permeated throughout the system for all database entries associated with
the received document.

References
For additional information, see the following:

» Importing Documents on page 4 - 57
» Exporting Documents on page 4 - 59
» Using Tracking, chapter 9 in this guide

The Document Editor feature is the Gentran:Server data entry tool. It allows you
to create, modify, and view documents.

Note

To use the Document Editor, you must register the appropriate screen entry
translation object with the system and set up a corresponding outbound
relationship for the partner.
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Document Browsers

Accessing the Document Browsers

Introduction  You can access document browsers in Gentran:Server in one of three ways:

» The Desk gives you access to the In Documents, ?In Documents, Workspace,
Out Documents, ?0Out Documents, Interchanges, In Drawer, and Out Drawer.

» The Main Toolbar gives you access to the In Documents, ?In Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer, Out
Drawer, and Send Queue.

» The View menu gives you access to the In Documents, ?In Documents,
Workspace, Out Documents, ?0ut Documents, Interchanges, In Drawer, Out
Drawer, and Send Queue.

Summary dialog  If you select the In Documents, ?In Documents, Out Documents, ?0Out
boxes Documents, In Drawer, or Out Drawer browser from any of the three locations
above, the system displays the appropriate summary dialog box for that browser.

The summary dialog box displays the number of each type of document for each
partner contained in the appropriate browser. This enables you to filter the display
of documents in the browser to only those of the document type and partner that
you want.

Browser columns  The following lists the columns displayed in all browsers:

Part Function
Partner Identifies the trading partner.
Type Identifies the specific type of EDI document.
Example

810 identifies an invoice.

Name Displays the user-assigned name of the document.
Status The allowable status depends on the browser.
Reference

See the Glossary for more information about status values.

(Continued on next page)
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Part Function

RefData Displays the reference data assigned by the translation
object designer to identify this document:

» Segment/element positional value (such as a PO
Number for a purchase order)

» Blank (no reference data is assigned)

Note
In the browsers, you can click a column heading to sort the display by that values
in that column.

Procedure  To access any of the document browsers, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the browser.

System Response
The system displays the appropriate summary dialog box for that
browser.

2 Select the type of document for the appropriate partner.

Notes

» To highlight more than one partner/document type combination,
click on the first partner/document type and then press SHIFT
and click the last partner/document type in the group.

» To highlight several partner/document types that are not adjacent
to each other in the summary dialog box, press CTRL and click
the partner/document types.

3 Click View.

System response
The system displays the browser containing those documents.
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In Documents Browser

Introduction

Diagram

Parts and
functions

Using Documents

The In Documents browser contains a list of documents that the system received
but that have not yet been processed by the user. After the documents are
processed (printed or exported) the documents are transferred to the In Drawer.

The following illustrates the In Documents browser:

* In Documents - PETZONE - 850 - 2 = E3
Farther | Type | M ame | Status Wigw, . I
FETZOME I il ] Fri
PETZ0OM ELi 1234567890 ok L5

Delete
Expart...
Mowve
Receiwe
Fefrezh
« | ] ferEsn |
Cloze

2 Documents w 1zelected =

<7 ok

The following lists the parts of the In Documents browser and their functions:

Part Function
View Accesses the View Choice Dialog Box, which allows you
view the selected document.
Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.
Delete Deletes the selected document.

Note

If a document is waiting for acknowledgement processing
(acknowledgement generation or reconciliation), you can
not delete it until this processing is complete.

(Continued on next page)
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In Documents Browser

Part

Function

Export

Accesses the Select Export Method Dialog Box, which
allows you to export the selected document

Move

Moves the selected document to the In Drawer.

Receive

Accesses the Communication Session dialog, which allows
you to begin a receive-only session.

Refresh

Refreshes the display of the browser.

Close

Closes the browser.

Help

Displays Online Help.
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2In Documents Browser

Introduction  The ?In Documents browser contains a list of documents that the system received
but failed compliance checking or do not have an identifiable partner or
transaction set.

Diagram  The following illustrates the ?In Documents browser:

i ?In Documents - - ORDERS - 1 =
Fartner I Type I MHame | Status Wiew. .. I
Unkrnown S Urikriown )

Unknown nkhown Print_
Delete
Export...

tove |

Fefrezh

1 |

1 Documents i 1 selected

Cloze

Help

Parts and  The following lists the parts of the ?In Documents browser and their functions:
functions

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Note

If a document is waiting for acknowledgement processing
(acknowledgement generation or reconciliation), you may
not delete it until this processing is complete.

(Continued on next page)
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Part Function
Export Accesses the Select Export Method Dialog Box, which
allows you to export the selected document
Move Moves the selected document to the In Drawer.
Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.
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In Drawer Browser

Introduction  The In Drawer browser contains a list of documents that the system received and
processed.

Diagram  The following illustrates the In Drawer browser:

* In Drawer - Rons Egos - Receipt Acknowledge - 1 M= B3
Fartner | Tyupe | Mame | Status Wik, . I
leceipt Acknow... B0 .
A L : Frint...
Delete
Expart...

Rezpond |

Fiefresh
4| | _bl - — |
Cloze
1 Documents 7 1zelected ———
Eﬁ Help

Parts and  The following lists the parts of the In Drawer browser and their functions:
functions

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Accesses the Select Export Method Dialog Box, which
allows you to export the selected document.

(Continued on next page)
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In Drawer Browser

Part

Function

Respond

Creates a turnaround document in response to the selected
document or documents.

Note

The Respond function is only valid when one or more
documents are selected and Turn Around translation
objects exist for the selected documents.

Reference
See Inbound Translation Object Dialog Box on page 3 - 15
for more information.

Refresh

Refreshes the display of the browser.

Close

Closes the browser.

Help

Displays Online Help.
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Workspace Browser

Introduction

Diagram

Parts and
functions

Using Documents

The Workspace browser contains a list of documents that the system received but
that have not yet been processed by the user. After the documents are processed
(printed or exported) the documents are transferred to the In Drawer.

The following illustrates the Workspace browser:

* Workspace - 1

= 3

Partner

| Type | Mame | Status Wiew... I

1

Frint...
Delete

Ewpart..

Open
Piost
Mew...
Impaoit...

Refresh

1 Documents

Cloze

i 1 zelected T
EW el

The following lists the parts of the Workspace browser and their functions:

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Not a valid function for this browser.

Open Accesses the Document Editor facility, which allows you
to edit the selected document.

(Continued on next page)
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Workspace Browser

Part

Function

Post

Moves the selected compliant document to the Out
Documents Browser.

Note
Post documents to the Out Documents before sending
them.

New

Accesses the Create New Document dialog box, which
allows you to select a partner/transaction set combination
for which you want to enter a new document using the
Document Editor facility.

Note

The Document Editor uses the associated screen entry
translation object to allow information to be entered into
the system.

Reference
See Creating an Outbound Relationship on page 3 - 66 for
more information.

Import

Accesses the Application Files to Import Dialog Box,
which allows you to import data from an external
application file.

Note

Depending on the content of the file, the system may
prompt you for partner, transaction, or translation object
information. The Import function does not affect any
selected documents.

Refresh

Refreshes the browser display.

Close

Closes the browser.

Help

Displays Online Help.

Gentran:Server for Windows User’s Guide

Gentran:Server for Windows — November 2005 ()



Out Documents Browser Using Documents

Out Documents Browser

Introduction = The Out Documents browser contains a list of documents that are ready to be sent.

After the documents are successfully sent, they are automatically transferred to
the Out Drawer.

Diagram  The following illustrates the Out Documents browser:

* OQut Documents - PETZ0ONE - 810 -5 !Eﬁ
Partrer | Type | M ame I Status Yiew,.. I
PETZONE g 000000005 4 Fi
FETZONE &1 0000000006 ok It
FETZONE 2410 Qooaooaoay (4 Delete
FETZOME 2410 Qooaooaoos (]

FETZOME 2410 Q0oaooa0o3 (4 Epport...
Send
UnPozt
Refresh
| | ] — |
Close
5 Documents a Tselected ——
o e

Parts and  The following lists the parts of the Out Documents browser and their functions:
functions

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Not a valid function from this browser.

(Continued on next page)
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Part Function

Send Accesses the Send/Receive dialog box, which enables you
to manually start a communications session to send data.

Notes

» Only selected documents will be enveloped and sent. If
no documents are selected then a// documents will be
sent. Successfully sent documents will be moved to the
Out Drawer.

» Initiating a Send session also prompts the system to
receive any documents that are waiting to be received.

» The Send function is only valid if Out Documents is
the currently selected browser and documents are
present or if interchanges in the Interchanges browser
have a Ready status.

UnPost Moves the selected document back to the Workspace
browser.

Refresh Refreshes the display of the browser.

Close Closes the browser.

Help Displays Online Help.
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?20ut Documents Browser

Introduction  The ?Out Documents browser contains a list of documents that were imported into
the system but are invalid.

Diagram  The following illustrates the ?0ut Documents browser:

i ?0ut Documents - 810 - PETZONE - 2 M= E
Partrer I Tupe I M ame I Status | Wiew... I
FET-0OMNE 210 Fatk, Print
PETZ0OM a10 Q000000008 MHatdk.

Delete
Erport. .

Maove |

Refresh

4| | 10
Cloze

2 Documents a7 1 selected
=N

Parts and  The following lists the parts of the ?0Out Documents browser and their functions:
functions

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete Deletes the selected document.

Export Not a valid function from this browser.

Move Moves the selected document to the In Drawer.
Refresh Refreshes the browser display.

Close Closes the browser.

Help Displays Online Help.
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Out Drawer Browser

Out Drawer Browser

Introduction = The Out Drawer browser contains a list of documents that the system successfully

sent.

Diagram  The following illustrates the Out Drawer browser:

* Out Drawer - Bons Egogs - Purchase Order Request Action - 1 M= B

Fartner

4]

Furchasze Crder ...

| Tyupe | Mame | Status Wi, I

Frint...
[elete

Exmart,

Copy
Al

| - Fefresh

1 Documents

Cloze

— 1selected ——
EH seleche Help

Parts and  The following lists the parts of the Out Drawer browser and their functions:

functions

Part

Function

View

Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print

Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Delete

Deletes the selected document.

Export

Not a valid function from this browser.

Copy

Copies the selected documents to the Workspace.

Note
This function enables you to reprocess and resend
documents that were already sent by the system.

(Continued on next page)
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Part Function
Ack Changes the status of the selected documents to
Acknowledged.
Refresh Refreshes the browser display.
Close Closes the browser.
Help Displays Online Help.
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Processing Browser

Processing Browser

Introduction  The Processing browser contains a list of documents that the system is currently

processing.

Note

The Processing browser displays the current status of the processing document. If
the document is processing, the status code is set to 1. If the document or
acknowledgement is deferred, the status code is set to 2.

Diagram  The following illustrates the Processing browser:

* Processing - 0

SIE E3

Partrer

| Hame | RefDat EEset I

4]

Refresh
| B et |

0 Documents

Cloze

F Oselected ——————
L Help

Parts and  The following lists the parts of the Processing browser and their functions:

functions

Part

Function

Reset

Returns to their previous location any documents that are
displayed on this dialog box but for which processing has
terminated.

Note
This function is typically used for exception cases when
the processing of a document terminated improperly.

Refresh

Refreshes the browser display.

Close

Closes the browser.

Help

Displays Online Help.
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Related Dialog Boxes

View Choice Dialog Box

Introduction  The View Choice dialog box enables you to specify how you want to view the
selected document.

Diagram  The following illustrates the View Choice dialog box:

Yiew Choice |

" Gentran Data
" External Data
" Formatted Documerk

™ Translatar Fepaort
" Data Audit

" Tracking Information

Cancel |

Parts and  The following lists the parts of the View Choice dialog box and their functions.
functions  You can select only one of these options.

Part Function

Gentran Data Displays the raw EDI data.

External Data Displays the data file used in translation.

Note
This option is not available if the external data file used in
translation does not exist.

Formatted Displays the data in the Document Editor using a screen
Document entry translation object.
Note

This option is not available if no screen entry translation
object exists for the document.

(Continued on next page)
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View Choice Dialog Box

Part

Function

Translator
Report

Displays a report of the actions the translator took on this
document and lists any EDI- or translation object-based
compliance errors.

Reference
See Error Messages in the Administration Guide for more
information about translator reports.

Data Audit

Displays the document tracking information that is
available for a single document.

Note
This function is not available if document level auditing is
disabled.

Tracking
Information

Displays information that tracks an external data file.

OK

Executes the selected function; exits the dialog box.

Cancel

Exits the dialog box.
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Print Choice Dialog Box

The Print Choice dialog box enables you to specify whether you want to print the
selected item (document or translation object) or a summary list of all items in the
browser.

Introduction

Diagram  The following illustrates the Print Choice dialog box:

Parts and
functions

Print Choice [ x|

i+ Selected ltems.
I Eormatted

¥ Move documents to In Drawer

= Sumrnary List of [bems.

Cahcel

_Cred |
Help |

The following lists the parts of the Print Choice dialog box and their functions:

Part

Function

Selected Items

Tells the system to perform the selected items or items (the
following two fields).

Formatted

Tells the system to print the items as formatted (using the
appropriate translation object).

Note

This option is unavailable when printing a translation
object (always formatted) or when a print translation object
does not exist for the item.

Move documents
to In Drawer

Tells the system to move the document to the In Drawer.

Note
This option is only available for the In Documents and ?In
Documents browsers.

Summary List of | Tells the system to print a summary list of the items
Items selected in the browser.

OK Executes the selected function; exits the dialog box.
Cancel Exits the dialog box.

Help Accesses Online Help.
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Select Export Method Dialog Box

Introduction  The Select Export Method dialog box enables you to write documents to an
external file for processing by another application.

Notes

» There must be a system export translation object for the document or a
partner-specific export translation object for the document.

» The Export function is only valid when one or more documents are selected
from one of the following browsers: In Documents, In Drawer, or ?In
Documents.

Diagram  The following illustrates the Select Export Method dialog box:

Select Export Method E3

& Ewport to Single File Cancel |

" Export to Default Files
" Select File by Document

Help |

Parts and  The following lists the parts of the Select Export Method dialog box and their
functions  functions. You can select only one of these options.

Part Function

Export to Single | Converts all selected documents to data and accesses the
File Choose File to Export Document Dialog Box to write them
to a single file.

Export to Default | Writes selected documents to the files set up in the partner
Files inbound relationship.

Reference
See Inbound Translation Object Dialog Box on page 3 - 15
for more information about designating the export file.

Select File by Accesses the Choose File to Export Document Dialog Box,

Document which enables you to rename selected documents to be
exported.

OK Executes the selected function; exits the dialog box.

(Continued on next page)

Gentran:Server for Windows User’s Guide Gentran:Server for Windows — November 2005 ()



Select Export Method Dialog Box
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Part

Function

Cancel

Exits the dialog box.

Help

Accesses Online Help.

Gentran:Server for Windows — November 2005
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Choose File to Export Document Dialog Box

Introduction  The Choose File to Export Document dialog box enables you to specify the name
of the file to which the system exports the selected document.

Notes

» There must be a system export translation object for the document or a
partner-specific export translation object for the document.

» The Export function is only valid when one or more documents are selected
from one of the following browsers: In Documents, In Drawer, or ?In
Documents.

Diagram  The following illustrates the Choose File to Export Document dialog box:

Chooze file to Export document:

Look in: I £ Expaorts

File nare: I

Files of type: |Tentfiles[".t:-:t] j Cancel |

Parts and  The following lists the parts of the Choose File to Export Document dialog box
functions  and their functions:

Part Function

Look in Select the folder where the system should look for the file.
Displays the current.

File name Specify the name of the export file.

Files of type Select the type of file.

Open Executes the selected function; exits the dialog box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Application Files to Import Dialog Box

Introduction  The Application Files to Import dialog box enables you to import data from an
external application file.

Note

Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information. The Import function does not affect
any documents that may be selected.

Diagram  The following illustrates the Application Files to Import dialog box:

Application Files to Import |
Lok jn: |El Imports j | ﬁFl e EE

B [0, bt

Pet_gire. bt
=] Pat_tinw. st
File narne: |F'et_8'| (0.tat Open
Files of type: [l files 7] = Cancel

Wi

Help

Parts and  The following lists the parts of the Application Files to Import dialog box and
functions their functions:

Part Function

Look in Select the folder where the system should look for the file.
Displays the current.

File name Specify the name of the export file.

Files of type Select the type of file.

Open Executes the selected function; exits the dialog box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Document Search Dialog Box

Introduction = The Document Search dialog box enables you to specify criteria for which
Gentran:Server performs a system-wide search. This enables you to quickly
access a subset of documents without searching each browser manually.

Diagram  The following illustrates the Document Search dialog box:

i Document Search

Enter zearch critena to dizplay Tracking Information for
each match found:

Docurment Mame:

RefData:

Partner:

Diocument Type:

Application Field 1:

Application Field 2;

Application Field 3:

Application Field 4:

Application Field 5:

Application Field &:

LCloge |

Parts and  The following lists the document search criteria and their descriptions:
functions

Criteria Description

Document Name Searches for documents with the specified user-assigned
document name.

RefData Searches for documents with the specified reference data
(assigned by the translation object designer).

Partner Searches for documents with the selected partner 1D
(identifies the partner for/from whom the document was
generated or received).

(Continued on next page)
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Criteria

Description

Document Type

Searches for documents of the specified EDI type.

Example
810 identifies an invoice.

Application Field 1

Searches for documents with the specified value in
Application Field 1.

Application Field 2 | Searches for documents with the specified value in
Application Field 2.

Application Field 3 | Searches for documents with the specified value in
Application Field 3.

Application Field 4 | Searches for documents with the specified value in
Application Field 4.

Application Field 5 | Searches for documents with the specified value in
Application Field 5.

Application Field 6 | Searches for documents with the specified value in

Application Field 6.

6
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Filter Dialog Box

Introduction  The Filter function can be used when the Out Drawer is active to filter the display
of documents by status.

If you want to filter the display of documents in the Out Drawer by the document
status you can choose not to display documents with a certain status by selecting
the check box next to each status that you do nor want displayed.

Note
When you clear a check box, the display of that status is turned “off.” The default

is to display documents regardless of status.

Diagram  The following illustrates the Filter dialog box:

Filter DutDrawer Contents E

— Filter
v Sent
V¥ Feceived by Metwark

W wharming from Mebwark:

v Errar from Metwork

W Picked Up by Trading Partner
v Acknowledged with Mo Emors

v wiaiting for Acknowledgement

W Acknowledgements Dverdue
W Acknowledgements with Emrars
v Partially scknowledged

W Acknowledged but Fejected

¥ Send Failed
Cancel |

Parts and  The following lists the filter criteria and their descriptions:

functions
Part Function
Sent Filters for documents that were successfully transmitted.
Received by Filters for documents that were successfully delivered to
Network a Value Added Network (VAN).
Warning from Filters for documents that were delivered to a VAN,
Network which detected non-critical errors in the data.
(Continued on next page)
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Part

Function

Error from Network

Filters for documents that were delivered to a VAN,
which detected critical errors in the data.

Picked up by Filters for documents that were successfully delivered to

Trading Partner a trading partner through a VAN.

Acknowledged with | Filters for documents that were acknowledged by your

No Errors partner with no errors.

Waiting for Filters for documents that are waiting to be reconciled

Acknowledgement | with an inbound functional acknowledgement.

Acknowledgements | Filters for documents that are waiting to be reconciled

Overdue with an inbound functional acknowledgement but have
exceeded the number of hours by which the
acknowledgement is deemed late.

Acknowledgements | Filters for documents that were acknowledged by your
with Errors partner with errors. These documents were accepted by
your partner in spite of the errors.

Partially Filters for documents that were partially acknowledged.

Acknowledged
Note
If your partner is going to issue partial
acknowledgements at the interchange or group level,
they should also indicate acceptance or rejection at the
transaction level.

Acknowledged but | Filters for documents that were acknowledged by your

Rejected partner with errors. These documents were rejected by
your partner.

Send Failed Filters for documents for which the send transmission

failed.
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Creating and Editing Documents

Creating Documents

Introduction  To create a document using the Document Editor, the system must be set up to
support screen entry for the partner/transaction set combination you want to enter.

Note
The appropriate Screen Entry translation object must be registered and a
corresponding Outbound relationship must be set up for the partner.

References
For additional information, see the following:

»  Registering New Translation Objects on page 2 - 7
» Creating an Outbound Relationship on page 3 - 66

» Gentran:Server Online Help (Document Editor)

Procedure  To create a document, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select Workspace.

System Response
The system displays the Workspace Browser.

2 Click New.

System response
The system displays the Create New Document dialog box.

(Continued on next page)
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Step Action

3 Select the appropriate partner/transaction set combination from the
list and click OK.

System response
The system displays the translation object for the selected
combination, as shown below:

ocument Editor - ANSI %12 Invoice [810] - Pet Zone

File Edit Group Wiew window Help
=TT = N A T B RRT )
ANSI X12 Invoice [810) - Pet Zone M=
voieeo. [ IvoiceDate [ | :‘ Open
L PODae [ — st
New:
EontractNo.:l Contract Date |:| Dol
ShipTo | | Brev
| | =
| | Frame ?
[ 1] |
Remit To | |
| |
| |
| 1L |
Payment Terms Cade =
=
[For Help, press F1 [ NOM[ s

(Continued on next page)
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Creating Documents

Step

Action

Type all the required data items into the boxes on the document
translation object.

Note

If the document contains a looping structure (lower-level detail
records such as line items), the input translation object contains a list,
as shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone

File Edit Group Wiew ‘window Help
dl@] =2 @ (ox]«(»]|
ANSI X12 Invoice [810] - Pet Zone M= 3

Itemn Product Qty. Price 2l Open

Store

Line Items

New
Del

Prew.

MNumber OF Line ltems I:l _I Next
Frame ?
Tatal Invoice Amount |:|

Jud

|For Help, press F1 LI i

To access items in a list, highlight the first entry and click New.

System response
The system displays the list box, as shown below:

Line Items =] 3
Item Mo I:l Product Code I:l Guantity I:l :A Open
™ Store
New,
Description | el
[rate Shipped I:lTransport Methodl vl Carrier Eodel Prev
Next

Frame ?

Enter the data for the item.

Notes

» To enter a second or subsequent item, click Next or press
ALT + T.

» After all loop items are entered, click Store to save and exit the
loop dialog box.

» Ifthe document contains codes, press SHIFT + F1 from each
code field to access a list of the codes.

(Continued on next page)
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Step Action

7 If the document contains calculated fields, select Recalculate from
the File menu before saving the document.

System response
The system updates the totals and checks the document for errors.

8 When you are finished entering data, select Save from the File menu.

System response

The system saves the information and automatically recalculates and
check for errors. If errors are found, you are prompted to view the
errors.

9 From the File menu, select Exit.

System response
You exit the Document Editor. The system prompts you to save the
document before closing.

Note
You can now open and edit this document from the Workspace
Browser.
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Opening and Editing Documents

Introduction

Procedure

To edit a document using the Document Editor, you need to set up the system to
support screen entry for the partner/transaction set combination you want to edit.

Note
The appropriate Screen Entry translation object must be loaded and a
corresponding outbound relationship must be set up for the partner.

References
For additional information, see the following:

»  Registering New Translation Objects on page 2 - 7
» Creating an Outbound Relationship on page 3 - 66

» Gentran:Server Online Help (Document Editor)

To open and edit a document, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select Workspace.

System Response
The system displays the Workspace Browser.

2 Select the desired document from the Workspace.

Note
Only documents in the Workspace can be edited.

» Ifthe document has already been moved to the Out Documents
and has not been sent, you can move it back to the Workspace
using the UnPost function (see UnPosting Documents on
page 4 - 54).

» Ifadocument has been sent, it cannot be modified. However,
you can move a copy of the document from the Out Drawer to
the Workspace, modify the copy, and send it (see Copying a
Document (to Reprocess and Resend) on page 4 - 52).

(Continued on next page)
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Step Action

3 Click Open.

System response

The system displays the document in the Document Editor facility, as
shown below:

7 Document Editor - ANSI %12 Invoice [810] - Pet Zone

File Edit Group Wiew ‘window Help

=TT = N A T B RRT )

ANSI X12 Invoice [810) - Pet Zone =] E3
Imvoice No. [0714653 Irvvoice Date [05/11/97 :‘ Open
L Store
F.O. Mo,  |PO18535 F.O. Date 0511/97
New,
Cantract Mo. 1203 Contract Date [11,/11/95 =
WE
Ship To  [MwT Ca. | Prov
4675 Lakshurst Tt | Next
| | Frame ?
[Dublin | [oH] [+3018 |
Remit To [PETZONE - Accounts Payable |
|1 Pet Zone Plaza |
[arevmiTy | [oH] [7777 | -
|Far Help, press F1 CAP |MLUM i

4 Modify the data as required.

Note
If the document contains a looping structure (lower-level detail

records such as line items), the input translation object contains a list,
as shown below:

7% Document Editor - ANSI %12 Invoice (810] - Pet Zone
File Edit Group Wiew ‘window Help

=TT = N A T B RRT )

ANSI X12 Invoice (810) - Pet Zone =] 3
Item  Product Gty Frice ||| Open
Line | Store
e iz 1 4532 10 993
2 7E5544 4 2250 New
3 11463 50 16.88 el
Breyv.
MNumber OF Line ltems Next
L] Frame ?
Total Invoice Amount [1033.9
|F0r Help, press F1 MLk i

(Continued on next page)
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Opening and Editing Documents

Step

Action

» To add a new line item, highlight the first entry and click New.
» To access items in the list, highlight the entry to be changed and
click Open (or double-click the item).

System response
The system displays the list item details, as shown below:

Line Items =] 3

Item Ma. Product Code  |4532 Quantity 10 = Qpen
L] _.:I

Store
New:
Description |Large Dog Collar el
Date Shipped |05/11/97 Tranzport Methodl1 vl Carrier CUdElLIF'S Prev
Next

Frame ?

You can now change or enter the data for the item.

Notes
» To move through the entries, use Next and Prev.

» To enter a second or subsequent item, click Next or press
ALT +T.

» After all loop items are entered, click Store to save and exit the
loop dialog box.

» If the document contains codes, press SHIFT + F1 from each
code field to access a list of the codes.

If the document contains calculated fields, select Recalculate from
the File menu before saving the document.

System response
The system updates the totals and checks the document for errors.

When you are finished entering data, select Save from the File menu.

System response

The system saves the information and automatically recalculates and
checks for errors. If errors are found, you are prompted to view the
errors.

From the File menu, select Exit.

System response
The system prompts you to save the document before closing.
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Managing Documents

Viewing Documents

View function

Using the View
function

Viewing a

Document from

the Document
Browsers

The View function enables you to view various types of information, depending
on the format selected in the View Choice Dialog Box. The view types include:

» Raw input data

» External data

» EDI-formatted data
» Translator report

» Data audit

» Tracking information

Notes

» The formatted view option is only active if a Screen Entry translation object is
available in the Partner Relationship record.

» The external data option is only active if the data file used in translation is
available.

» When viewing raw input or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

The View function can be accessed using either of the following methods:

» A document browser is active and a single document is selected.

» The Interchanges or Restored Interchanges browser is active and a single
document within an interchange is selected.

Reference
See Viewing Documents within Interchanges on page 7 - 14 for information about
the Interchanges browser.

To view a document from a document browser, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select one of the document
browsers.

System Response
The system displays the appropriate summary dialog box for that
browser.

(Continued on next page)
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Viewing Documents

Step

Action

Select the type of document for the appropriate partner and click
View.

System Response
The system displays the browser containing those documents.

Select a single document from the appropriate browser.

Click View.

System Response
The system displays the View Choice Dialog Box.

Select an option to display the input data:
» To display raw EDI data, select Gentran Data.

» To display the data file used in translation, select External Data.

Note
This option is not available if the external data file used in

translation does not exist.

» To display the data in the Document Editor using a screen entry
translation object, select Formatted Document.

Note
This option is not available if no screen entry translation object
exists for the document.

» To display a report of the actions the translator took on this
document and list any EDI- or translation object-based
compliance errors, select Translator Report.

Reference
See Error Messages in the Administration Guide for more
information about translator reports.

» To display the document tracking information available for a
single document, select Data Audit.

Note
This function is not available if document level auditing is
disabled.

» To display information that tracks an external data file, select
Track Information.

Click OK to access the view that you specified.
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Viewing a  To view a document from the Interchanges or Restored Interchanges browser,
Document from  complete the following steps:
the Interchange

Browser Step Action
1 From the appropriate area of The Desk, select the Interchanges
browser.
2 Select a single document.

3 Click the Data icon on the Toolbar.

System response

The system displays the raw EDI data view of the Interchange
(displayed in the Data View window on the Interchanges or Restored
Interchanges browser).

Note
When viewing raw input or external data, you can switch from Text
to Hex format by selecting the appropriate command from the View
menu.
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Viewing Currently Processing Documents

Processing
browser

Reset function

Procedure

The Processing Browser displays any document that is currently being processed
in the Gentran:Server system. This browser enables you to ascertain which
documents are currently being processed by you or other users in the
Gentran:Server system.

Note

Any document that is currently being processed in the Gentran:Server system is
displayed in the appropriate browser as unavailable, and you are not permitted to
access that document until processing is complete and the document has been
released to the system.

The Processing Browser enables you to use the Reset function to return to their
previous location any documents that are displayed in the browser but for which
processing has terminated. Typically, you use this function for exception cases
when the processing of a document terminated improperly.

To view the documents that are currently being processed, complete the following
steps:

Step Action

1 From the View menu, select Processing.

System Response
The system displays the Processing Browser.

2 You can view the currently processing documents or perform the
function listed in this table.

Note

You can use the Reset function to return to their previous location
documents that are displayed in the Processing browser but for which
processing has terminated. This is typically done when the
processing of a document terminated improperly.
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Finding Specific Text in a Document

Find function  This function enables you to find specified text in the active data-view window.

Using the Find  The Find function is available when a data-view is the active window. The
function following are the data-view windows.

Audit Log
Document Tracking

Interchange Tracking

Raw Data-View of an Interchange

Raw Data-View of a Document

External Data-View of an Interchange

External Data-View of a Document

Procedure  To find specific text, complete the following steps:

Step

Action

1 Access one of the following data-view windows.

Note

When viewing raw input or external data, you can switch from Text
to Hex format by selecting the appropriate command from the View

menu.

To display this

window... Do the following:

Audit Log Select Audit Log from the View menu.

Document 1. Select a document in a browser.

Tracking 2. Select View from the Commands menu.
3. Click the Tracking information option.
4. Click OK.

Interchange 1. Select an interchange in the Interchanges

Tracking browser.

Select View from the Commands menu.
3. Click the Tracking information option.
4. Click OK.

(Continued on next page)
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Finding Specific Text in a Document

Step Action
1 To display this
(contd) | window... Do the following:
Raw Data View of |1. Select Interchanges from the appropriate
an Interchange area of the The Desk.
2. Select an interchange from the Interchanges
browser.
3. Selecting Interchanges from the View menu.
4. Selecting Data from the Interchanges
cascading menu.
Raw Data View of |1- Select a document in the Interchanges
a Document browser.
2. Select View from the Commands menu.
3. Click OK on the View Choice dialog box.
External Data 1. Select Interchanges from the appropriate
View of an area of the The Desk.
Interchange 2. Select an interchange from the Interchanges
browser.
3. Select Interchanges from the View menu.
4. Select External Data from the Interchanges
cascading menu.
External Data 1. Select a document in the Interchanges
View of a browser.
Document 2. Select View from the Commands menu.
3. Select External Data and click OK on the
View Choice dialog box.
4 From the Edit menu, select Find.
System response
The system displays the Find dialog box.
5 In the Find what box, type the text you want to locate.
6 Do you want the system to search for case-sensitive text?
» Ifyes, select the Match Case check box and continue with step 7.
» Ifno, continue with step 7.
(Continued on next page)
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Step

Action

Click Find Next to find the first occurrence of the specified text.

Notes
» If'the system locates that text, it is highlighted in the data-view
window.

» Ifthe system does not find the specified text, the system beeps. If
this is the case, skip to step 7.

Continue clicking Find Next to find each subsequent occurrence of
that text.

Click Cancel.

System response
The system returns to the data-view window.
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Searching for Documents

Searching for Documents

Introduction  The Document Search facility enables you to quickly and easily locate specific
documents in the system. This facility returns the available tracking information
for each matching document.

Procedure  To search for documents, complete the following steps:

Step

Action

1

From the Commands menu, select Document Search.

System response
The system displays the Document Search Dialog Box.

Enter the appropriate criteria.

Click Search.

System response
The system displays the tracking data for each document it locates
that matches the criteria you specified.

Double-click a document to display the associated tracking
information.
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Sorting Documents

Procedure  To sort documents in any document browser or the Send Queue browser, click the
appropriate column heading to sort by that values in that column.
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Filtering Out Drawer Documents by Status

Introduction = When the Out Drawer Browser is active, you can use the Filter function to filter
the display of documents by status.

Sorting with Qut  To filter the document display in the Out Drawer browser, complete the following
Drawer browser  steps:

Step Action

1 From the appropriate area of The Desk, select the Out Drawer.

System response
The system displays the Out Drawer Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

3 Click Filter.

System response
The system displays the Filter Dialog Box.

4 If you want to filter the display of documents in the Out Drawer by
the document status, you can choose not to display documents with a
certain status by selecting the check box next to each status that you
do not want displayed.

Note
When you clear a check box, the display of that status is turned off.
The default is to display documents regardless of status.

5 Click OK.

System response
The contents of the Out Drawer browser are filtered as specified.
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Deleting Documents

Introduction  The Delete function is used to remove a document or group of documents from
the system.

Notes
» When a document is deleted, all the associated document information,
tracking information, and translation report information is also deleted. When

the last document in an interchange is deleted, the interchange entry is also
deleted.

» Documents in the Send Queue can only be deleted from the Interchanges
Browser.

Procedure To delete a document or group of documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the current location of
the document by selecting the location.

System response
If you select one of the document browsers, the system displays the
appropriate summary dialog box for that browser.

2 If the system displays a summary dialog box, select the type of
document for the appropriate partner and click View.

System response
Access the browser containing those documents.

3 Click Delete.

System response
The system displays a confirmation dialog box.

4 Click Yes.

System response
The document is deleted.
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Printing Documents

Introduction  If no documents are selected, the Print function prints a summary list of all
documents in the browser. For selected documents, the Print function prints one of
the following:

» Raw EDI data

» Formatted version of the documents using the print translation object
established (partner relationship)

» Summary list of those documents

Procedure  To print a document or group of documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the current location of
the document by selecting the location.

System response
If you select one of the document browsers, the system displays the
appropriate summary dialog box for that browser.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the browser containing those documents.

3 Do you want to print a summary list of all documents?

» Ifyes, click Print to access the Print dialog box. Continue with
step 6.

» Ifno, continue with step 4.

4 Do you want to print selected documents (either formatted or not) or
a summary list of selected documents?

» Ifyes, select a document or group of documents and click Print
and continue with step 5.

System response
The system displays the Print Choice Dialog Box.

» Ifno, continue with step 6.

(Continued on next page)
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Step

Action

On the Print Choice Dialog Box, select one of the following options
and click OK:

» To print selected unformatted documents, select the Selected
Items option.

» If you want the selected documents printed as formatted (a print
translation object must exist for the documents to be printed as
formatted), select the Selected Items option and the Formatted
check box.

» Ifyou are printing from the In Documents Browser or ?In
Documents Browser, you can either move the document to the
In Drawer Browser or leave the document in place.

» To print a summary list of selected documents, select the
Summary List of Items option.

System response
The system displays the Print dialog box.

On the Print dialog box, set the appropriate options and click OK.

Note

The system displays the Print dialog box if you either selected no
documents from the browser and clicked Print, or if you chose
Summary List of Items from the Print Choice dialog box.
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Using Documents

Routing Documents

Moving Documents to the In Drawer

Moving Documents to the In Drawer

Introduction  This function moves a selected document or group of documents to the In Drawer
Browser. Documents are automatically moved from the In Documents Browser or
?In Documents Browser to the In Drawer Browser by the system at the
completion of a successful export or print. However, you might want to manually
move a document to the In Drawer Browser so that you could create a turnaround
(response) document.

Procedure  To move a document or group of documents, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select the In Documents
Browser or ?In Documents Browser.

System response
The system displays the appropriate summary dialog box for that
browser.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the browser containing those documents.

Select the documents that you want to move to the In Drawer
Browser and click Move.

System response
The selected documents are moved to the In Drawer Browser.
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Copying a Document (to Reprocess and Resend) Using Documents

Copying a Document (to Reprocess and Resend)

Introduction  The Copy function copies a document (that was already sent successfully) to the
Workspace Browser so you can modify the document and resend it. The Copy
function can only be used when Out Drawer is active.

Note
This function can result in sending duplicate documents to a trading partner.

Reference
After you modify the documents, you may want to resend them. See Resending
Documents on page 5 - 9 for more information.

Procedure To copy a document or group of documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the Out Drawer.

System response
The system displays the Out Drawer Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

3 Select the documents that you want to copy to the Workspace
Browser and click Copy.

System response
The selected documents are copied to the Workspace Browser.
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Using Documents Posting Documents

Posting Documents

Introduction  The Post function moves a selected compliant document or group of compliant
documents to the Out Documents Browser. A document is compliant if it
conforms to the validation rules as defined by the translation object. A document
is designated compliant if the Status column contains OK. If the Status column
contains NotOk, the document is not compliant and is not posted.

Note
The Post function can only be used when the Workspace is active.

Procedure To post a document or group of documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the Workspace.

System response
The system displays the Workspace Browser.

2 Select the compliant documents that you want to move to the Out
Documents Browser.

Note

A document is designated compliant if the Status column contains
OK. If the Status column contains NotOk, the document is not
compliant and is not posted.

3 Click Post.

System response
The selected documents are moved to the Out Documents Browsers.
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UnPosting Documents

Introduction  The UnPost function moves a selected document or group of documents to the
Workspace Browser. You can use UnPost to prevent a document from being sent
to a trading partner or to allow the document to be modified before it is sent. The
UnPost function can only be used when the Out Documents Browser is the active
browser.

Note
If you modify the document, you must repost it before the system sends it.

Procedure  To UnPost a document or group of documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the Out Documents.

System response
The system displays the Out Documents Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

3 Select the documents that you want to move back to the Workspace
Browser and click UnPost.

System response
The selected documents are moved back to the Workspace Browser.
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Responding to Documents

Responding to Documents

Introduction

Turnaround
documents

Modifying
documents

Procedure

The Respond function automatically generates a response document by
transferring data from an inbound source document. The Respond function is only
available when all of the following are true:

» The In Drawer is the currently selected browser.
» One or more documents are selected.

» Turn Around translation objects exist for the selected documents.

The Respond function creates a turnaround document (using the Turn Around
translation object from the Partner relationship — see Selecting an inbound
translation object on page 3 - 62 for instructions) in response to the currently
selected documents. You can create a turnaround document for non-compliant
documents (documents with a NotOK status), as well as for compliant documents.

The documents generated by the turnaround process are placed in the Workspace,
where you can modify them prior to sending.

Note
To modify a document, a Screen Entry translation object must be set up in the
outbound relationship for the created document.

Reference
See Creating an Outbound Relationship on page 3 - 66 for instructions on setting
up an appropriate screen entry translation object.

To respond to one or more documents, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select In Drawer.

System response
The system displays the In Drawer Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the In Drawer Browser.

(Continued on next page)
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Responding to Documents Using Documents

Step Action

3 Select the document or documents for which you want to create a
turnaround (response) document and click Respond.

System response

» The system automatically creates a turnaround document in
response to each document you selected by using the Turn
Around translation object that you specified in the Partner
relationship.

» The turnaround documents that are produced are displayed in the
Workspace for you to modity, if necessary, before posting to the
Out Documents Browser.

Reference
See Posting Documents on page 4 - 53 for instructions.
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Importing Documents

Importing Documents

Introduction

Additional
configuration
task

Procedure

Gentran:Server allows you to import data from data files as an alternative to using
the Document Editor to enter data directly into the system. To import a document,
you must have a system import and/or import translation object for the transaction
set that is imported, registered with the system.

Reference
See Registering New Translation Objects on page 2 - 7 for more information.

For each type of import file, you need to define an import specification on the
Import tab in the System Configuration program that indicates which import or
system import translation object is used to begin translation during the import
process.

You need to see your system administrator about adding the UNC file path or file
name to the System Configuration program if either of the following are true
(because the system may be unable to import the file):

» You select a file from a UNC file path and a local drive is specified for
imports of that file type in the System Configuration program.

» You select a file from a local drive and a UNC filename is specified for
imports of that type in the System Configuration program.

Reference
See How to Edit an Import Specification in the Administration Guide for more
information about adding import specifications.

To import a document, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the Workspace.

System response
The system displays the Workspace Browser.

2 Click Import.

System response
The system displays the Application Files to Import dialog box.

(Continued on next page)
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Importing Documents

Using Documents

Step

Action

Select the file or files to be imported and click Open.

System response
The system imports the documents into the Workspace Browser.

The documents either have an OK status (the documents were
successfully read and compliance checked) or a NotOK status (the
documents failed compliance checking).

Note

You may not send non-compliant documents—either delete those
documents and reprocess them from the data file, or correct the
documents in the Document Editor (if you have Screen Entry
translation objects for them).

Reference
See Opening and Editing Documents on page 4 - 35 for more
information about correcting the documents in the Document Editor.

Important
If you import a file and no documents are displayed in the Workspace
Browser, check the Audit Log.
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Exporting Documents

Introduction  To export a document to a data file, an export translation object for the transaction
set must be:

» Loaded into the system and registered
» Set up as the Export translation object in the inbound relationship record for
the partner

Notes

» After performing an export command, any subsequent exports to the same
export file increases the size of the file by appending the new external data to
this file.

» Ifyou set up the Export to Mailbox command on the Inbound Translation
Objects dialog box, the document is exported to the mailbox you specify.

References
For additional information, see the following:

» Registering New Translation Objects on page 2 - 7
»  Outbound Translation Object Dialog Box on page 3 - 40

» Inbound Translation Object Dialog Box on page 3 - 15 (setting up the Export
to Mailbox function)

Procedure  To export a document, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the In Documents
Browser, ?In Documents Browser, or In Drawer Browser.

System response
The system displays the appropriate summary dialog box for the
selected browser.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the appropriate document browser.

3 Select the document or documents that are to be exported, and click
Export.

System response
The system displays the Select Export Method Dialog Box.

(Continued on next page)
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Exporting Documents

Using Documents

Step

Action

Select one of the following options and click OK:

To convert all selected documents to data and write them to a
single file, select the Export to Single File option.

System response
The system displays the Choose File to Export Document Dialog
Box.

To write selected documents to the files set up in the partner
inbound relationship, select the Export to Default Files option.

To rename selected documents, select the Select File by
Document option.

System response
The system displays the Choose File to Export Document Dialog
Box.
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Overview Using Communications

Overview

In this chapter  This chapter explains how to use communications with Gentran:Server.

Communications  The Communications feature enables you to send and receive data from your
feature trading partners. Gentran:Server uses the Communicator to handle your
communication needs.

Send process  The following describes the system process that occurs when you send an

interchange:
Stage Description
1 The documents in the selected interchange are batched into EDI

envelopes and the required information (including control numbers)
is generated from the information in the partner profile.

2 After the interchange is built, it is listed in the Interchange browser.

Reference
See Viewing Interchanges on page 7 - 10 for more information.

3 Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» Ifthe communication fails because there is no mailbox set up or
the Mailbox service is not started, the interchange and
documents are left in a Ready to send status.

» If communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

4 After a successful communications session, the documents are
moved to the Out Drawer and the interchange status is set to Sent.
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Using Communications Send Queue Browser

Send Queue Browser

Introduction = The Send Queue browser contains a list of documents that are currently queued
for the system to send.

Note
To delete a document that is in the Send Queue, you must open the Interchanges
Browser and delete the document from there.

Diagram  The following illustrates the Send Queue browser:

} Queue - 3 M= 3
Partrer Type  Mame Status  RefDat | Wiew... I

Queusd 993000 .

; ; _F'rlnt...
Queued 222212 -
FETZONEZ INVOIC 2113114 (ueued 955

Refresh

Cloze

3 Documents rrrra 1 zelected el
elp

il

Parts and  The following lists the parts of the Send Queue browser and their functions:
functions

Part Function

View Accesses the View Choice Dialog Box, which allows you
view the selected document.

Print Accesses the Print Choice Dialog Box, which allows you
to print the selected document.

Refresh Refreshes the display of the browser.
Close Closes the browser.
Help Displays Online Help.

Gentran:Server for Windows User’s Guide Gentran:Server for Windows — November 2005 ()



Communications Session Dialog Box Using Communications

Communications Session Dialog Box

Introduction = The Communications Session dialog box enables you to select mailboxes and
initiate a communications session to send and receive data.

Diagram  The following illustrates the Communications Session dialog box:

Communication Session E3

Select the mailbox pou wish to communicate with:
[ IGEMTRAM Application

CIGENTRAN Tutarial
Cancel |

Parts and  The following lists the parts of the Communications Session dialog box and their
functions  functions:

Part Function
Select the Displays the list of Gentran:Server mailboxes.
mailbox you wish
to communicate
with
OK Exits the dialog box; starts a communication session for
the selected mailbox or mailboxes.
Cancel Cancels the function; exits the dialog box.
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Process File Dialog Box

Introduction  The Process File feature allows you to invoke the post-communications process
with any EDI file, as if the file was received via a communications session.
Diagram  The following illustrates the Process File dialog box:
Process File EH
Look i I 3 Tutorial j ﬁl
Pet_eard.tpl Peteiris. stp Pettirz. stp Pettst]. ink
Pet_tinee.map Peteiris. tpl Piettitres.tpl Pettatt2.int
Pet_tir.tpl Peteardp.stp Pettordp.stp Petzone. p.
% Pet_tiree. tut Peteardp. tpl Pettordp.tpl Petzonel |
Pet_tord. map Pettast. int Pettztel.int PetzongZ.|
Pet_tord.tpl Pettest.int Pettste int Petzoned.|
] | i
File name: |F'ettest.int
Files of type: |AII Filez [*.7) j Cancel |
Parts and  The following lists the parts of the Process File dialog box and their functions:
functions
Part Function
Look in Select the folder where the system should look for the file.
Displays the current.
File name Specify the name of the export file.
Files of type Select the type of file.
Open Executes the selected function; exits the dialog box.
Cancel Exits the dialog box.
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Sending Document

Sending Document

Using Communications

Procedure To send a selected document or set of documents, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Out Documents.

System response
The system displays the Out Documents Summary dialog box.

Note

If the documents to be sent are not in the Out Documents Browser,
you must post the documents from the Workspace Browser to the Out
Documents Browser.

Reference
See Posting Documents on page 4 - 53 for more information.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

Select the document or documents that need to be sent.

Note

To select a group of documents click the first document, press
SHIFT, and click the last document. To select several documents that
are not adjacent to each other in the Out Documents list, press CTRL
and click the documents.

Click Send.

System response
The system displays the Gentran:Server for Windows dialog box.

Click Yes to start the transmission session.

6
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Sending All Documents

Sending All Documents

Introduction  You can send all documents in the Out Documents by two different methods:

Select the Transmit icon on The Desk.

Access the Out Drawer browser and click Send.

Procedure:  To send all documents, complete the following steps:

Method 1

Step

Action

1

From the appropriate area of The Desk, select Transmit.

System response
The system displays the Gentran:Server for Windows dialog box.

Click Yes to start the transmission session.

System response
The system displays the Communications Session Dialog Box.

» Select one or more mailboxes for which you want to send data.

» Click OK to start a communication session to send data (click
Cancel if you want to cancel the transmission session).

Note

This action sends all documents currently located in the Out
Documents for which the partner is using one of the selected
mailboxes.

If there are no documents in the Out Documents or interchanges with
a Ready status in the Interchanges browser, a receive-only session is
performed and, as a result, the In Documents and ?In Documents are
updated with any data received.
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Sending All Documents

Using Communications

Procedure:  To send all documents, complete the following steps:

Method 2

Step

Action

1

From the appropriate area of The Desk, select OQut Documents.

System response
The system displays the Out Documents Summary dialog box.

Note
If the documents to be sent are not in the Out Documents, you must
post the documents from the Workspace to the Out Documents.

Reference
See Posting Documents on page 4 - 53 for more information.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

Do not select any documents. If any documents are selected, press
CTRL and click the primary mouse button to deselect them.

Click Send.

System response
The system displays the Gentran:Server for Windows dialog box.

Click Yes to start the transmission session.

Note
All the documents in the Out Documents are sent to the appropriate
mailboxes.

6

Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Communications

Resending Documents

Resending Documents

Introduction  After a document is successfully enveloped and sent, it is stored in the Out
Drawer. If you need to resend the document, you must make a copy of the
document and execute the Send process again using the copy.

Procedure  To resend a document, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Out Drawer.

System response
The system displays the Out Drawer Summary dialog box.

Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

Select the document or documents that need to be resent.

Note

To select a group of documents click the first document, press
SHIFT, and click the last document. To select several documents that
are not adjacent to each other in the Out Drawer list, press CTRL and
click the documents.

Click Copy to make a copy of the document and place the copy in the
Workspace.

From the appropriate area of The Desk, select Workspace.

System response
The system displays the Workspace Browser.

Make any necessary changes to the documents.

Note
You can modify a document only if there is a Screen Entry translation
object for the partner relationship.

Select the documents and click Post.

System response
The documents are posted to the Out Documents Browser.

(Continued on next page)
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Resending Documents Using Communications

Step Action

8 From the appropriate area of The Desk, select Out Documents.

System response
The system displays the Out Documents Summary dialog box.

9 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Documents Browser.

10 Select the documents and click Send.

System response
The system displays the Gentran:Server for Windows dialog box.

11 Click Yes to start the transmission session.
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Receiving Documents

Introduction  Any time a Send session is executed, the system automatically checks your
Mailbox for any information waiting to be received by your system. If any data is
in the Mailbox, it is received without any action from you.

If you need to receive information without first sending anything, you must
initiate a receive-only session using one of two methods:
» From the Commands menu, select the Receive command.

» Access the In Documents browser and click Receive.

Procedure:  To start a receive-only session, complete the following steps:
method 1

Step Action

1 From the Commands menu, select Receive.

System response
The system displays the Communications Session Dialog Box.

2 Click OK to start a communication session to send data.

Note

The system initiates a receive-only session and the In Documents
Browser and ?In Documents Browser are updated with any data
received.

Procedure:  To start a receive-only session, complete the following steps:
method 2

Step Action

1 From the View menu, select In Documents.

System response
The system displays the In Documents Summary dialog box.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the In Documents Browser.

(Continued on next page)
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Receiving Documents Using Communications

Step Action

3 Click Receive.

System response
The system displays the Communications Session Dialog Box.

4 » Select one or more mailboxes for which you want to send data.

» Click OK to start a communication session to send data.

Note

This action initiates a communications session and updates the In
Documents Browser and ?In Documents Browser with any data
received as a result of that session.

Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Communications

Viewing the Send Queue

Viewing the Send Queue

Introduction  The Send Queue browser displays a list of the documents that are currently
queued to be sent and enables you to perform document-based tasks similar to
those available in the main system browsers.

Note

The Send Queue contains documents only if a transmission session failed. The
documents remain in the Send Queue until a successful transmission session
occurs; no user intervention is required.

Procedure  To view the Send Queue, complete the following steps:

Step

Action

1

From the View menu, select Send Queue.

System response
The system displays the Send Queue Browser.

Select a document or documents.

» Click View to view the contents of any of the following:
— Selected document (raw EDI data)
— Formatted document

— Translation report

Reference
See Viewing Documents on page 4 - 38 for more information.

»  Click Print to print the selected documents or summary of the

documents.

Reference
See Printing Documents on page 4 - 49 for more information.
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Processing Data Files

Introduction  The Process File feature invokes the post-communications process with any data
file, as if the file was received via a communications session. This enables you to
process a data file from a disk or anywhere on your system.

Procedure To send a data file to the Communicator, complete the following steps:

Step Action

1 From the Commands menu, select Process File.

System response
The system displays the Process File Dialog Box.

2 Select the desired data file and click Open.

System response
The system immediately invokes the post-communications process
with the file, as if the file was received via a communication session.
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Overview

Overview

In this chapter

External data

External data
viewer

Using External Data

This chapter explains how to use external data with Gentran:Server.

References
See the following for more information:

»  Restoring Archived Data on page 10 - 44

» Interchanges Browser on page 7 - 3

Gentran:Server can track the relationship between an EDI document or
interchange and the corresponding external (application) data. For import
processing, the system makes a persistent copy of the external data at the start of
processing. For inbound (process file and export) processing, the system again
copies the external data file for persistent storage. Gentran:Server also enables
you to archive external data.

You can specify which external data (process file, import, and export) is copied to
the External Data folder in the System Configuration subsystem.

Note

If you do not specify that the system should copy external data for at least one of
the export, import, or process file functions, the option to view external data is not
available.

Reference
For more information, see the following:

» Importing Documents on page 4 - 57

» Exporting Documents on page 4 - 59

» Using Tracking on page 9 - 1

»  Using Archive and Restore on page 10 - 1

» System Configuration—External Data Tab in the Administration Guide

The External Data viewer enables you to do the following:

» View a list of all external data files associated with documents or interchanges
that were sent or received.

» Filter the display of external data.

» View external data, correlated EDI data, and the related translator report (if
they are available).

Note
When viewing EDI or external data, you can switch from Text to Hex format
by selecting the appropriate command from the View menu.
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External Data Summary Viewer

Introduction  The External Data Summary Viewer enables you to view a list of all external data
files associated with documents or interchanges that were sent or received. The
External Data Summary Viewer can always be accessed.

Information  The information displayed in the External Data Summary Viewer is organized in a
organization  hierarchical manner, as shown below:

Level How to access Information displayed
Externaldata | Open External Data » File path and name
file Summary Viewer. » Date and time the file was

(numbered) created

Documentor | Double-click anexternal | »  Document or interchange
Interchange | data file. control number

» Associated partner

» Document type

» Acknowledgement status

» Document name

» Reference data

» Date and time the document was

created

Note

If any of these components are
missing or not appropriate for a
particular group, they are not
displayed.

External Data  You can perform the following functions on the External Data Summary Viewer:

Sumn@ry » Filter the display of external data by date/time and action from the External
functions Data Filter dialog box.

» Display the external data, raw-EDI data, and translator report data for the
selected external data file in the appropriate browser panes.

» Print a selected item.

» Delete the external data file from the External Data folder.
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External Data Summary Viewer Using External Data

Diagram  The following illustrates the External Data Summary Viewer with external data,
EDI data, and translator report options turned on:
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Parts and  The following lists the parts of the External Data Summary Viewer and their
functions  functions:

Part Function
Status bar Displays the filer specifications from the External Data
Filter Dialog Box.
left pane— Displays a list of all external data files and (if available) an
external tree associated EDI document or interchange that was sent or
received.
Reference

See the following for more information:

» Information organization on page 6 - 3

» Iconsonpage6-5

upper right Displays the data file used in translation (if this option is
pane—External selected from the View\External Data menu).

Data (Continued on next page)
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External Data Summary Viewer

Part

Function

middle right
pane—Gentran
Data

Displays the associated document in EDI format (if this
option is selected from the View\External Data menu).

Note
This option is not available if the document used in
translation does not exist.

(lower right
pane—Export
Document
Summary
Translator Report

Displays a report of the external actions the translator took
on this document and lists any EDI- or translation object-
based compliance errors (if this option is selected from the
View\External Data menu).

Reference
See Error Messages in the Administration Guide for more
information.

Icons  The following lists the icons that the system uses on the External Data Summary

Viewer:
Icon Description
) Indicates a process file or mailbox process file system activity.
ED Indicates a send system activity.

Indicates an import or mailbox import system activity.

Indicates an export system activity.

o Indicates an interchange related to the external data file.
B Indicates a document related to the external data file.
Note

If this icon is red, it indicates that the document contains errors.
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Using External Data

External Data Filter Dialog Box

Introduction  The External Data Filter dialog box allows you to filter the display of external
data files by date and system action (process file, mailbox process file, import,
mailbox import, send, and export).

To access  When the External Data Browser is active, select Filter from the Commands
menu. Or, from the Options menu, select Preferences and click on the External

Data Filter tab.

Diagram  The following illustrates the External Data Filter dialog box:

External Data Filter

External Data Filter |

—Action

—Date

—From

I 51142004 VI
an- =]
I 8:00:00 A0 =

— 1o

I 942342005 VI
Ea =7
I 1EBZEPM =

v Always Current

[ END Date/Time Checking: Unselect All Actions |

0K | Cancel | Help |

Parts and  The following lists the parts of the External Data Filter dialog box and their

functions functions:

Part

Function

Date From

Select the beginning date and time of a date/time range,
from which the system filters the display of external data
files.

Note
The Date From box is only active if the No Date/Time
Checking check box is not selected.

(Continued on next page)
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External Data Filter Dialog Box

Part

Function

Date To

Select the end date and time of a date/time range, to which
the system filters the display of external data files.

Note

The Date To box is not active if either the No Date/Time
Checking check box is selected or the Always Current
check box is selected.

Always Current

Indicate that the end date for the date range is always the
current system date and time.

Note
The Always Current check box is only active if the No
Date/Time Checking check box is not selected.

No Date/Time
Checking

Indicate if the system filters the display of external data
files by date and time (if selected).

Action

Contains a list of all the actions the system can perform
using external data files. This list allows you to filter the
display of external data files by the actions you specify.

Note
The default display is all actions, but you can clear them.

Unselect All
Actions

Clears all the actions.

Note
This allows you to filter the display of external data files
by the actions you specify.

Warning
At least one action must be selected.

OK

Exits the dialog box; saves the selections.

Cancel

Exits the dialog box without saving selections.

Help

Opens the online help.

Gentran:Server for Windows User’s Guide
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Viewing External Data Files

Procedure

Using External Data

To view external data files, complete the following steps:

Step

Action

1

From the View menu, select External Data\Browser.

System response

The system displays the External Data Summary Viewer.

Do you want to filter the display of external data files by action or

date?

» Ifyes, see Filtering External Data Files on page 6 - 9.

» If no, continue with step 3.

Select an external data file.

Use the following table to determine your next step:

To view the external data
for a single selected file,

Select View > External Data > Related
External Data.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

To view the related EDI
data,

Select View > External Data > Gentran
Data.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

To view the translator
report for actions taken on
the external data file,

Select View > External Data >
Translator Report.

To delete the external data
file from the External
Data folder,

1. Select the appropriate file in the left

2. Select View > Delete.

pane of the viewer.

To print the external data
file, EDI data, or
translator report,

2. Select File > Print.

Select the appropriate right pane of
the viewer.

6
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Filtering External Data Files

Introduction = When the External Data Summary viewer is active, the Filter function enables you
to filter the display of external data files by date and action.

Procedure  To sort external data files by date and/or action, complete the following steps:

Step Action

1 From the View menu, select External Data\Browser.

System response
The system displays the External Data Summary Viewer.

2 From the Commands menu, select Filter.

System response
The system displays the External Data Filter Dialog Box.

3 Do you want the system to filter the display of external data files by
date and time?

» Ifyes, clear the No Date/Time Checking check box and proceed

with step 4.
» Ifno, select the No Date/Time Checking check box and proceed
with step 6.
4 Use the Date From slide bar to select the beginning date of a date

range, from which the system filters the display of external data files.

5 Do you want the end date for the date range to always be the current
system date and time?

» Ifyes, select the Always Current check box.

» Ifno, clear the Always Current check box and move the Date to
slide bar to the date and time you want to use.

(Continued on next page)
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Step Action

6 Do you want to filter the display of external data files by action?

» Ifyes, from the Action list, select the actions that you want
displayed.

Note

The default display is all actions, but you can click actions to
clear them and change the display. Alternately, you can click
Unselect All Actions to clear all actions, so you can then click
the one or more actions to select them. At least one action must
be selected.

» Ifno, continue with step 7.

7 Click OK.

System response
The system filters the display of the external data files using the
criteria you specified.
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Overview

Using Interchanges

In this chapter  This chapter explains how to use interchanges with Gentran:Server.

Reference
See Restoring Archived Data on page 10 - 44 for more information about the
Restored Interchanges browser.

Interchanges  The Interchanges browser enables you to do any of the following:

browser

View a hierarchical list of all the interchanges, group, and documents that
were sent or received.

View status information for the interchanges (such as whether or not a
functional acknowledgement was received and the status of that
acknowledgement).

Filter the display of interchanges.

Access the documents within the interchanges.

View external data, EDI data, and the related translator report (if they are
available).

Note
When viewing EDI data, you can switch from Text to Hex format by selecting
the appropriate command from the View menu.

6
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Using Interchanges Interchanges Browser

Interchanges Browser

Introduction  The Interchanges browser enables you to view a list of all the interchanges,
groups, and documents that were sent or received. The Interchanges browser can
always be accessed. This browser contains status information about the
interchanges (such as whether or not a functional acknowledgement was received
and the status of that acknowledgement).

Information  The information about the Interchanges browser is organized in a hierarchical
organization = manner. The following table describes the hierarchical organization of the
information about the Interchanges browser:

Information displayed

Level How to access (in middle pane
Interchange | Open Interchanges » Direction of the interchange
browser.

» Date and time the interchange
was created

» Partner name

» Control number

» Interchange process status
» Network status

» Interchange acknowledgement
status

» Message status

Note

If any of these components are
missing or not appropriate for a
particular interchange, they are not

displayed.
Group Double-click an » Group control number
interchange. »  Group type

» Group acknowledgement status

Note

If any of these components are
missing or not appropriate for a
particular group, they are not
displayed.

(Continued on next page)
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Using Interchanges

Information displayed

Level How to access (in middle pane
Document Double-click a group. » Document compliant status
» Document control number
» Document type
» Document name
» Reference data
» Document compliant status
» Transaction acknowledgement
status
Note
If any of these components are
missing or not appropriate for a
particular document, they are not
displayed.
document Double-click a Document data
data document.

Note

A screen entry translation object for
that document must available on
your system.

Browser  You can perform the following functions on the Interchanges browser:

functions

Filter the display of interchanges by date, partner, and direction (inbound and
outbound) from the Interchanges Filter dialog box.

Display the external data, raw-EDI data, and translator report data for the
selected interchange or document in the appropriate browser panes.

Note

When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

Toggle the status of interchanges between Ready to Send and Hold.

Manually change the status of groups to Acknowledged.

Print or delete a selected item.

Note
You might want to use the toggle function if you do not want to send an
interchange right away.

( Gentran:Server for Windows — November 2005
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Diagram  The following illustrates the Interchanges browser with external data, EDI data,
and translator report options turned on:

& Interchanges Summary - 2 [ [O]*]
B = [8IPatners  |Date/Time Checkingis0ft.
=57 Root Cantrol Humber | Type | Doz, Mame | Refers [IDEPETTEST X003030510 P -
EHE 05/10/2002 03:32 AL @ oo 10 FEEREERE55 sooas [BEGIE1111111000000555555555535

555555555555950515 15 15 30x0

-

&-£37 1-PETZOME
| ..[8 0001-PETZ | 5
= 05411 /2002 12:20 P

B3 4-PETZOME

BIG*QSDEl0*5555555555*950512*2;|

! @ onod-PETE FEF*EM*555555555555~ _ILI
- 7
[« | 3
Document SUumnary -
Trading Partrner: FETZONE
_ L ijm I 5| o

Parts and  The following lists the parts of the Interchanges browser and their functions.

functions
Part Function
Status bar Reflects the filer specifications from the Interchange Filter
Dialog Box.
Note

The Electronic Commerce Manager status bar is updated
when you select a single item from the middle pane.

left pane— Displays a list of all the interchanges, groups, and
Interchanges tree | documents that were sent or received. Also displays the
time created and partner name.

Note
To refresh the display of the Interchanges browser,
press F5.

Reference
See the following for more information:

» Information organization on page 7 - 3

» Document level status icons on page 7 - 7

(Continued on next page)
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Using Interchanges

Part

Function

middle pane—

Displays a detailed list of the selected interchange, group,

detailed list or document. The information displayed depends on the
level.

Notes

» To select multiple items, press and hold the CTRL key
while selecting the items.

» To refresh the display of the Interchanges browser,
right-click the middle pane and select Refresh from the
shortcut menu (or press F5).

upper right Displays the data file used in translation (if this option is

pane—External
Data

selected from the View\Interchanges menu).

Notes

» This option is only available if a single item is selected
from the detailed list.

» This option is not available if the external data file
used in translation does not exist.

» When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

middle right
pane—Gentran
Data

Displays the data in EDI format (if this option is selected
from the View\Interchanges menu).

Notes

» This option is only available if a single item is selected
from the detailed list.

» When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

lower right
pane—Translator
Report

Displays a report of the actions the translator took on this
document and lists any EDI- or translation object-based
compliance errors (if this option is selected from the
View\Interchanges menu).

Note
This option is only available if a single item is selected
from the detailed list.

Reference
See Error Messages in the Administration Guide for more
information.
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Interchanges Browser

Document level  The following lists the status icons that the system may use at the document level
status icons  on the Interchanges browser:

Status

Icon

Description

OK

[

(green) — Indicates that the documents are fully
compliant with the EDI standard and are eligible for
further processing.

NotOK

(red) — Indicates one of the following:

The document failed to comply with the EDI
standard. If this is the cause of the error, the errors
will be indicated on a translator report associated
with the document. Despite the fact that the
document is not fully compliant, it is eligible for
further processing.

The received document could not be associated with
a specific trading partner. If this is the case, the
partner for the document is listed as Unknown. To
associate this document, and the other documents
received in the interchange with a partner, attach the
documents from the Interchange browser.

A suitable trading relationship or translation object
could not be associated with the document. Detailed
information concerning what information was used
to locate the relationship and/or the translation object
will be listed in the audit log. To correct this
problem, a valid relationship must be established
using the Partner Editor and a valid export, print, or
turn-around translation object must be defined for
that relationship.

A major error occurred while processing the
interchange, functional group, or transaction level
enveloping structures. This error may include header
and trailer control numbers that do not match, an
invalid trailer control count, or a control number
sequence checking error. If any of these errors occur,
they will be listed on the translator report for the
interchange containing the document.

Duplicate

(yellow) — Indicates the document has the same name as
another document on the system.

Gentran:Server for Windows User’s Guide
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Interchange Filter Dialog Box

Introduction  The Interchange Filter dialog box allows you to filter the display of interchanges
by date, partner, and direction (inbound and outbound).

Note

You can set global Interchange Filter preferences in the Gentran:Server
Preferences dialog box on Interchange Filter tab. Access the Preferences dialog
box by selecting Preferences from the Options menu.

Diagram  The following illustrates the Interchange Filter dialog box:

Interchange Filter E3
—Diate — Partner
Eram PETZOME
07 February 97 15:00
o | i
e
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Kl 12
] ey i Unzelect &l Partners
— Direction
[ Mo DatedTime Checking W IrBound 1

v OutBound =

Cancel |

Parts and  The following lists the parts of the Interchange Filter dialog box and their
functions  functions:

Part Function

Date From Select the beginning date of a date range, from which the
system should filter the display of interchanges.

Note
The Date From box is only active if the No Date/Time
Checking check box is not selected.

(Continued on next page)
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Interchange Filter Dialog Box

Part

Function

Date To

Select the end date of a date range, from which the system
should filter the display of interchanges.

Note

The Date To box is not active if either the No Date/Time
Checking check box is selected or if the Always Current
check box is selected.

Always Current

Indicate that the end date for the date range is always the
current system date and time.

Note
The Always Current check box is only active if the No
Date/Time Checking check box is not selected.

No Date/Time
Checking

Indicate if the system filters the display of interchanges by
date and time (if selected).

Partner

Contains a list of all partner profiles on your system. This
list allows you to filter the display of interchanges by the
partners you specify.

Note
The default display is all partners, but you can click on
partner profiles to clear them.

Unselect All
Partners

Clears all partner profiles.

Note
This allows you to filter the display of interchange by the
partners you specify.

Warning
At least one partner must be selected.

InBound
Outbound

Select the direction of traffic (inbound and outbound) for
the system to filter the display of interchanges.

Note
The default display is both inbound and outbound
interchanges.

Warning
At least one of the Inbound/Outbound check boxes must be
selected.

OK

Exits the dialog box; saves the selections.

Cancel

Exits the dialog box without saving selections.

Gentran:Server for Windows User’s Guide
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Using Interchanges

Viewing Interchanges

Procedure  To view interchanges, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Note
To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press F5).

Do you want to filter the display of interchanges by status?

» Ifyes, see Filtering the Display of Interchanges on page 7 - 12.
» Ifno, continue with step 3.

Note

The Filter function enables you to filter the display of interchanges by
date, partner, and direction (inbound and outbound).

Select an interchange.

Use the following table to determine your next step:

To view the related Select View > Interchanges > Related
external data for a single | External Data.

selected interchange,
Note

When viewing raw-EDI or External
Data, you can switch from Text to Hex
format by selecting the appropriate
command from the View menu.

To view the content of a Select View > Interchanges > Gentran
single selected Data.
interchange in raw EDI

data format, Note

When viewing raw-EDI or External
Data, you can switch from Text to Hex
format by selecting the appropriate
command from the View menu.

(Continued on next page)
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Viewing Interchanges

Step

Action

(contd)

To view the translator
report for a single selected
interchange,

Select View > Interchanges >
Translator Report.

To print a selected
interchange or a summary
of interchanges,

Print from the File menu.

To delete a selected
interchange and all
associated documents,

Select Document > Delete.

Notes

If you delete an interchange with a
status of Queued, you receive a
warning that you must remove
specified messages from Out
Documents and from your trading
partner’s inbox. If you proceed, you
are warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

If you delete an interchange with a
status of Ready to send, you are
warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

If an interchange contains a
document that is waiting for
acknowledgement processing
(acknowledgement generation or
reconciliation), you cannot delete it
until this processing is complete.

To attach an interchange
to a partner,

Select Document > Attach.

Gentran:Server for Windows User’s Guide
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Filtering the Display of Interchanges

Introduction = When the Interchanges browser is active, the Filter function enables you to filter
the display of interchanges by date, partner, and direction (inbound and

outbound).

Procedure  To filter interchanges by partner and/or date, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

From the Commands menu, select Filter.

System response
The system displays the Interchange Filter Dialog Box.

Do you want the system to filter the display of interchanges by date
and time?

» Ifyes, clear the No Date/Time Checking check box and proceed
with step 4.

» Ifno, select the No Date/Time Checking check box and proceed
with step 6.

Use the Date From slide bar to select the beginning date of the date
range, from which the system will filter the display of interchanges.

Do you want the end date for the date range to always be the current
system date and time?

» Ifyes, select the Always Current check box.

» Ifno, clear the Always Current check box and move the Date to
slide bar to the date and time you want to use.

(Continued on next page)
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Filtering the Display of Interchanges

Step

Action

Do you want to filter the display of interchanges by partner?

» Ifyes, select the partners that you want displayed from the
Partner list (lists all partner profiles on your system).

Note
The default display is all partners, but you can click partner
profiles to clear them and change the display. Alternately, you

can click Unselect All Partners to deselect all partner profiles.

You can then click one or more profiles to select them. At least
one partner must be selected.

» Ifno, continue with step 7.

Which direction do you want to filter the interchange?

Default
The default display is both inbound and outbound interchanges.
Clear the Inbound or Outbound check box to clear the direction.

Note
At least one of the Direction check boxes must be selected.

Click OK.

System response
The system filters the interchange display based on the criteria you
selected.
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Viewing Documents within Interchanges

Introduction  You can view the individual documents in an interchange as long as a screen entry
translation object for each document is available on your system.

Procedure  Use this procedure to view the documents within an interchange.

Step Action

1 From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Notes

» The Interchanges browser displays all interchanges, group, and
documents that were sent or received.

» Torefresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select a document and proceed with the next step or double-click a
document to view it.

Note
You must have a screen entry translation object for this document
available on your system.

(Continued on next page)
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Viewing Documents within Interchanges

Step

Action

With a document selected, use the following table to determine your

next step:

To view a translator report of
the actions the translator took
on this document,

Select View > Interchanges >
Translator Report.

To view the content of a
single selected interchange in
raw EDI data format,

Select View > Interchanges >
Gentran Data.

Note

When viewing raw-EDI or External
Data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

To view the related external
data of a single selected
interchange,

Select View > Interchanges >
Related External Data.

Note

When viewing raw-EDI or External
Data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

To print a selected document
or translation report,

Select File > Print.

To delete a selected
document,

Select Document > Delete.

To copy the document to the
appropriate browser,

—_—

Select Document > Copy.

2. Select the appropriate browser
from the submenu.
(?In Documents or In Documents
Browser for compliant Inbound
documents; Workspace Browser
for outbound documents)

Gentran:Server for Windows User’s Guide
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Attaching Interchanges to a Partner

Introduction  The Attach to Partner dialog box can be accessed when the Interchanges browser
is active and one interchange is selected. The Attach function enables you to link
the interchanges to a partner. Use this function if you received documents that did
not have an identifiable partner and are now listed without a partner in the ?In
Documents browser.

Note

The interchanges for these documents are listed without a partner in the
Interchanges browser.

Procedure  Use this procedure to attach an interchange to a partner.

Step

Action

1

From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Select one interchange.

Does the partner already exist?
» Ifyes, continue with step 4.
» If no, you must create the partner before you can continue.

Reference
See Creating a Partner Definition on page 3 - 56 for instructions.

From the Document menu, select Attach.

System response
The system displays the Select Partner dialog box.

Select the desired partner from the list and click OK.

System response
The system links the selected interchange to this partner and returns
to the Interchanges browser.

Does the partner to which you are attaching the interchange have
more than one interchange definition?

» Ifyes, you are prompted with an additional dialog box. Continue
with the next step.

» If no, continue with Step 8.

(Continued on next page)
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Attaching Interchanges to a Partner

Step

Action

Use the following table to determine what to select on the dialog box:

If your partner has more L. Selec.t jche appropriate interchange
than one interchange definition.
definition, 2. Click OK.
If your partner has more Select the appropriate group
than one group definition, definition.
2. click OK.
If your partner has more Selec.t Fhe appropriate relationship
than one relationship definition.
defined for a document type |2 (Click OK.
in the interchange,

After you attach the interchange to a partner, open ?In Documents by
selecting it from the appropriate area of The Desk.

Note

You can then export, print, or move the documents to the In Drawer

Browser.
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Resending Interchanges

Introduction

Resending
interchanges
automatically

There are two ways to resend interchanges:

» To automatically resend all outbound interchanges, you can set the Send
Options preference.

» To resend specific outbound interchanges, you can use the Resend command
from the Interchanges browser.

Note
You can only resend interchanges that were previously sent or that have a status of
Ready to send.

You can set an option for the system to automatically check for interchanges that
are stuck in the Send Queue. The interval for checking the Send Queue is set by
default to 30 minutes in the Registry. However, you can change this value in the
UPIDValidationInterval key.

During the first system check, the Gentran Executive Service checks for
interchanges that are possibly stuck and places those interchanges into a queue.
During the next system check, the Executive Service checks if those interchanges
are still in the queue. Any that are still in the queue at the second system check are
flagged to be sent during the next communications session.

To automatically resend outbound interchanges, complete the following steps:

Step Action

1 From the Options menu, select Preferences.

System response
The system displays the Preferences dialog box.

2 Click the Send Options tab.

3 Click the box for Check for interchanges that did not send.

4 Click OK.

5 Optional
Change the System Check Interval in the registry. (Default is 30
minutes.)

6 Restart services.
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Resending a
specific
interchange

Resend process

Resending Interchanges

To resend a specific outbound interchange, complete the following steps:

Step Action
1 From the appropriate area of The Desk, select Interchanges.
System response
The system displays the Interchanges Browser.
2 Select the outbound interchange that needs to be resent.
3 From the Document menu, select Resend.
System response
The system displays the Gentran:Server for Windows dialog box.
4 Click Yes to start the transmission session.

The following describes the system process that occurs when you resend an
interchange:

Stage

Description

1

When the resend command is executed, the system first determines if
it is a TRADACOMS interchange. If the interchange is
TRADACOMS, the system increments the current version number in
the FIL segment by one. After this update, the interchange is resent in
the same manner as all other interchanges.

Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» If communication fails because there is no mailbox set up or the
Mailbox service is not started, the interchange and documents are
left in a Ready to send status.

» If communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

The documents are moved to the Out Drawer Browser and the
interchange status is set to Sent.

Gentran:Server for Windows User’s Guide
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Manually Acknowledging an Interchange, Group, or

Document

Introduction = The Acknowledge function does not generate an acknowledgement; it merely
changes the status of the outbound document.The status of an interchange, group,
or document in the Interchanges browser may need to be manually set to
acknowledged for many reasons.

Example

You contact a partner about an overdue document and the partner verifies that it
was received but they did not send an acknowledgement.

Procedure  To manually change the status of an interchange, group, or document to
acknowledged, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Interchanges.

System response
The system displays the Interchanges Browser.

Select an unacknowledged interchange, group, or document that
needs to be set to acknowledged.

Note
Unacknowledged documents are marked with one of the following
statuses.

» Overdue

» Waiting

» Sent

» OnNet

» PickedUp
» NetErr

» NetWarn

From the Document menu, select Ack.

System response
The system sets the status of the document to acknowledged.
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Overview

Overview

Acknowledgement

Using Acknowledgements

In this chapter  This chapter explains how to use Gentran:Server acknowledgements, including
the following topics:

Defining acknowledgement criteria (inbound)
Defining acknowledgement criteria (outbound)
Manually acknowledging a document, group, or interchange

Checking for overdue acknowledgements

Acknowledgements are sent to a trading partner to inform them that you received

a transmission they sent and to inform them of any errors. You must define the
level of acknowledgements that you expect from your trading partners and you are
sending to your trading partners upon receipt of a transmission.

6
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Defining Inbound Acknowledgement Criteria

Introduction  The criteria that the system uses to acknowledge inbound documents, functional
groups, and interchanges is defined at the partner level on the Partner Editor
Inbound Relationship dialog boxes. The translation objects used by the system to
generate functional acknowledgements are included as system translation objects
and are registered automatically when you install Gentran:Server.

Note

If you generate functional acknowledgements as a result of receiving documents
for an inbound relationship, you must set up the corresponding outbound
relationship to generate the acknowledgements your partner requests.

Reference
See Creating an Outbound Relationship on page 3 - 66 for information about how
to establish an outbound relationship to generate acknowledgements.
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Procedure  To define criteria to generate acknowledgements, complete the following steps:

Step Action

1 Document acknowledgement criteria is defined when you set up the
partner relationship using the Advanced options on the Inbound
Relationship Dialog Box, which are illustrated below.

Seguence Checking Last sed Contral Mumber | Generate Acknowledgments
& Mone Joood & o
" Duplicate
" Incremental
" Chronglogical | [~ Skip Compliance Check

[ Duplicate Documents ™ ez - Mo Emor Detail
= Yes - With Eror Detail

Acknowledgement Processing

Test Indicatar: 7 Test & Production " Deferned & Immediate

Note

If you select Immediate acknowledgement processing,
acknowledgement reconciliation occurs during the inbound break
session. If you select Deferred acknowledgement processing (the
default), reconciliation occurs at its scheduled interval.

References

» See System Configuration—System Tab in the Administration
Guide for more information about setting the intervals for
deferred acknowledgement processing.

» See Creating an Inbound Relationship on page 3 - 58 for more
information about setting parameters on the Inbound
Relationship dialog box.

(Continued on next page)

( Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Acknowledgements

Defining Inbound Acknowledgement Criteria

Step

Action

Functional Group acknowledgement criteria is defined when you set
up the Inbound Group Entry using the Advanced options on the
Inbound Group Entry Dialog Box, as illustrated below.

Seguence Checking Last Used|Eroup Eomtraldumber ¥ hcknowledgs Group
&+ Mone o

" Duplicate &ck Transaction Set [D:

7 Incramental I j'

" Chronaological

Group Tranzl. Obj I j
=

Acknowledge Tranzl. Obij: IAEKBUILD_EDNTHL

Reference
See Selecting an inbound functional group for more information
about setting parameters on the Inbound Group Entry dialog box.

Interchange acknowledgement criteria is defined when you set up the
Inbound Interchange Entry using the Advanced options on the
Inbound Interchange Entry Dialog Box, as illustrated below.

Seguence Checking  Last Used Contral Humber

™ Acknowledge Interchange
& None [oo0o0000D ece ?

" Duplicate Ackiransachon Seb

" Incremental I vI

" Chronological

Interchanage Transl Ohbj. I

[
[]

Acknowledge Transl. Obj. I

Reference

See Selecting an inbound interchange on page 3 - 64 for more
information about setting parameters on the Inbound Interchange
Entry dialog box.
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Defining Outbound Acknowledgement Criteria

Introduction

Reconciling documents and their acknowledgements is a function that the system
automatically performs for you. The translation objects that are necessary to
process the acknowledgements you receive are included as system translation
objects and are registered when you install Gentran:Server.

However, you must establish the level of acknowledgements that you expect by
completing the Partner Editor Outbound Relationship dialog boxes.

Note

If you are receiving functional acknowledgements as a result of sending
documents for an outbound relationship, you must set up the corresponding
inbound relationship to receive the acknowledgements you expect to receive.

Reference
See Creating an Inbound Relationship on page 3 - 58 for information about how
to establish an inbound relationship to receive acknowledgements.

6
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Procedure

Defining Outbound Acknowledgement Criteria

To set up the level of acknowledgements that you expect to receive from your

partners, complete the following steps:

Step

Action

1

The requirement for receiving interchange acknowledgements is set
in the Advanced section of the Outbound Interchange Entry Dialog
Box, as illustrated below.

¥ Use the default Mailbox and E-mail Sddress
| GENTREN Application x|

=8t =il e |

bzl
E-mail Address I Bt arlmy |
Cantent Type:  |Application/ED

™ Set Max Mumber of Documents per Interchange

—

™ Expect Acknowledgement

HEnms [ erme: ID

i & W umbern ek eciumerts pernterchange;

Laszt Uged Control Mumber:

IDDDDDDDDD

Interchange Transl. OBl {154 Build Template - ANS| =]
Acknowledge Tranzl. Obj. I j
Reference

See Selecting an outbound interchange on page 3 - 73 for more
information about setting parameters on the Outbound Interchange

Entry dialog box.

Recommendation
Do not change the translation objects in the Interchange Transl. Ob;.

and Acknowledge Transl. Obj. lists, unless you are certain of the
result.

(Continued on next page)
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Step Action

2 The requirement for receiving functional group acknowledgements is
set in the Advanced section of the Outbound Group Entry Dialog
Box, as illustrated below.

Laszt Uged Group Contral Humber: [ Expect Acknowledgement
0 1 otirs [ Erd e ID

Tranzaction Contral Mumbers

|

™ Sequence From Group Eafmiat
) hliarmal
[Last [ sed ot Himber: B/
||:| B
5/
Group Trangl, Obj; IGS Build Template - AMSI

Ll [

Acknovledge Tranzl Obj; I

Recommendation
Do not change the translation objects in the Group Transl. Obj. and
Acknowledge Transl. Ob;. lists, unless you are certain of the result.

Note

If the acknowledgement is overdue (it is not received within the
number of hours designated in the Hours Overdue box), it is
indicated with a status of Overdue on the Interchanges Browser.

Reference

» See Selecting an outbound functional group on page 3 - 71 for
more information about setting parameters on the Outbound
Group Entry dialog box.

» See Viewing Documents within Interchanges on page 7 - 14 for
instructions on how to access the Interchanges browser.

(Continued on next page)
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Defining Outbound Acknowledgement Criteria

Step

Action

The requirement for receiving transaction set acknowledgements is
set in the Advanced section of the Outbound Relationship Dialog
Box, as illustrated below.

Last Uzed Contral Humber: IDDDD

T Eupect dckrowledgement | T Duplicate Documents
Hmnrs [ ierdie; ID Test Indicator: | & Test & Production
Reference

See Finalizing the outbound relationship on page 3 - 75 for more
information about setting parameters on the Outbound Relationship
dialog box.
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Manually Acknowledging Documents

Introduction  The Acknowledge function does not generate an acknowledgement; it merely
changes the status of the outbound document.The status of a document in the Out
Drawer browser may need to be manually set to Acknowledged for many reasons.

Example
You have contacted a partner about an overdue document, and that partner
verified that it was received but they are not sending you an acknowledgement.

Reference
See Manually Acknowledging an Interchange, Group, or Document on
page 7 - 20 for more information.

Procedure  To manually change the status of a document to Acknowledged, complete the
following steps:

Step Action

1 From the appropriate area of The Desk, select Out Drawer.

System response
The Out Drawer Summary dialog box is displayed.

2 Select the type of document for the appropriate partner and click
View.

System response
The system displays the Out Drawer Browser.

3 Select an Unacknowledged document that needs to be set to “Ack’d”
(acknowledged).
Note
Unacknowledged documents are marked with one of these states.
» Overdue
» Waiting
» Sent
» OnNet
» PickedUp
» NetErmr
» NetWarn
4 Click Ack.

System response
The system sets the status of the document to “Ack’d.”
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Special Considerations for EDIFACT Acknowledgements

Introduction = When creating an outbound EDIFACT Control document, the default system
behavior is to extract the Sender ID and Receiver ID from the Internal System
User partner. According to the EDIFACT standard, the Sender ID and Receiver ID
in the UCI and UCF record of the Control document should contain the values
from the Inbound UNB and UNG segment, respectively.

The Gentran:Server product CD (in the Maps\Special directory) contains the
translation object CntrlBld_DLL.tpl. This map enables you to obtain the Sender
ID and Receiver ID from the inbound data file via a user exit that accesses the
GentranAutomation.DLL. The GentranAutomation.DLL is automatically
registered when you install or upgrade the product. This DLL is currently only
used by the CntrlBld DLL map.

Note
You can either use either functionality. The default translation object selected for
the Outbound Control Build relationship is the ACKBUILD CONTRL.

Procedure  To use the CntrlBld DLL.tpl functionality to obtain the Sender ID and Receiver
ID, complete the following steps:

Step Action

1 From the Tools menu, select Partner Editor.

System Response
The system displays the Partner Editor Dialog Box.

2 Select the Outbound Control Build relationship from the Select a
Partner list and click Outbound.

System response
The system displays the Outbound Relationship Dialog Box for that
partner.

3 On the Outbound Relationship dialog box, click Translation.

System response
The system displays the Outbound Translation Object Dialog Box.

4 From the Import list, select ACKBUILD CONTRL_DLL.

Note
The default translation object selected for the Outbound Control
Build relationship is the ACKBUILD CONTRL.

5 Click Save to save your selections and return to the Outbound
Relationship dialog box.
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Checking for Overdue Acknowledgements

Introduction  You can manually check for overdue acknowledgements by using the Overdue
Check feature.

Note

You can specify the frequency at which the system will check for overdue
acknowledgements (in whole minutes) in the System Configuration program. This
allows you to disable or reduce the frequency of overdue acknowledgement
checking.

Reference
See How to Change the Frequency of Overdue Acknowledgement Checking in
the Administration Guide for more information.

Procedure  To check for overdue acknowledgements, complete the following steps:

Step Action

1 From the Commands menu, select Overdue Check.

System response

The system checks if any interchange, group, or document that
requires an acknowledgement is overdue (the system has not received
an acknowledgement for it and the specified time to do so has
expired). For any overdue interchange, group, or document, the
system sets the status to Overdue on the Interchanges Browser.

Reference
See Viewing Interchanges on page 7 - 10 for more information about
using the Interchanges browser.

( Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Contents

Gentran:Server for Windows User’s Guide

CHAPTER

9
Using Tracking

OVEIVIBW . . ottt e e e 9-2
Tracking Inbound Information ........................... 9-3
Tracking Outbound Information . . ........................ 9-6
Viewing and Printing Data Audit Information ............... 9-9
Viewing and Printing Tracking Information................ 9-10

Gentran:Server for Windows — November 2005 ()



Overview Using Tracking

Overview

In this chapter  This chapter describes how to use the Gentran:Server tracking systems.

Tracking feature  The system writes a Document Tracking record for every significant event that
occurs for a document. For example, a Document Tracking record is written when
the document is created, when it is modified, and when it is exported.
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Tracking Inbound Information

Tracking Inbound Information

Introduction

Process file
process

For inbound processing, the system may receive an inbound transmission file
(such as external data) through the Process File command within Gentran:Server
or through a Mailbox message (when the ContentType is configured to
Application/EDI). After the file is received by the system, you may either export
the file or configure the system to export it automatically.

When data arrives directly into the system through a Process File command,
Commpost performs the following actions to save the information pertaining to
this file:

Stage Description

1 If System Configuration is configured to copy process file data,
Commpost copies the file to the External Data directory.

2 Commpost updates the ExtData tb with a new record containing the
type of external data being saved (such as ExtData), a new external
data key (after allocating a new one), and other relevant data
pertaining to this external data reference.

3 Commpost splits this file into interchanges and creates INT files
(interchanges) and IPC files for the Translator.

4 Commpost invokes the Translator, which continues with the inbound
process and creates a record in ExtDataXref tb linking the external
data reference to the interchange just created. There is one IPC file
for each interchange, and the IPC file passes information to the
Translator, including the starting and ending offset indicators in the
transmission file for the interchange to which it corresponds and the
external data type and key.

This ensures that the system can reference this file (external data) in the event you
want to view tracking information or external data.

Note
If you do not configure Gentran:Server to copy external information, the external
data viewer is unavailable.

References

See the following for more information:
» Processing Data Files on page 5 - 14
» Exporting Documents on page 4 - 59

» System Configuration—External Data Tab and the Using Database Tables
appendix in the Administration Guide
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Mailbox process = When data enters the system through a mailbox, all associated message identifiers
file process  are tracked using the following process:

Stage

Description

1

Your trading partner creates a data file (in which ContentType is set
to Application/EDI. An associated message ID is created in the
Outbox.

Your partner sends it to your Gentran Application Inbox, which
creates a new target message ID.

The CommMgr (the Gentran:Server Executive service) recognizes
the ContentType as Application/EDI. It receives the data and stores
the external data reference in the ExtData tb in the same way as
described in the previous section, except that since CommMgr
receives the data, it saves this database entry.

The CommMgr builds a temporary session file using the
GDW_Process MBFile command for unattended processing to
execute, and Process Control invokes Commpost.

Commpost builds the IPC file, which includes writing the external
data key and the start and end offset indicators in the transmission
file for the given interchange.

Commpost invokes the Translator for each interchange to finish
processing the data, and writes the entry in the ExtDataXref tb to
link the external data reference to the Gentran data.

References
See the following for more information:

» Using Process Control, chapter 11 in this guide

» Communications User s Guide

» Using Database Tables appendix in the Administration Guide
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Export process  Data that is exported is already in the system, so the external data that creates the
export file is the Translator. Therefore, the Translator stores the tracking
information in the database.

Stage Description

1 The Translator uses the document or documents as input to the
export translation object.

2 Depending on the specifications of the translation object, the system
generates an export file.

3 The Translator copies the newly generated export file to the External
Data folder in the system data store, updates the ExtData_tb with the
appropriate information, and updates the ExtDataXref tb with the
external data and associated document information.

References
See the following for more information:

» Exporting Documents on page 4 - 59
» Using Database Tables appendix in the Administration Guide
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Tracking Outbound Information

Introduction  For outbound processing, the system can import external data through the Import
command within Gentran:Server or through a Mailbox message (when the
ContentType is configured to Application/Import). After the file is imported into
the system, you can send the file or configure Process Control to send the file
automatically. After a send command, a new mailbox message is created and any
subsequent send transmissions create a new mailbox message that is related to the
same external data file that was initially imported.

Import process  Data is imported using the following process:

Stage Description

1 The external data is imported directly into Gentran:Server. This data
is either coming from an unattended process control (GDW_Import)
or a manual import.

2 Depending on how the data is imported, either UNATTEND or
EDIMGR copies the external data file to the External Data folder in
the system data store.

3 UNATTEND or EDIMGR updates the ExtData tb with an entry that
indicates the filename, the date and time from the timestamp on the
file, the date and time of the action, and the ExtDataKEY

4 UNATTEND or EDIMGR writes the ExtDataType and ExtDataKEY
parameters to the [PC file (they are called "Type" and "Key,"
respectively, in this file).

5 The Translator executes the import translation object. It obtains the
ExtDataType and ExtDataKEY from the IPC file and writes the
ExtDataXref tb entries that link the documents to the external data
reference created by EDIMGR or UNATTEND.

References
See the following for more information:

» Importing Documents on page 4 - 57
» Using Process Control on page 11 - 1
» Using Database Tables appendix in the Administration Guide
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Tracking Outbound Information

Mailbox import  When an external data file is imported using a Collection Mailbox, all the
process  associated message identifiers are tracked by the system according to the
following process:

Stage

Description

1

When outbound data flows through the system, the Collection
Mailbox creates a data file and an associated message ID in its
Outbox (with ContentType set to Application/Import).

The Collection Mailbox sends it to your Gentran Application Inbox,
creating a new target message ID.

Note

For a Mailbox Import, you must specify the UNC path and file name
on the System Configuration Imports tab. This specification must
exactly match the path you set for the TRANSIN directory on the
System Configuration Directories tab.

References
See the following for more information:

» How to Create a File System Mailbox in the Communications
User's Guide

» System Configuration—Directories Tab in the Administration
Guide

» System Configuration—Imports Tab in the Administration Guide

The CommMgr recognizes the ContentType as Application/Import
and initiates the import of this file.

The CommMgr stores the external data reference in the ExtData_tb
and then builds the unattended processing session file (with the new
GDW_MBImport command) to import the data into Gentran:Server.

After the session file is created, unattended processing creates the
IPC file and writes the external data information that the Translator
needs to perform an import.

The Translator runs the import map stores tracking information in the
ExtDataXref tb.

References
See the following for more information:

»  Using Process Control, chapter 11 in this guide

» Communications User’s Guide

» Using Database Tables in the Administration Guide

Gentran:Server for Windows User’s Guide
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Send process  After a file has been imported, the Gentran:Server documents that are created can
be sent to a Mailbox according to the following process:

Stage

Description

1

The system creates an associated Mailbox message in the Gentran
Application mailbox.

It sends the message to the partner’s mailbox. Like the process file
and import actions, the send action has a source and target message
ID associated with the external data. However, unlike the other
actions, the external data is a message and it is related to an
interchange.

The links between the interchange that is sent and the Mailbox
message to which it is sent are preserved in the ExtDataXref tb.
When you want to view this information, it is available in the
External Data Summary Viewer.

Example

In this scenario, the user has selected to send multiple documents in one
interchange. After the Translator builds the interchange, the CommMgr sends the
interchange to the Mailbox. While the CommMgr is sending the interchange, it
receives a message ID for the Mailbox to create a message in the Gentran
Application mailbox. Then, it creates an external data reference in the ExtData tb
where the type is Message. Finally, CommMgr has enough information to create a
record in the ExtDataXref tb linking the interchange to the message.

References
See the following for more information:

» Sending Document on page 5 - 6

» Communications User s Guide

» Using Database Tables in the Administration Guide

6
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Viewing and Printing Data Audit Information

Introduction  Typically, you view data audit (document tracking information that is available for
a single document) to get information to help resolve a problem with a document.
These records can be viewed from any of the document browsers.

Procedure  To view or print data audit information, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select the desired browser.

System response

If you select the In Documents, ?In Documents, Out Documents,
?0ut Documents, In Drawer, or Out Drawer browser, the appropriate
summary dialog for that browser is displayed.

2 To access the browser containing those documents, select the type of
document for the appropriate partner and click View.

3 Select a single document and select View from the Commands
menu.

System response
The system displays the View Choice Dialog Box.

4 Select Data Audit and click OK.

System response
The system displays a Document Audit window for that document.

Note

The Document Audit window contains the audit messages specific to
the selected document. The information in this window includes the
severity of the message, event ID, event name, audit number, user
name, machine name, and message.

Reference
See Using the Audit Notification System in the Administration
Guide for more information.

5 Do you want to print the displayed data audit information?
» Ifyes, from the File menu, select Print.

» Ifno, click Close to exit the Tracking window.
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Viewing and Printing Tracking Information

Introduction  This function displays information that tracks an external data file. These records
can be viewed from any of the document browsers.

Procedure To view or print tracking information, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select the desired browser.

System response

If you select the In Documents, ?In Documents, Out Documents,
?0ut Documents, In Drawer, or Out Drawer browser, the appropriate
summary dialog for that browser is displayed.

To access the browser containing those documents, select the type of
document for the appropriate partner and click View.

Select a single document and select View from the Commands
menu.

System response
The system displays the View Choice Dialog Box.

Select Tracking Information and click OK.

System response
The system displays a Tracking Information window for that
document.

Note

The Tracking Information window contains an entry for each set of
correlated files. If there are more events than can be displayed in the
window, a scroll bar enables you to view the remaining records.

Do you want to print the displayed tracking information?
» Ifyes, from the File menu, select Print.

» Ifno, click Close to exit the Tracking window.

6
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Introduction

Introduction

In this chapter

Archive feature

Restore feature

When to use
archive

Using Archive and Restore

This chapter explains how to use the interactive archive and restore feature of
Gentran:Server.

The Archive feature provides a record of past interchanges (inbound and
outbound), application data, and mailbox messages. This enables you to produce
an offline archive data file of interchanges, external data, or mailbox messages
with stored parameters (archive definitions) that you define. This archive data file
can be stored long-term.

You can also use Gentran:Server Process Control to purge and archive data at
predefined intervals.

Reference
See Using Process Control, chapter 11 in this guide, for more information about
scheduling unattended archive sessions.

The Restore feature enables you to reprocess archived data through
Gentran:Server. This feature copies data from an archive data file back to the
active system. For restored interchanges, you can then view the data in the
Restored Interchange browser and reprocess it, if necessary.

We recommend that you archive your system data on a weekly basis. Using this
feature is critical in large volume operations.

6
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Using Archive and Restore

Overview

Archiving Data

Overview

Types of data
that can be
archived

Archive
definition

The Archive feature enables you to archive the following types of data:
» Inbound and outbound interchanges (Gentran EDI)
» Mailbox messages (and any corresponding attachments)

» External data

Note

If a document is waiting for acknowledgement processing (acknowledgement
generation or reconciliation), you will not be able to archive it until this
processing is complete.

You can completely configure the Archive feature by using stored archive
definitions. An archive definition is a set of archive parameters that you set to
specify the exact data that you want the system to archive. The system saves the
archive definition file (*.ARD file) so you can execute the same archive process
repeatedly without having to define parameters again.

Reference
See Creating an Archive Definition on page 10 - 36 for more information.
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Overview

The archive
process

Using Archive and Restore

The following table describes the archive process:

Stage Description
1 Define the archiving parameters (*.ARD file). The archive
parameters available depend on the type of data you are archiving.
THEN the available archive parameters
IF you archive... are...
Gentran EDI, » partner profile ID
»  whether the interchange is inbound or
outbound
» age
» processed status
» network status
» acknowledgement status
Mailbox messages, » mailbox (a particular mailbox or all
mailboxes)
» location (Inbox, Outbox, or both)
» age
» status
» content type
external data, » action taken
» age
2 Execute the archive process, which creates the archive files (*.ARV)
in the Archive folder.
Note
This definition can be run interactively or on a scheduled basis via
Process Control.
Reference
See Using Process Control, chapter 11 in this guide, for more
information about scheduling the archive process.
3 In the archive process, the system copies (or removes) data both from

the database tables and the system data store.

6
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Using Archive and Restore

Archive Manager

Archive Manager

Introduction

Archive
information
available to view

The Archive Manager is the facility through which you archive and restore data.
The Archive Manager enables you to view the following.

» archive definition files
» summary data about the control information that was archived

» the detailed contents of the data stored in the archive data file

Notes

» When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

» You can sort the Archive tree by filename or by date/time.

The Archive Manager also provides you with a search facility that enables you to
quickly define search parameters that are used to find a specific piece of
information. The system displays the matching results in the How to Archive
Data. You can then select the desired information and the system highlights it in
the Archive Manager tree view.

The Archive Manager retains extensive data for the information you archive and
enables you to easily view it.

Reference
See Viewing Archived Data on page 10 - 39 for more information.

The Archive Manager user interface uses a tree structure that displays the
hierarchical levels of the archived data. This table lists the information available
for each level of the Archive entry for Gentran EDI, Mailbox, and External Data.

Note
N/A indicates that the item is a graphical placeholder used only to illustrate the
type of data that was archived.

IF you select the... THEN you can view...

archive file at the summary information, including the following:
Gentran EDI, Mailbox,
or External Data level

» date and time the archive started
» date and time the archive ended
» number of items archived

» number of items deleted (if any)

(Continued on next page)
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Archive Manager

Using Archive and Restore

IF you select the... THEN you can view...
interchange summary information, including the following:
» partner profile ID
» direction
» date and time
» interchange control number
data audit
tracking information
group summary information, including the following:
» group control number
» functional group ID
» group control key
document summary information, including the following:
» transaction ID
» transaction control number
» document name
data audit
tracking information
mailbox N/A
Inbox/Outbox N/A
message summary information, including the following:
» series ID
» message ID
» source ID
» content type
» sender ID/recipient ID
» sender name/recipient name
» sender mailbox E-mail/recipient mailbox E-mail
» subject
» status
» time message created
data audits
(Continued on next page)
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Archive Manager

IF you select the...

THEN you can view...

attachment

summary information, including the following:
» attachment ID
» content type

» filename

data audits

file, which is viewed either in an external viewer (the
default viewer is Notepad) or on screen in the
Archive Manager.

Note

When viewing raw-EDI or external data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

external data

any one of the following:

» external data type

» external data key

» action

» date and time of action

» original filename

data audits

Upper-right pane

any one of the following, depending on the level and
type of the selection:

» file information (start, end, number of items
archived, and if any items were deleted)

» interchange information
» group information

» document information

» message information

» attachment information

» external data information
» data audit information

» tracking information

Lower-right pane

the content of the selected attachment.
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Diagram  The following illustrates the Archive Manager, shown with the Archive tree
expanded and a Mailbox message selected:

m Archive Manager M=l 3
File  Archivez Definitions  Help
[ > o
ESRVall—
E{ﬁ] Archive Subsystem | |_Attachment [d | Content Type | Filename |
Gentran EDI al Application45G File  150.M505
M ailbox
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EIEfI MyCollect]_2Wan2000_154251
= A MyCallect]
E@ Inbox
=g Dutbox
-] meg 62
-] meg 63
-] msg 64 +TN0A : 1+FETTESTL : 00+FETTESTL : 00+ 950818 : 13023 +4' |
o +3+0RDERS : 92 : 1 : TN
.E gBB ++100020002000+3"
(- mzg +4:350815"
B[] meg B7 +117:9508146"
(=] mea B3 +152 : 950817
E meg 59 ADHET+++BILLTD NAME+BILLTC ADDREZS] :BILLTC ADDRESS
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B LO+R++2!
"E msg 75 CA+TET - 50
-] meg 76 LIN+Z++555668217"
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-] msa 78 OTY+21 : 200 :10"
: Cb+146:10"
-] msg 79 LO+C+13
=] meg 80 CA+EEE 115"
b LIN+3++555556505 "
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B[l Extemal Data Qgi:ié%g;%n
B-{2]l Definitions L4153
E-{Z] Archives OR+EET 10"
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. [ External Data, 9. Import LI P | | »
Ready NUM i

Parts and  The following lists the parts of the Archive Manager and their functions:
functions

Part Function

File menu Exit Archive Manager.
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Archive Manager

Part

Function

Archives menu

Contains the following options:
» Restore data.

» Mark data for restoration (single item or all
items).

» Unmark data (single item or all items).
» Refresh (archive-level).

» View data audits at the interchange, document
message, or external data level.

» View data audits and data at the interchange,
document, attachment, or external data level.

» Delete archive files.
» Search for specific archived data.

» Select how you want the Archive data sorted.

Definitions menu

Contains the following options:

» Create new archive definition.

» Edit or delete archive definition.
» Archive data.

Help menu

Access Archive Help and information about the
Archive Manager.

[

Create new archive definition.

Archive data.

N | [

Mark selected item to be restored to the system.

=l

Restore marked data to the system.

Left pane

Archive, view, and restore data.

(Continued on next page)
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Using Archive and Restore

Part

Function

Upper right pane

The display depends on the level and type of the
selection, but may contain any one of the following:

» file information (start, end, number of items
archived, and if any items were deleted)

» interchange information
» group information

» document information

» message information

» attachment information

» external data information
» data audit information

» tracking information

Lower right pane

Displays the content of the selected interchange,
document, attachment, or external data file.

6

Gentran:Server for Windows — November 2005

Gentran:Server for Windows User’s Guide



Using Archive and Restore

Gentran EDI Archive Definition Dialog Box

Gentran EDI Archive Definition Dialog Box

Diagram

The following illustrates the Gentran EDI Archive Definition dialog box:

Gentran EDI Archive Definition

I arne: I

™ Delete Data After Archive

r— Selection Criteria

fdd | Eft peE
Partrer | Direction | Daysz Old | Processed Status | Mebwork Status | Acknowledgement Status | Owerduye groups and Interchanges |
Save I Cancel Help

Parts and
functions

The following lists the parts of the Gentran EDI Archive Definition dialog box

and their functions:

Part Function

Name Specify the name of the archive definition file.
Note
This name must be unique.

Delete Data After Tell the system to remove the interchange data after

Archive archiving it.

Add Accesses the Mailbox Selection Criteria Dialog Box
and enables you to define new archive criteria.

Edit Accesses the Mailbox Selection Criteria Dialog Box

for the selected criteria and enables you to modify the
archive criteria.

(Continued on next page)
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Using Archive and Restore

Part Function

Delete Deletes the selected Gentran EDI criteria from the
system.
Warning
The system removes the criteria without prompting
you to confirm the deletion.

Partner Displays the partner profile ID.

Direction Displays the direction of the interchanges.

Days Old Displays the age of the interchanges.

Processed Status

Displays the processed status of the interchanges.
The default is All.

Network Status

Displays the network status of the interchanges. The
default selection is All.

Acknowledgement
Status

Displays the acknowledgement status of the
interchanges. The default is AllL

Overdue groups and

Displays whether overdue groups and interchanges

Interchanges are archived. The default is No.

Save Saves the archive definition and exits the Gentran
EDI Archive Definition dialog box.

Cancel Exits the Gentran EDI Archive Definition dialog box.

Help Accesses Online Help.
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Interchange Selection Criteria Dialog Box

Interchange Selection Criteria Dialog Box

Diagram  The following illustrates the Interchange Selection Criteria dialog box:

Interchange Selection Criteria |

Partner IAII j
Direction: {* Bath " Inbound " Outhound
[rays Old: ID— [ Archive Dverdue Groups and Interchanges
Cutbound Criteria
Processed Status: IA" j
Metwork Status: I',_\,'" j
Ak Status: I'ﬁ'" j

Save I Cancel | Help |

Parts and  The following lists the parts of the Interchange Selection Criteria dialog box and

functions their functions:

Part

Function

Partner

Select a partner profile ID (default is All).

Direction

Choose Both (inbound and outbound), Inbound, or
Outbound.

Days old

Specify the age (in days) of the interchanges to be
archived.

Archive Overdue
Groups and
Interchanges

Specify whether overdue groups and interchanges are
archived. The default is No. If selected, the system
behavior prior to the implementation of Deferred
Acknowledgements is implemented where overdue
groups and interchanges are archived if the user
selects “All” or “ReconcileOverdue” for the
acknowledgement status and the direction is “Both”
or “Outbound.”

If this checkbox is not selected, outbound overdue
groups and interchanges are not archived.

(Continued on next page)
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Using Archive and Restore

Part

Function

Processed Status

Select the processed status of the interchanges that

are to be archived. Valid values:
» All (default)

» Received

» Sent

» ReadyToSend
» Queued

» Held

» SendFailed

Network Status

Select the network status of the interchanges that are

to be archived. Valid values:
» All (default)

» NotSent

» ReceivedOK

» ReceivedWarning

» ReceivedError

» PickedUp

» ThirdParty

Ack Status

Select the acknowledgement status of the
interchanges that are to be archived. Valid values:

» All (default)

» ReconcileNotRequired
» ReconcileWaiting

» ReconciledOK

» ReconciledErrors

» ReconciledPartial

» ReconciledReject

» ReconcileOverdue

Save

Saves the selection criteria and exits the Interchange

Selection Criteria dialog box.

Cancel

Exits the Interchange Selection Criteria dialog box.

Help

Accesses Online Help.
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Interchange Search Dialog Box

Interchange Search Dialog Box

Diagram  The following illustrates the Interchange Search dialog box:

Interchange Search [ x|

Farther

Direction;

Contral Mumber:

|AII

' Both

=

' Inbound " Outbound

— Inbound Criteria

[ Becsived Between: |2Dnnf02;14 132545 j and |2nnwuzz14 132545 j

— Outbound Criteria

Processed Status:
Metwork, Status:

Ack Status:

| Sent Betiween:

[ =]
[ =]
[ =]

|2an02;14 122545 j and |2nnux02,=14 122545 j

Find I Cancel | Help |

Parts and  The following lists the parts of the Interchange Search dialog box and their

functions functions:

Part

Function

Partner

Select a partner profile ID (default is All).

Direction

Choose Both (inbound and outbound), Inbound, or
Outbound.

Control No.

Specify a control number.

Received Between

Define a range of dates and times to search (in
YYYY/MM/DD and HH:MM:SS format) for
received interchanges.

(Continued on next page)

Gentran:Server for Windows User’s Guide

Gentran:Server for Windows — November 2005 ()



Interchange Search Dialog Box

Using Archive and Restore

Part

Function

Processed Status

Select the processed status of the interchanges to
search for. Valid values:

» All (default)

» Received

» Sent

» ReadyToSend
» Queued

» Held

» SendFailed

Network Status

Select the network status of the interchanges to
search for. Valid values:

» All (default)

» NotSent

» ReceivedOK

» ReceivedWarning
» ReceivedError

» PickedUp

» ThirdParty

Ack Status

Select the acknowledgement status of the
interchanges to search for. Valid values:

» All (default)

» ReconcileNotRequired
» ReconcileWaiting

» ReconciledOK

» ReconciledError

» ReconciledPartial

» ReconciledReject

» ReconcileOverdue

Sent Between

Define a range of dates and times to search (in
YYYY/MM/DD and HH:MM:SS format) for sent
interchanges.

Note
Click the arrow to access the calendar control.

(Continued on next page)
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Interchange Search Dialog Box

Part

Function

Find

Finds the appropriate interchanges based on the
criteria you selected and displays them in the Search
Results Dialog Box.

Cancel

Exits the dialog box.

Help

Accesses Online Help.
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Group Search Dialog Box

Diagram  The following illustrates the Group Search dialog box:

Group Search E
Partrer I,&II j

Direction: ' Bath " Inbound " Outbound

Cantral Humber: I

Group [d: I

Ak Status: IA" ﬂ

Parts and  The following lists the parts of the Group Search dialog box and their functions:

functions
Part Function
Partner Select a partner profile ID (default is All).
Direction Choose Both (inbound and outbound), Inbound, or
Outbound.

Control No. Specify control number.

Group ID Specify group identifier.

Ack Status Select the acknowledgement status of the groups to

search for. Valid values:

» All (default)

» ReconcileNotRequired
» ReconcileWaiting

» ReconciledOK

» ReconciledErrors

» ReconciledPartial

» ReconciledReject

» ReconcileOverdue

(Continued on next page)
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Using Archive and Restore Group Search Dialog Box
Part Function
Find Finds the appropriate groups based on the criteria
you selected and displays them in the Search Results
Dialog Box.
Cancel Exits the dialog box.
Help Accesses Online Help.
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Document Search Dialog Box

Diagram  The following illustrates the Document Search dialog box:

Document Search K3
Partrer I.-’-'«II j

Diirection: {+ Both ' Inbound " Dutbound

Caontrol Mumber:

Trahg Id:

|
|
Ref Data: I
Mame: I

Ack Status: I"f""" j

Parts and  The following lists the parts of the Document Search dialog box and their
functions  functions:

Part Function

Partner Select a partner profile ID (default is All).

Direction Choose Both (inbound and outbound), Inbound, or
Outbound.

Control No. Specify a control number.

Trans ID Specify a transaction identifier.

Ref Data Specify the reference data from the translation object.

Name Specify the document name established for the
translation object.

(Continued on next page)
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Part Function

Ack Status Select the acknowledgement status of the documents
to search for. Valid values:

» All (default)

» Received

» ReconcileWaiting
» ReconciledOK

» ReconciledErrors
» ReconciledPartial
» ReconciledReject

» ReconcileOverdue

Find Finds the appropriate documents based on the criteria
you selected and displays them in the Search Results
Dialog Box.

Cancel Exits the dialog box.

Help Accesses Online Help.
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Mailbox Archive Definition Dialog Box

Diagram  The following illustrates the Mailbox Archive Definition dialog box:

Mailbox Archive Definition

Marne: I

[ Delete Data dfter Archive

r— Selection Criteria

add | Edr | D |

i ailbox | Lacation | Daps Old | Status | Content Type |

TCave Cancel Help

Parts and  The following lists the parts of the Mailbox Archive Definition dialog box and
functions their functions:

Part Function
Name Specify the name of the archive definition file.
Note
This name must be unique.
Delete Data After Tell the system to remove the message data after
Archive archiving it.
Add Accesses the Mailbox Selection Criteria Dialog Box

and enables you to define new archive criteria.

Edit Accesses the Mailbox Selection Criteria Dialog Box
for the selected mailbox criteria and enables you to
modify the archive criteria.

(Continued on next page)
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Part Function

Delete Deletes the selected mailbox criteria from the system.

Warning
The system removes the criteria without prompting
you to confirm the deletion.

Mailbox Displays the mailbox name.

Location Displays the location of the messages.

Days Old Displays the age (in days) of the messages to be
archived.

Status Displays the status of the messages that are to be

archived. The default is All.

Content type Displays the content type of the messages. The
default selection is Any.

Save Saves the archive definition and exits the Mailbox
Archive Definition dialog box.

Cancel Exits the Mailbox Archive Definition dialog box.

Help Accesses Online Help.
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Mailbox Selection Criteria Dialog Box

Diagram  The following illustrates the Mailbox Selection Criteria dialog box:

Mailbox Selection Criteria B

Mailbe [ =]

Location: * Bath  Inbox " Dutbox
Drays Old: IU—

Status: I Al j

Content Type: I,.f_m_.lJ ﬂ

Parts and  The following lists the parts of the Mailbox Selection Criteria dialog box and their
functions  functions:

Part Function
Mailbox Select a mailbox (default All).
Location Choose Both (Inbox and Outbox), Inbox, or Outbox.
Days old Specify the age (in days) of the messages to be
archived.
Status Select the status of the messages that are to be

archived. Valid values:
» All (default)
» Delivered

» Picked Up
» Read
» Sent

» Sent Third Party

(Continued on next page)
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Part Function

Content type Select the content type of the messages. Valid values:
» Any (default)

» Application/EDI

» Application/Document-EDI

» Application/Import

» Application/rosettanet-agent (only if

Gentran:Server for RosettaNet is installed)

Note
This edit box allows you to enter any content type
you created.

Save Saves the selection criteria and exits the Mailbox
Selection Criteria dialog box.

Cancel Exits the Mailbox Selection Criteria dialog box.

Help Accesses Online Help.
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Mailbox Search Dialog Box

Diagram  The following illustrates the Mailbox Search dialog box:

Mailbox Search
b il [ =]
Locatior: " Both T Inbox " Quthox
Status: Ia‘-‘«ll j
Content Tupe: |An_l,l j

V| Crested Betwesr:  [2000/02/1¢ 130253 v| and [2000/02/14 130259 |

I¥| Sert Bebwest: |2DDDJ|32£14 13:02:59 j - |2|:|u|:|,4|:|2,'14 130253 j

| Received Betweer: |2000/02/14 130259 7| and | 2000/02/14 130289 7|

Cancel | Help |

Parts and  The following lists the parts of the Mailbox Search dialog box and their functions:

functions
Part Function

Mailbox Select a mailbox (default is All).

Location Choose Both (Inbox and Outbox), Inbox, or Outbox

Status Select the status of the messages to be archived. Valid
values:
» All (default)
» Sent
» Read
» Delivered
» Picked Up
» Sent Third Party

Content type Select the content type of the messages. The default
is Any, but you can type in any content type you have
created.

(Continued on next page)
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Mailbox Search Dialog Box

Part

Function

Created Between

Define a created between range of dates and times to
search (in YYYY/MM/DD and HH:MM:SS format).

Note
Click the arrow to access the calendar control.

Sent Between

Define a sent between range of dates and times to
search (in YYYY/MM/DD and HH:MM:SS format).

Note
Click the arrow to access the calendar control.

Received Between

Define a received between range of dates and times
to search (in YYYY/MM/DD and HH:MM:SS
format).

Note
Click the arrow to access the calendar control.

Find

Finds the appropriate messages based on the criteria
you selected and displays them in the Search Results
Dialog Box.

Cancel

Exits the Mailbox Search dialog box.

Help

Accesses Online Help.
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External Data Archive Definition Dialog Box

Diagram  The following illustrates the External Data Archive Definition dialog box:

External Data Archive Definition = I

Mame; Itcst

[V Delete Data &fter Archive

|- Selaction Crtena
i add |

Acliori Taken | Daps Dld_| Archive Ext Data Files |
Al o ez

Save Cancel Help
| E

Parts and  The following lists the parts of the External Data Archive Definition dialog box
functions  and their functions:

Part Function
Name Specify the name of the archive definition file.
Note
This name must be unique.
Delete Data After Tell the system to remove the message data after
Archive archiving it. This is selected by default.
Add Accesses the External Data Selection Criteria Dialog

Box and enables you to define new archive criteria.

Edit Accesses the External Data Selection Criteria Dialog
Box for the selected mailbox criteria and enables you
to modify the archive criteria.

(Continued on next page)
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External Data Archive Definition Dialog Box

Part

Function

Delete

Deletes the selected external data criteria from the
system.

Warning
The system removes the criteria without prompting
you to confirm the deletion.

Action Taken

Displays the action taken on the external data file.
Value values:

» All (default value)
» ProcessFile
» MBProcessFile

» Import

» MBImport
» Send

» Export

Days old

Displays the age (in days) of the external data files to
be archived.

Archive Ext Data Files

Displays the archived external data files.

Save

Saves the archive definition and exits the External
Data Archive Definition dialog box.

Cancel

Exits the External Data Archive Definition dialog
box.

Help

Accesses Online Help.
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External Data Selection Criteria Dialog Box

Diagram  The following illustrates the External Data Selection Criteria dialog box:

E xternal D ata Selection Criteria E3
Action Taken: |A|| j
Draps Old: ||:|
[ Archive Files

Cancel | Help

Parts and  The following lists the parts of the External Data Selection Criteria dialog box and
functions their functions:

Part Function

Action Taken Select the action to be taken on the external data file.
Value values:

» All (default value)
» ProcessFile

» MBProcessFile

» Import

» MBImport

» Send

» Export

Days old Specify the age (in days) of the external data files to
be archived.

Archive Files Indicate that the external data files will be archived.

Save Saves the selection criteria and exits the External
Data Selection Criteria dialog box.

Cancel Exits the External Data Selection Criteria dialog box.

Help Accesses Online Help.
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External Data Search Dialog Box

Diagram  The following illustrates the External Data Search dialog box:

External Data Search |

Ation Taken: I,.-:-._|| j

Actint Eertamed = =
I_ B ehwear IEDDD!D2H14 13:58:54 j =iyl I2EIDEI.-’EI2:’14 13:58:54 j

Original Filenare: I

External Data Key: I

Find I Cancel Help

Parts and  The following lists the parts of the External Data Search dialog box and their
functions  functions:

Part Function

Action Taken Select the action to be taken on the external data file
for which to search. Value values:

» All (default)
» ProcessFile
» MBProcessFile

» Import

» MBImport

» Send

» Export
Action Performed Define a range of dates and times on which to search,
Between defining when the action was performed on the

external data file (in YYYY/MM/DD and
HH:MM:SS format).

Note
Click the arrow to access the calendar control.

Original Filename Specify the original name of the external data file for
which to search.

(Continued on next page)
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Part Function
External Data Key Specify the external data key for which to search.
Find Finds the appropriate messages based on the criteria
you selected and displays them in the Search Results
Dialog Box.
Cancel Exits the External Data Search dialog box.
Help Accesses Online Help.
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Search Results Dialog Box

Diagram  The following illustrates the Search Results dialog box, illustrating the result of a
search performed on archived mailbox messages:

Search Results
Archive Hame | Mailbos | Meszage Id | Location | Time Created | -
SWHATETTEMH...  MyCollectl B2 Outhos 01/06/00 15:15:04
SWATETTEMH...  MyCollectl B3 Outhos 01/06/00 15:15:05
SWATETTEMH...  MyCollectl B4 Outhos 01/06/00 15:15:06
SWHATETTEMH...  MyCollectl BS Outhos 01/06/00 15:15:09
SWHATETTEMH...  MyCollectl! BB Outhos 01/06/00 15:15:14
SWATETTEMH...  MyCollectl B7 Outhos 01/06/00 15:15:16
SWATETTEMH...  MyCollectl B8 Outhos 01/06/00 15:15:17 |
SWHATETTEMH...  MyCollectl B39 Outhos 01/06/00 15:15:18
SWHATETTEMH...  MyCollectt 71 Outhos 01/0B/00 15:15:25
SWATETTEMH...  MyCollectl 72 Outhos 01/0B/00 15:15:26
SWATETTEMH..  MyCollectl 73 Outhos 01/08/00 15:15:27
SWATETTEMH...  MyCollectl 74 Outhos 01/06/00 15:15:28
SWATETTEMH...  MyCollectl 75 Outhos 01/08/00 15:15:33
SWHATETTEMH...  MyCollectl 76 Outhos 01/06/00 15:15:34
SWHATETTEMH...  MyCollectl 77 Outhos 01/06/00 15:15:35
SWATETTEMH...  MyCollectl 78 Outhos 01/06/00 15:15:36
SWATETTEMH...  MyCollectl 79 Outhos 01/06/00 15:15:45
SWHATETTEMH...  MyCollectl 80 Outhos 01/06/00 15:15:47
SWHATETTEMH...  MyCollectl B2 Outhos 01/06/00 15:15:04
SWATETTEMH...  MyCollectl B3 Outhos 01/06/00 15:15:05
SWATETTEMH...  MyCollectl B4 Outhos 01/06/00 15:15:06
SWHATETTEMH...  MyCollectl BS Outhos 01/06/00 15:15:09
SWHATETTEMH...  MyCollectl! BB Outhos 01/06/00 15:15:14
SWATETTEMH...  MyCollectl B7 Outhos 01/06/00 15:15:16
SWATETTEMH...  MyCollectl B8 Outhos 01/06/00 15:15:17
SWHATETTEMH...  MyCollectl B39 Outhos 01/06/00 15:15:18
SWATETTEMH...  MyEstractl 70 Inbox 01/06/00 15:15:04
SWHATETTEMH...  MyCollectt 71 Outhos 01/0B/00 15:15:25
SWATETTEMH...  MyCollectl 72 Outhos 01/0B/00 15:15:26
SWHATETTEMH...  MyCollectl 73 Outhos 01/06/00 15:15:27 LI

b ark All | Eresinms | [d[Ewk |
Mt Enmark: | Help | Cloze |

Parts and  The following lists the parts of the Search Results dialog box and their functions:

functions
Part Function

(list) Displays context-specific information, depending on
whether you searched for interchanges, groups,
documents, messages, or external data.

Mark All Marks all items in the Search Results dialog box to
be restored.

(Continued on next page)
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Part Function

Previous Selects the previous item in the list.

Note
This button is only enabled if you select an archive
file.

Next Selects the next item in the list.

Note
This button is only enabled if you select an archive
file.

Mark/Unmark Flags the selected item to be restored (or deselect a
previously selected item).

Note
This toggle button is only enabled if you select an
archive file.

Help Accesses Online Help.

Close Exits Search Results dialog box.

( Gentran:Server for Windows — November 2005 Gentran:Server for Windows User’s Guide



Using Archive and Restore Sort Preferences Dialog Box

Sort Preferences Dialog Box

Diagram  The following illustrates the Sort Preferences dialog box, which enables you to
select how you want the archive data sorted in the Archive tree view:

X

Select how you want your archives sorted
in the dizplay:
Cancel |

" By Filename

How to access Select Preferences from the Archive menu.

Parts and  The following lists the parts of the Sort Preferences dialog box and their
functions  functions:

Part Function

Select how you want Select one of the following methods of sort order:

your ?rchives sortedin | ) Date/Time

the display )
» Filename

OK Implements the selected sort order and exits the
dialog box.

Cancels Exits the dialog box without changing the sort order.
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Creating an Archive Definition

Procedure  To create an archive definition file, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the Archive tree.

Note
This is necessary to create a new archive definition.

Right-click Definitions under Gentran EDI, Mailbox, or External
Data, and select New from the shortcut menu to define archive
parameters.

System response

The system displays the Gentran EDI Archive Definition Dialog
Box, the Mailbox Archive Definition Dialog Box, or the External
Data Archive Definition Dialog Box.

In the Name box, type the name of the archive definition.

Do you want the system to remove the data from the Gentran:Server
system after archiving it?

» Ifyes, select the Delete Data After Archive check box and
continue with the next step.

» Ifno, continue with the next step.

Click Add.

System response
The system displays the appropriate Selection Criteria dialog box.

(Continued on next page)
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Creating an Archive Definition

Step

Action

Complete the appropriate parameters.

References
See the following for more information:

» Interchange Selection Criteria Dialog Box on page 10 - 13

»  Mailbox Selection Criteria Dialog Box on page 10 - 24

»  External Data Selection Criteria Dialog Box on page 10 - 30
Note

All elements on the Selection Criteria dialog boxes are

automatically set to the defaults, which results in the archival of all
data.

Click Save.

System response
The system exits the Selection Criteria dialog box.

Do you want to create additional archive criteria?
» Ifyes, repeat Steps 6 through 8.

» Ifno, continue with the next step.

10

Click Save on the appropriate Archive Definition dialog box.

System response

The system creates an archive definition file that contains the
archive parameters. The definition file is stored with an .ARD
extension.

11

Use this table to determine your next step.

IF you want to... THEN...

edit the archive criteria, select the appropriate item on the
appropriate Archive Definition
dialog box and click Edit.

delete archive criteria, select the appropriate item on the
appropriate Archive Definition
dialog box and click Delete.
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Before you begin  Before archiving data, you must create an archive definition file that contains your
selection criteria.

Reference
See Creating an Archive Definition on page 10 - 36 for more information.

Procedure  To archive data, complete the following steps:

Step

Action

1

Use your company’s computer backup process to back up the
Gentran:Server system before executing the archive process.

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the archive tree and open the appropriate Definitions folder.

Right-click the appropriate archive definition and select Archive
Data from the shortcut menu.

System response

» The system executes the archive process. An interactive progress
dialog box displays the current state of the archive process and
enables you to cancel the archive, if necessary.

» The system archives the data by the parameters you specified
and creating a new file in the Archives folder.

Naming convention

The system naming convention for creating the archive files uses the
same name of the archive definition file, plus the unique date and
time of archival, with an .ARV file extension.

When the archive process is complete, right-click the appropriate
Archive folder in the Archive Manager tree view and select Refresh.

System response
The system displays the archive file along with the date and time on
which the archive data file was created.
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Viewing Archived Data

Procedure  To view archived information, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the archive tree and open the appropriate Archives folder.

In the Archive folder, locate the archive data file for which you want
to view the contents (summary or detailed) or search for a specific
piece of data, and click the “+” to the left of that file.

System response
The system displays the archived files. When you select an archive
file, the system displays summary information for each item.

Reference
See Archive Manager on page 10 - 5 for details about the
information available at each level.

Select Preferences from the Archive menu, choose how you want
your archive data sorted in the Archive tree view, and click OK.

To view additional information, select the appropriate level of the
tree and use the following table to determine your next action.

Note
N/A indicates that the information that the system displays when
you selected the specified item.

IF you want to view the... THEN perform this action...

archive file information select the archive file.
(displayed in the Archive
Manager, upper-right pane)

interchange information select the interchange.
(displayed in the Archive
Manager, upper-right pane)

(Continued on next page)
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Step

Action

(contd)

interchange data audit
(displayed in the Archive
Manager, upper-right pane)

right-click the interchange and

select View\Data Audits from
the shortcut menu.

interchange tracking
information (displayed in the
Archive Manager, upper-right
pane)

right-click the interchange and

select View\Tracking Info
from the shortcut menu.

interchange file (displayed in
an external viewer)

right-click the interchange and

select View\Data\External
Viewer from the shortcut
menu.

interchange file (displayed in
the Archive Manager, lower-
right pane)

right-click the interchange and

select View\Data\Screen from
the shortcut menu.

group information (displayed
in the Archive Manager,
upper-right pane)

select the group.

document information
(displayed in the Archive
Manager, upper-right pane)

select the document.

document data audit
(displayed in the Archive
Manager, upper-right pane)

right-click the document and

select View\Data Audits from
the shortcut menu.

document tracking
information (displayed in the
Archive Manager, upper-right
pane)

right-click the document and

select View\Tracking Info
from the shortcut menu.

document file (displayed in an
external viewer)

right-click the document and

select View\Data\External
Viewer from the shortcut
menu.

document file (displayed in
the Archive Manager, lower-
right pane)

right-click the document and

select View\Data\Screen from
the shortcut menu.

(Continued on next page)

( Gentran:Server for Windows — November 2005

Gentran:Server for Windows User’s Guide



Using Archive and Restore Viewing Archived Data
Step Action
5 message information select the message.
(contd) | (displayed in the Archive

Manager, upper-right pane)

message data audit (displayed
in the Archive Manager,
upper-right pane)

» right-click the message and

» select View\Data Audits from
the shortcut menu.

attachment information
(displayed in the Archive
Manager, upper-right pane)

select the attachment.

attachment data audit
(displayed in the Archive
Manager, upper-right pane)

» right-click the attachment and

» select View\Data Audits from
the shortcut menu.

attachment file (displayed in
an external viewer)

» right-click the attachment and

» select View\Data\External
Viewer from the shortcut
menu.

attachment file (displayed in
the Archive Manager, lower-
right pane)

» right-click the attachment and

» select View\Data\Screen from
the shortcut menu.

external data information
(displayed in the Archive
Manager, upper-right pane)

select the external data file.

external data audit (displayed
in the Archive Manager,
upper-right pane)

» right-click the external data
file and

» select View\Data Audits from
the shortcut menu.

external data file (displayed in
an external viewer)

» right-click the external data
file and

» select View\Data\External
Viewer from the shortcut
menu.

(Continued on next page)
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Step Action
5 external data file (displayed in | »  right-click the external data
(contd) | the Archive Manager, lower- file and
right pane) » select View\Data\Screen from
the shortcut menu.

System response
The system displays the information you requested.
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Searching Archived Data

Introduction  The Archive Manager Search facility enables you to quickly define parameters
that are used to search all archive files or one archive file and find a specific piece
of information. You can then select the desired information, and the system
highlights it in the Archive Manager tree view.

Procedure  To search for a specific piece of archived data, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

2 From the Archive Subsystem tree, select the appropriate (Gentran
EDI, Mailbox, or External Data) Archives folder.

3 From the Archives menu, select Search and then select one of the
following:

» Message

» Interchange

» Group

» Document

» External Data

System response
The system displays the appropriate Search Dialog Box.

4 Select the appropriate parameters.

Note
If you do not change any parameters on a search dialog box, the
system finds the default (all items).

5 Click Find to execute the search.

System response
The system displays the Search Results Dialog Box.

Reference
See Archiving Data on page 10 - 38 for more information about the
actions you can perform on the Search dialog box.

6 Click Close to exit the Search Results dialog box.
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Restoring Archived Data

Overview

Restore feature

Restore caveats

Moving archive
files to tape

The Restore feature enables you to view and reprocess data via the Restored
Interchanges browser. When data is restored, the archive data file (*.ARV file) is
not altered.You can restore data from the same archive file again, if you wish.

To restore data to your system, the following must be true:
» The item must have been deleted after it was archived.

» For message data, the original mailbox must still exist on your system.

Note
If the original mailbox does not exist, Archive Manager attempts to recreate it.
This facsimile mailbox does not contain all the properties of the original one.

Reference
See Creating an Archive Definition on page 10 - 36 for more information about
the post-archive delete function.

As the number of archive data files created by the Archive function increases and
corresponding disk space is used, you may determine that you want to move
archive data files to tape.

Note

Copying archive files to tape is not part of the Gentran:Server functionality. If you
move an archive file to tape, the Archive Search facility is no longer aware of the
existence of the file. Files that are moved to tape cannot be viewed while on tape.
However, if you reload an archive file from tape to the Archives folder, you can
once again view the data via the Archive Manager.

Recommendation
Use some type of tape management system to track the archive files saved to tape.

6
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Overview

Procedure  To restore archived data, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Archive.

System response
The system displays the Archive Manager.

Expand the archive tree and locate the item that you want to restore.

Right-click the item and select Mark\Unmark from the shortcut
menu.

System response
The system flags that item for restoration.

Click Restore Data.

System response
The marked data is restored to your system.

Note
If the system is unable to restore data, you are prompted to view the
Audit Log for detailed information about why the failure occurred.

Use the following table to determine how to view the restored data.

IF the restored

data was an... THEN you can view the data in the...
interchange, Restored Interchanges browser.
Reference

See How to View Restored Interchanges for
more information.

message, Mailbox subsystem.

Reference
See the Communications Guide for more
information.

external data file, | External Data Summary viewer.

Reference
See Viewing External Data Files on page 6 - 8
for more information.
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The Restored Interchanges browser enables you to view a list of all interchanges,

groups, and documents that were restored from an archive file. This browser
contains status information about the interchanges, such as whether a functional
acknowledgement was received and the status of that acknowledgement.

The information about the Restored Interchanges browser is organized in a
hierarchical manner. The following table describes the hierarchical organization

of the information on the Restored Interchanges browser.

How to access

Information displayed (in middle pane)
(all information may not appear)

Open Restored
Interchanges browser

» direction of the interchange

» date and time the interchange
was created

» partner name

» control number

» interchange process status
» network status

» interchange acknowledgement
status

» message status

Note

If any of these components are
missing or not appropriate for a
particular interchange, they are not
displayed.

Introduction
Information
organization
Level
Interchange
Group

Double-click an
interchange

» group control number

» group type
» group acknowledgement status

Note

If any of these components are
missing or not appropriate for a
particular group, they are not
displayed.

(Continued on next page)
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Information displayed (in middle pane)
Level How to access (all information may not appear)

Document Double-click a group » document compliant status

» document control number

» document type

» document name

» reference data

» document compliant status

» transaction acknowledgement

status

Note

If any of these components are
missing or not appropriate for a
particular document, they are not
displayed.

document Double-click a document | document data

data
Note

A screen entry
translation object for that
document must available
on your system.

Browser  You can perform the following functions on the Restored Interchanges browser:

functions  ,  Fjjter the display of interchanges by date, partner, and direction (inbound and
outbound) from the Interchanges Filter dialog box.

» Display the external data, raw-EDI data, and translator report data for the
selected interchange or document in the appropriate browser panes.

Note
When viewing raw-EDI or external data, you can switch from Text to Hex
format by selecting the appropriate command from the View menu.

» Toggle the status of interchanges between Ready to Send and Hold.

» Print or delete a selected item.
Note

You might want to use the toggle function if you do not want to send an
interchange right away.
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Diagram  The following illustrates the Restored Interchanges browser:

& Restored Interchanges Summary - 2 [ [O]*]
== I.-’-'«II Farthers IDate.-"Time Checking iz Off.
N Root Cantrol Humber | Type | Doz, Mame | Referenc FIDEPETTEST  XO00307 4
| (=9 000000001-FETZONE | |[da] 0oat 810 5555555555 2202207, [FEGIILLIILLILGOONC |
£ £105/10/2002 03:33 M 3253353355538305.
M HE0001-FETZONE ] _’lJ
- =105/ 2/2002 12:46 PM-PET
: EIG*A50510*%555555 &)
EH:‘ 4-PETZONE FEF*EM*5555555555.
.| D004-PETZOME 1 *VISVENDOR. NAM-
4] _>I_I

Docunent Sunmary |

Trading Partner:

< (3 ) | oy

Siy

Parts and  The following lists the parts of the Restored Interchanges browser and their
functions  functions:

Part Function

Status bar Reflects the filer specifications from the Interchange Filter
Dialog Box on page 7 - 8.

Note
The Electronic Commerce Manager status bar is updated
when you select a single item from the middle pane.

left pane— Displays a list of all the restored interchanges, groups, and
Interchanges tree | documents. Also displays the time created and partner
name.
Note

To refresh the display of the Restored Interchanges
browser, press F5.

Reference
See the following for more information:

»  Archive information available to view on page 10 - 5
» Document level status icons on page 10 - 50

(Continued on next page)
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Restored Interchanges Browser

Part

Function

middle pane—

Displays detailed information about the document, group,

detailed list or interchange selected. The information displayed
depends on the level.

Note

» To select multiple items, press and hold the CTRL key
while selecting the items.

» To refresh the display of the Interchanges browser,
right-click the middle pane and select Refresh from the
shortcut menu (or press F5).

upper right Displays the data file used in translation (if this option is

pane—External
Data

selected from the View\Restored Interchanges menu).

Notes

» This option only available if a single item is selected
from the detailed list.

» This option is not available if the external data file
used in translation does not exist.

» When viewing raw-EDI or External Data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

middle right
pane—Gentran
Data

Displays the data in EDI format (if this option is selected
from the View\Restored Interchanges menu).

Notes

» This option only available if a single item is selected
from the detailed list.

» When viewing raw-EDI or External Data, you can
switch from Text to Hex format by selecting the
appropriate command from the View menu.

lower right
pane—Translator
Report

Displays a report of the actions the translator took on this
document and lists any EDI- or translation object-based
compliance errors (if this option is selected from the
View\Restored Interchanges menu).

Note
This option only available if a single item is selected from
the detailed list.

Reference
See Error Messages in the Administration Guide, for a
detailed explanation of translator reports.
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Document level  The following lists the status icons that the system may use at the document level
status icons  on the Restored Interchanges browser:

Status

Icon

Description

OK

(&3

(green) — Indicates that the documents are fully compliant
with the EDI standard and are eligible for further
processing.

NotOK

(red) — Indicates one of the following:

The document failed to comply with the EDI standard.
If this is the cause of the error, the errors will be
indicated on a translator report associated with the
document. Although the document is not fully
compliant, it is eligible for further processing.

The received document could not be associated with a
specific trading partner. If this is the case, the partner
listed for the document will be Unknown. To associate
this document and the other documents received in the
interchange with a partner, attach the documents from
the Interchange browser.

A suitable trading relationship or translation object
could not be associated with the document. Detailed
information concerning what information was used to
locate the relationship and/or the translation object will
be listed in the audit log. To correct this problem, a
valid relationship must be established using the Partner
Editor, and a valid export, print, or turn-around
translation object must be defined for that relationship.

A major error occurred while processing the
interchange, functional group, or transaction level
enveloping structures. This error may include header
and trailer control numbers that do not match, an
invalid trailer control count, or a control number
sequence checking error. If any of these errors occur,
they will be listed on the translator report for the
interchange containing the document

Duplicate

(yellow) — Indicates the document has the same name as
another document on the system.
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Viewing Restored Interchanges

Procedure  To view restored interchanges, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Restored
Interchanges.

System response
The system displays the Restored Interchanges Browser.

Note
To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press F5).

Do you want to filter the display of interchanges by status?

» Ifyes, see Filtering the Display of Restored Interchanges on
page 10 - 53.

» If no, continue with step 3.
Note

The Filter function enables you to filter the display of restored
interchanges by date, partner, and direction (inbound and outbound).

Select an interchange.

Use the following table to determine your next step.

IF you want to... THEN select...
view the content of a » Restored Interchanges from the
single selected View menu, and then
interchange in raw EDI » select Gentran Data from the
data format, submenu.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

(Continued on next page)

Gentran:Server for Windows User’s Guide

Gentran:Server for Windows — November 2005 ()



Viewing Restored Interchanges

Using Archive and Restore

Step

Action

(contd.)

view the corresponding
external data file,

Restored Interchanges from the
View menu, and then

select External Data from the
submenu.

Note

When viewing raw-EDI or external data,
you can switch from Text to Hex format
by selecting the appropriate command
from the View menu.

view the translator report
for a single selected
interchange,

Restored Interchanges from the
View menu, and then

select Translator Report from the
submenu.

print a selected
interchange or a summary
of interchanges,

Print from the File menu.

delete a selected
interchange and all
associated documents,

Delete from the Document menu.

Notes

If you delete an interchange with a
status of Queued, you receive a
warning that you must remove
specified messages from Out
Documents and from your trading
partner’s Inbox. If you proceed, you
are warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.

If you delete an interchange with a
status of Ready to send, you are
warned that if your partner bases
processing results on control number
sequencing, you should modify the
transaction, group, and interchange
control numbers.
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Filtering the Display of Restored Interchanges

Procedure  To filter restored interchanges by partner and/or date, complete the following

steps:

Step

Action

1

From the appropriate area of The Desk, select Restored
Interchanges.

System response
The system displays the Restored Interchanges Browser.

From the Commands menu, select Filter.

System response
The system displays the Interchange Filter Dialog Box.

Do you want the system to filter the display of interchanges by date
and time?

» Ifno, select the No Date/Time Checking check box and proceed
with step 6.

» Ifyes, clear the No Date/Time Checking check box and proceed
with step 4.

Use the Date From slide bar to select the beginning of the date range
from which the system should filter the display of interchanges.

Do you want the end date for the date range to always be the current
system date and time?

» Ifno, deselect the Always Current check box and move the Date
To slide bar to the end of the date range.

» Ifyes, select the Always Current check box.

Do you want to filter the display of restored interchanges by partner?
» If no, continue with step 7.

» Ifyes, select the partners that you want displayed from the
Partner list (which contains a list of all the partner profiles on
your system).

Note

The default display is all partners, but you can click partner profiles
to unselect them and change the display. Alternately, you can click
Unselect All Partners to clear all the partner profiles. You can then
click one or more profiles to select them. At least one partner must be
selected.

(Continued on next page)
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Step Action

7 Which direction do you want to filter the interchange?

Default
The default display is both inbound and outbound interchanges.
Click the Inbound or Outbound check box to clear the direction.

Note
At least one of the Direction check boxes must be selected.

8 Click OK.

System response
The system filters the restored interchange display based on the
criteria you selected.
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Viewing Restored Documents

Introduction  You can view the individual documents in an interchange as long as a screen entry
translation object for each document is available on your system.

Procedure To view the documents within a restored interchange, complete the following

steps:
Step Action

1 From the appropriate area of The Desk, select Restored
Interchanges.
System response
The system displays the Restored Interchanges Browser.
Note
To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select a document and proceed with the next step or double-click a
document to view it.
Note
You must have a screen entry translation object for this document
available on your system.

(Continued on next page)
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Step

Action

With a document selected, use this table to determine your next step.

IF you want to...

THEN select...

view a translator report of the
actions the translator took on
this document,

» Interchanges from the View
menu, and then

» select Translator Report.

view the content of a single
selected interchange in raw
EDI data format,

» Interchanges from the View
menu, and then

» select Gentran Data from the
submenu.

Note

When viewing raw-EDI or external
data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

view the related external data
of a single selected
interchange,

» Interchanges from the View
menu, and then

» select Related External Data
from the submenu.

Note

When viewing raw-EDI or external
data, you can switch from Text to
Hex format by selecting the
appropriate command from the View
menu.

print a selected document or
translation report,

Print from the File menu.

delete a selected document,

Delete from the Document menu.

copy the document to the
appropriate browser,

» Copy from the Document menu.

» select the appropriate browser
(?In Documents Browser or In
Documents Browser for
compliant Inbound documents;
Workspace Browser for
outbound documents) from the
submenu.
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Reprocessing Restored Documents

Introduction  To reprocess data from the Restored Interchanges browser, you must use the Copy
command to move the selected outbound documents to the Workspace and the
compliant inbound documents to the In Documents or ?In Documents browsers.

Procedure  To reprocess data, complete the following steps:

Step Action

1 From the appropriate area of The Desk, select Restored
Interchanges.

System response
The system displays the Restored Interchanges Browser.

Note

To refresh the display of the Interchanges browser, right-click the
middle pane and select Refresh from the shortcut menu (or press
F5).

2 Select the documents that you wish to copy to the Workspace
Browser, In Documents Browser, or ?In Documents Browser so you
can reprocess and/or resend them.

3 From the Document menu, select Copy.

4 Select the appropriate browser from the cascading menu to copy the
restored interchanges to that browser.
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Resending Restored Interchanges

Introduction  To resend outbound interchanges from the Restored Interchanges browser, you
must use the Resend command.

Note

You can only resend interchanges that were previously sent or that have a status of
Ready to send.

Resend process  The following table describes the process that occurs when you resend a selected
interchange.

Stage

Description

1

The restored interchange is listed in the Restored Interchanges
Browser.

Reference
See Filtering the Display of Restored Interchanges on page 10 - 53
for instructions.

When the resend command is executed, the system first determines if
it is a TRADACOMS interchange. If the interchange is
TRADACOMS, the system increments the current version number in
the FIL segment by one. After this update, the interchange is resent in
the same manner as all other interchanges.

Communication is established with the remote end. The status of the
message is updated based on the success or failure of the
communications session.

» Ifthe communication fails because there is no mailbox set up or
because the Mailbox service is not started, the interchange and
documents are left in a Ready to send status.

» If communication fails because there is no modem, the
interchange and documents are left in a Queued status.

Note
No user action is required at this point. Interchanges that failed to
send are automatically sent as part of the next transmission session.

After communication is successful, the documents are moved to the
Out Drawer Browser and the interchange status is set to Sent.
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Resending Restored Interchanges

Procedure  To resend restored outbound interchanges, complete the following steps:

Step

Action

1

From the appropriate area of The Desk, select Restored
Interchanges.

System response
The system displays the Restored Interchanges Browser.

Select the outbound interchange that needs to be resent.

From the Document menu, select Resend.

System response

The system displays the Gentran:Server for Windows dialog box.

Click Yes to start the transmission session.
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Introduction

Introduction

In this chapter

Process control
feature

Event creation
process

Using Process Control

This chapter explains how to use the Gentran:Server process control.

Process control feature enables you to automate your message processing.
Essentially, you need to tell the system what you want done and when, and
process control takes care of it for you automatically.

With process control, you can build customized events to initiate the processing
functions of Gentran:Server. These processing functions include the following.
» importing data from your application files

» exporting data to your application files

» sending

» receiving

In addition, file and process management functions can be executed that provide
additional flexibility in integrating your application with Gentran:Server.

Process control is regulated by events, which are a combination of what you want
done (a session) and when to process a session (calendar, days, a date, or based on
whether or not a file exists). The following describes the event creation process:

Stage Description

1 Create a process control session.

Reference
See Creating Sessions on page 11 - 9 for more information.

2 Create a process control calendar (if necessary).

Reference
See Creating and Editing Calendars on page 11 - 41 for more
information.

3 Create the process control event.

Reference
See Creating New Events on page 11 - 23 for more information.

4 Activate the event.

Reference
See Activating and Suspending Events on page 11 - 36 for more
information.
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Sessions

Overview

Introduction

What is a session
script?

Process Control

Overview

A session definition is an integral part of a process control event. The session
setup process enables you to configure and edit process control session scripts.
Sessions are defined independently from the event, so the same session definition
can be scheduled multiple times.

A session script consists of a list of commands (Gentran:Server functions) that the
system executes in the sequence listed. You can set parameters for each allowable
command. You can also place conditions on the command you choose. These

conditions determine whether or not the command is executed within the session.

You can specify two types of conditions: The system can query for the presence or
absence of a specific file; the system can determine whether or not documents
exist in a specific location. If the evaluated condition is true, the command is
executed. If the condition is false, the command is skipped and processing
continues with the next defined command.

The following illustrates the Sessions tab of the Process Control dialog box:

dialog box
(Sessions tab)
% Gentran:Server Process Control M= E3
Active Evenlsl Eventsl Calendars  Sessions |
AuditPurge [EREISEEE |S_l,lstem-.t’-‘-.uditF'urge N
Command | Parm1 | Farmz | Parm3 | Farmd Sae |
GO _Audit_Purge 3 WWRTETTE...
*+End Sonpts* Save fs |
IEfere |
1] | ]
Inz | Edit Delete e | [T |

[Earee| | Help
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Using Process Control

Sessions tab  The following lists the parts of the Process Control dialog box Session tab and

parts and their functions:

functions
Part

Function

(list)

Displays all currently defined session scripts.

Session

Displays the script of the currently-selected session.

Ins

Accesses the Action Setup dialog box so you can
insert a script command above the current line.

Edit

Accesses the Action Setup dialog box so you can
modify the selected script command.

Delete

Deletes the selected script command.

Up

Moves the selected command up one line in the
script.

Down

Moves the selected command down one line in the
script.

New

Accesses the New Session dialog box so you can
create a new session.

Save

Saves the current session script.

Save As

Saves the current session script under another name.

Delete

Deletes the selected session.
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Overview

Action Setup  The following illustrates the Action Setup dialog box:

dialog box

Action Setup

— Command Specification

Command

(]9

™ wiite bo Audit Log if execution time exceeds I minLkes

Cancel
Browse

Help

dilli)

— Condition
Condition

=

Action Setup  The following lists the parts of the Action Setup dialog box and their functions:

Function

Select which command you want to add to the script.

Note

Selecting a command allows you to access the
parameters for that command, which the system
displays in the Command Setup section.

dialog box parts
and functions Part
Command
Specification
Write to Audit Log if

execution time exceeds

Specify that the system write an audit message if the
command execution time exceeds the specified
number of minutes (next field).

Note

If a command exceeds the allotted time, the system
writes a warning message to the Audit Log and the
command continues to run until it completes.

minutes

Specify the number of minutes after which the
system writes a message to the Audit Log if the
command has not finished processing.

Condition

Select conditions for the command. These conditions
determine whether or not the command is executed
within the session.
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Commands  The following lists the script commands and their actions:

Note

See the Gentran:Server online Help for detailed information about these

commands.

Command

Action

Exec Program

Indicates a program for the system to run.

Note

When this command is executed, the system writes
an informational message to the Audit Log indicating
which program (command line in working directory)
was run.

Exec Program Ex

Indicates a program for the system to run and for
which the system will pass the Event ID and
controller name.

Note
This function is used by the Gentran:Server for
RosettaNet install program.

File Copy

Copies a file.

Note

When this command is executed, the system writes
an informational message to the Audit Log indicating
that the file copy was successful.

File Rename

Changes the name of a file.

File Delete

Removes a file from the system.

Note

When this command is executed, the system writes
an informational message to the Audit Log indicating
that the deletion of the file was successful.

GDW_ Archive

Performs the archive command according to the
specifications of a selected archive definition file.

GDW_Audit Rpt

Copies the audit records to a specified file.

(Continued on next page)

( Gentran:Server for Windows — November 2005

Gentran:Server for Windows User’s Guide



Using Process Control

Overview

Command

Action

GDW_Audit Purge

Deletes all audit records in the system.

Note

The purged Audit Log entries are removed from the
database and appended to a text file. To ensure that
the text file does not grow unchecked, you may want
to use a File Delete command prior to this command.

GDW_ Audit_Write

Writes a processing user audit message to the Audit
Log, based on the specified parameters.

GDW_Document
Purge

Removes document records from the Gentran:Server
database according to the specified age/date,
location, and/or status.

GDW_Document Rpt

Creates a specified file that contains document data
(as well as group and interchange data, if applicable)
for documents in the Gentran:Server database
according to the specified status, location, and/or
age/date.

GDW _Export

Performs the Export function and can perform the
send mailbox function to enable the output of an
inbound translation to be delivered back to the
Mailbox Server Manager.

Note
You must have an export translation object registered
with the system.

GDW_ExtData Delete

Deletes external data references based on the action
taken on the external data and/or age.

GDW_Import

Performs the Import function on a specified file.

Note
You must have an import translation object registered
with the system.

GDW _Partner Delete

Executes the partner delete command.

GDW _Partner Import

Executes the partner import command.

GDW _ Partner Export

Executes the partner export command.

(Continued on next page)
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Command

Action

GDW _Print

Performs the Print function.

Note
You must have a print translation object registered
with the system.

GDW _Process_File

Invokes the post-communications process with any
EDI file as if the file was received via a
communication session.

Note
You must have an export translation object registered
with the system.

GDW _Receive

Performs the Receive Only function.

GDW_Send

Performs an automated send for all partners and
mailboxes that have documents posted to be sent
(unless you specify a particular partner, mailbox, and
transaction combination).

GDW_Send_Receive

Performs the Send/Receive function. This function
does not wait for previously executed Send/Receive
sessions to finish; it executes the Send/Receive when
you specify.

Terminate Script

Terminates the script.

Conditions  The following lists the script conditions and their actions:

IF the condition is...

THEN it indicates that...

Location Below

If File Below Exists the system must look for the file you specify and then
execute the command based on whether the file is
found or not found.

If Docs Are In the the system must look for the documents in the

location you specify and then execute the command
based on whether or not the documents are found in
that location.
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Creating Sessions

Creating Sessions

Procedure  To create a process control session, complete the following steps

Step

Action

Creating a session

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

Click New.

System response
The system displays the New Session dialog box.

In the Session Name box, type in the new session name, using
alphanumeric characters.

Note
The dash (-) character is also allowed.

Click OK to add the new session.

Building the session script

With the new session currently selected, click Ins to insert a
command above the current line.

System response
The system displays the Action Setup dialog box. This dialog box
allows you to create script commands.

From the Command list, select a command.

Note

The Commands list allows you to select which command you want to
add to the script, which enables you to access the parameters for that
command (displayed below this box in the Action Setup section.

After you choose a command, additional boxes may be displayed in
the Command Specification section of the dialog box.

(Continued on next page)
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Step

Action

Complete the boxes in the Command Specification section of the
dialog box with the appropriate values.

Reference
See Commands on page 11 - 6 for more information.

Do you want to specify a limit (in minutes) on how long this
command should process before the system writes a message to the
Audit Log?

» Ifyes, select the check box and type the number of minutes in the
box.

» If no, continue with the next step.

Do you want to apply a condition to the command?

» Ifyes, select a condition from the Condition list.

» If no, continue with Step 8.

Note

Each script command can have an associated condition. These

conditions are evaluated just prior to execution of the command and
can be used to control the processing flow of your session.

After you choose a condition, the system displays two additional
boxes in the Condition section of the dialog box.

Complete the boxes in the Condition section of the dialog box with
the appropriate values.

Note

If you selected the If file Below Exists condition, you can use a
wildcard (*) to specify the name of the file for which you want the
system to check.

Did you specify conditional execution?
» Ifyes, you must also select True or False from the Result list.

» If no, continue with the next step.

Notes

» Ifyou select True, you are indicating that the command should
only be executed if there are documents in the specific location
or if the file is present.

» Ifyou select False, you are indicating that the command should
be executed only if there are no documents in the specific
location or if the specified file does not exist.

(Continued on next page)
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Step

Action

Click OK.

System response
The command is saved and you return to the Gentran:Server Process
Control dialog box.

Repeat Steps 1 through 8 until you finish adding commands to the
session script.

Notes
» Ifyou need to resequence the commands in the script, use Up
and Down.

» Ifyouneed to edit a command in the script, select that command
and click Edit.

» Ifyouneed to delete a command from a script, select that
command and click Delete.

Saving the session

Click Save to save the new session script.

Click OK to exit the Gentran:Server Process Control dialog box.
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Editing Sessions

Using Process Control

Introduction Ifan event calls a session that is currently processing or is activated, you are
unable to edit and save the session until the event has either finished processing or
you suspend the event. However, you can edit the session and use the Save As
function to save it under another name.

Reference
See Procedure. suspending an event on page 11 - 37 for more information.

Procedure To edit an existing session, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

Select a session to display the session script.

With the session selected, click Ins to insert a command above the
current line.

System response
The system displays the Action Setup dialog box.

From the Command list, select a command.

Note

The Commands list allows you to select which command you want to
add to the script, which enables you to access the parameters for that
command (displayed below this box in the Action Setup section.

Reference
See Commands on page 11 - 6 for more information.

(Continued on next page)
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Step

Action

Do you want to specify a limit (in minutes) on how long this
command should process before the system writes a message to the
Audit Log?

» Ifyes, select the check box and type the number of minutes in the
box.

» If no, continue with the next step.

After you choose a command, additional boxes may be displayed in
the Command Specification section of the dialog box. Complete
these boxes with the appropriate values.

If you want to apply a condition to the command, select a condition
from the Condition list.

After you choose a condition, the system displays two additional
boxes in the Condition section of the dialog box. Complete these
boxes with the appropriate values.

Note

If you selected the If file Below Exists condition, you can use a
wildcard (*) to specify the name of the file for which you want the
system to check.

10

When you specify conditional execution, you must also select True
or False from the Result list.

Notes

» Ifyou select True, you are indicating that the command should
only be executed if there are documents in the specific location
or if the file is present.

» Ifyou select False, you are indicating that the command should
be executed only if there are no documents in the specific
location or if the specified file does not exist.

11

Click OK.

System response
The command is saved and you return to the Gentran:Server Process
Control dialog box.

(Continued on next page)
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Step Action

12 Repeat Steps 4 through 11 until you finish adding commands to the
session script. Use Up and Down if you need to resequence the
commands in the script.

Note
» Ifyouneed to edit a command in a script, select that command
and click Edit.

» Ifyouneed to delete a command from a script, select that
command and click Delete.

13 Click Save to save the new session script.

Note
If you want to save the session under another name, click SaveAs,
type the new session name, and click OK.

14 Click OK to exit the Gentran:Server Process Control dialog box.
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Deleting Sessions

Introduction Ifan event calls a session that is currently processing or is activated, you are
unable to delete the session until the event has either finished processing or you
suspend the event.

Reference
See Procedure. suspending an event on page 11 - 37 for more information.

Procedure  To delete a session, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Sessions tab to access the sessions options.

System response
The system displays the Process Control dialog box (Sessions tab).

Select a session and click Delete.

System response
The Gentran:Server Process Control dialog box asks you to confirm
the delete operation.

Click Yes to delete the current selection.

Click OK to exit the Gentran:Server Process Control dialog box.
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Events

Overview

Introduction

Before you begin

Timed events

Polled events

Using Process Control

Events are a combination of the following:

» A time or day to execute or a file name for which the system checks
» The controller on which the event is processed

» A session definition

The Process Control runs events based on whether they are timed or polled. You
define the events in a session definition.

The Process Control enables you to process an event at a specified time, every
day. Additional options enable you to restrict processing to certain days of the
week or a specific date. In addition, you can define calendars to exclude specific
holidays or days of the week from the processing schedule.

You manage events by using the following dialog boxes:
» Process Control dialog box (Events tab)

» Event Setup dialog box
» Process Control dialog box (Active Events tab)

You must have already defined the session definition to be executed prior to
creating an event.

Reference
See Creating Sessions on page 11 - 9 for more information.

When a timed event is activated, the Gentran Scheduler initiates that event at the
correct time on the appropriate day or date.

When a polled event is activated, the Gentran Poller polls the controller for the
presence or absence of a defined file (depending on what is indicated in the event
definition), and initiates the event when the specified file either exists or does not
exist (based on the event definition).

6
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Process Control
dialog box
(Events tab)

Events tab parts
and functions

Overview

The following illustrates the Events tab of the Process Control dialog box:

f.& Gentran:5erver Process Control

Active Events  Events | Calendarsl Sessionsl

Description

| Time | Parameter

| Contraller | Time Started | Time Ende Hew

4]

Syztem-tuditP... 0000

SMTWTFS RTETTEM... 2A0/001Z00:414M  2/10/001

Bl
[E(Ete

Suzpend

Execute

| I3

Cantraller: |<.ﬂ.l| Controllers> ‘l

E B

Soart: IDescription *l |2D Seconds M Auto Refresh Refiesh

Cancel | Help |

The following lists the parts of the Process Control dialog box Events tab and their

functions:
Part Function
(list) Displays all scheduled events.
Controller Select the controller whose events you want filtered.
Sort Select how you want the list of events sorted.
IF you sort by... | THEN the events are listed...
description (the in alphabetic order of the event
default) descriptions.
controller in alphabetic order by controller.
Note
For each controller, the events are listed
in alphabetic order by event description.
status by currently processing events first (red

indicator), activated events second
(green indicator), and suspended events
third (yellow indicator).

Note
Within each status, the events are listed
in alphabetic order by event description.
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Part

Function

Seconds

Specify the interval (in seconds) at which you want the
system to refresh the dialog box (default is 20 seconds).

Auto Refresh

Indicate whether you want the Process Control dialog box to
automatically refresh (so you do not have to click Refresh).

New

Accesses the Event Setup dialog box so you can create a new
event entry.

Edit

Accesses the Event Setup dialog box so you can modify the
selected event entry.

Delete

Deletes the selected event entry.

Activate/
Suspend

» Ifaselected event is suspended (yellow indicator), the
Activate/Suspend toggle button reads Activate.

» Ifaselected event is activated (green indicator), the
Activate/Suspend toggle button reads Suspend.

Execute

Executes the selected event immediately, which allows you
to manually invoke an unattended session. This also enables
you to test a new event or an event that failed.

Notes

» Executing an event immediately using this button does
not replace the next scheduled run of the event.

» When you click this button, an informational message
box is displayed.

— If the selected event is scheduled to execute within
the next 30 minutes, you are notified when the event
is scheduled to run and prompted to specify whether
you want to run it now (click OK) or cancel the
request (click Cancel).

— Ifthe selected event is not scheduled to execute
within the next 30 minutes, you are prompted to
either confirm the request to execute it immediately
(click OK) or cancel the request (click Cancel).

Refresh

Refreshes the display of the Events tab.
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Event Setup  The following illustrates the Event Setup dialog box:

dialog box

Event Setup

]|

[escription I

Seszsion I

j .h Cancel |

[ Maotification Type Event

Cantroller IGENTH.&NMAEHINH Browse |

Timed | Poled |

Help

Tirne: Start I Lkl I

EYEY I mitiLkes

Calendar I

v Sun v Mon W Tue W wed W Thu ¥ Fi v Sat

=~

Diate I

Event Setup  The following lists the parts of the Event Setup dialog box and their functions:

dialog box parts
Description Enter a description of the event.
Session Select one of the sessions you defined on the
Sessions tab.
Controller Specify the name of the controller on which the event

1S run.

Notification Type Event

Designate this event as a “notify type,” which means
that the system executes it based on parameters set in
the Notification Log.

Note
Selecting this check box deactivates the Timed and
Polled tabs.

Timed tab

Start

Indicate the beginning run time of a session.

Note

You must enter the time in 24-hour HH:MM format.
If you do not enter the time in this format, the system
attempts to determine the correct 24 hour time from

what you entered.

(Continued on next page)
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Part

Function

Until

Specify a stop time for the event.

Note

You can either use 24-hour HH:MM format or
12-hour HH:MM or H:MM format with the
designator "a" (am) or "p" (pm).

Note

An event will always execute on its end time
regardless of the interval that is set. To have an event
execute once, do not enter an end time or interval.

Minutes

Specify an interval of time after which the event is to
be executed.

Example
If you specify "15" minutes, the event is executed
every 15 minutes.

Calendar

Select one of the calendars you defined on the
Calendars tab that you want the system to check
against when scheduling this session.

Notes

» A calendar allows you to specify days in each
month that you do not want the selected session
to be run.

» Ifyou use the Date box, you cannot use the
Calendar box.

Sun/Mon/Tue/Wed/
Thu/Fri/Sat

Indicate which days of the week the event is to be
executed.

Date

Specify a date on which the event is to be executed.

Notes

» You can enter this date in any format, but the
sequence of the date you enter must correspond
to the international Windows date formats (for
example, in the United State, dates must be
entered in month/day/year format).

» Ifyou select a calendar from the Calendar box or
days of the week, you cannot use the Date box.

(Continued on next page)
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Part Function

Polled tab

File name Specify the name of the file for which the system
checks.

Note
You can use a wildcard (*) to specify the name of the
file.

Browse Accesses the Choose Network Server dialog box so
you can browse for the file for which you want the
system to check.

Result Indicate whether the event should be executed if the
result is True or False.

Note

» Ifyou select True, you are indicating that the
event should be executed only when the specified
file is present.

» Ifyou select False, you are indicating that the
event should be executed only when the specified
file does not exist.

Process Control  The following illustrates the Active Events tab of the Process Control dialog box:
dialog box

. L& Gentran:5erver Process Control [_ [C] =]
(Active Events
tab) Active Events |Events| Ealendarsl Sessionsl
Ewent | EventID | Controlle  Session: |
Command | Parmi | Parmé | Parm3
1] | 2oL | 2l
Refresh Ewvents: IW seconds Refrezh Actions: |2_ zeconds ¥ uto Refresh
Ok | Cancel | Help |
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Active Events tab  The following lists the parts of the Process Control dialog box Active Events tab

parts and  and their functions:

functions
Part

Function

(Event list)

Displays the events that are currently processing.

(Session list)

Lists each command and the associated parameters
for the session script for the event that is currently
processing.

Note
A green arrow indicates which command the system
is currently processing.

Refresh Events seconds

Specify the default interval (10 seconds) for
refreshing the Active Events list. Valid values are 2 —
300 seconds.

Notes
» This value is saved when you change focus on
the dialog box (click another box).

» The Auto Refresh check box must be selected
(checked) for the Seconds boxes to be available.

Refresh Actions
seconds

Specify the default interval (2 seconds) for refreshing
the Sessions list. Valid values are 2 seconds — 300
seconds.

Notes

» This value is saved when you change focus on
the dialog box (click another box).

» The Auto Refresh check box must be selected
(checked) for the Seconds boxes to be available.

Auto Refresh

Indicate whether you want automatic refresh enabled.
The default is Enabled, which means that you do not
have to click Refresh.

Refresh

Manually refreshes the Active Events display.

Note

If the Active Events tab has not been refreshed after
an event has expired (is no longer active), the system
continues to display the event on the Active Events
tab (even though it is inactive), until the Active
Events tab is refreshed.
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Creating New Events

Introduction  You can specify that the event runs as timed or as polled. If the event is running as
“timed,” you must specify a time, a pre-defined calendar and/or days of the week
to run, or a date to run one time only. When it is time for the event to be run, the
Gentran Scheduler service initiates the processing of the event.

If the event is running as “polled,” you can specify a file name and whether the
event should run if the file exists or not. The Gentran Poller service polls the
process controller.

» Ifyou specified that the file must exist, the Gentran Poller initiates the
processing of the event when the file appears.

» Ifyou specified that the file must not exist, the Gentran Poller initiates the
processing of the event when the file no longer exists on the controller.

Procedure  To create a new event, complete the following steps:

Step Action

Creating a new event

1 Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

2 Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

3 Click New.

System response
The system displays the Event Setup dialog box so you can create a
new event entry.

4 In the Description box, type a description of the event.
5 From the Session list, select the session that you want to be executed.
6 In the Controller box, type or select the machine name of the

controller on which you want this event to be run.

(Continued on next page)
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Step

Action

Do you want to designate this event as a notification type?

» Ifyes, select the check box and continue with Step 2 in Saving
the event on page 11 - 26.

» If no, continue with the next step.

Complete this section if the event is timed

In the Time Start box (on the Timed tab), you must fill in a time.

Note
You must use 24-hour HH:MM format.

If you want to specify a stop time for the event, type that time in the
Until box (on the Timed tab).

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM or
H:MM format with the designator “a” (am) or “p” (pm).

Do you want to specify an interval of time after which the event is
run?

» Ifyes, in the Minutes box (on the Timed tab), type the number of
minutes after which you want the event to be executed and
continue with Step 4.

Example
If you specify 15 minutes, the event is executed every 15 minutes
from the start time.

» If no, continue with Step 4.

Do you want to use a predefined calendar?

» Ifyes, select that calendar from the Calendar list and continue
with Step 5.

» If no, continue with Step 5.

Note

A calendar enables you to specify the days in each month that you do
not want the selected session to be run. If you select a calendar, you
can also select specific days of the week on which you want this
session to run on. However, if you select a calendar, you cannot
specify a day in the Date box.

Reference
If you need to define a calendar, see Creating and Editing Calendars
on page 11 - 41.

(Continued on next page)
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Step

Action

Do you want to select a day or days of the week on which you want
this session to be scheduled?

» Ifyes, click the check box next to the days on which the event
should be run and continue with Step 6.

» If no, continue with Step 6.

Note

By default, every day of the week is selected. If any days are selected
in this section, then the schedule is executed only on those days. If
you select days from this section, you cannot use the Date box.

Do you want to specify a day in which you want this session to run
one time only?

» Ifyes, type that date in the Date box and continue with Saving the
event on page 11 - 26.

» If no, continue with Saving the event on page 11 - 26.

Note

This box enables you to specify a date on which this session should
run one time only. The system then removes the session from the
database. If you type a date in this box, you cannot select from the
days of the week check boxes.

Format

You can enter this date in any format, but the sequence of the date
you enter must correspond to the international Windows date formats
(for example, in the United States, dates must be entered in
MM/DD/YY format, and in the United Kingdom, dates must be
entered in DD/MM/YY).

Complete this section if the event is polled

Click the Polled tab on the Event Setup dialog box.

System response
The system displays the polled options.

In the File name box, complete only one of the following:

» Type the path and name of the file for which you want the system
to check.

» Click Browse to select the file from the appropriate drive and
directory.

Note
You can use a wildcard (*) to specify the name of the file.

(Continued on next page)
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Step Action

3 From the Result list, select True or False.

Note

» Ifyou select True, you are indicating that the event should only
be executed when the specified file is present.

» Ifyou select False, you are indicating that the event should be
executed only when the specified file does not exist.

Saving the event

1 Click OK.

System response
The event is saved and you exit the Event Setup dialog box.

2 Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Editing Events

Editing Events

Introduction  You are not able to edit an event unless the event is suspended.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To edit an existing event, complete the following steps:

Step

Action

Editing an event

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

Select the event that you want to modify and click Edit.

System response
The system displays the Event Setup dialog box.

If you want to modify the description of the event, type the new
description in the Description box.

If you want to select another session to be executed, do so from the
Session list.

If you want to change the controller on which you want this event to
be run, type the machine name in the Controller box.

Do you want to designate this event as a notification type?

» Ifyes, select the check box and continue with Step 2 in Saving
the event on page 11 - 30.

» If no, continue with the next step.

(Continued on next page)
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Step

Action

Complete this section if the event is timed

In the Time Start box (on the Timed tab), type a time.

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM
format with the designator “a” (am) or “p” (pm).

If you want to specify a stop time for the event, type that time in the
Until box (on the Timed tab).

Note
You can either use 24-hour HH:MM format or 12-hour HH:MM or

H:MM format with the designator “a” (am) or “p” (pm).

Do you want to specify an interval of time after which the event is
run?

» Ifyes, in the Minutes box (on the Timed tab), type the number of
minutes after which you want the event to be executed and
continue with Step 4.

Example
If you specify 15 minutes, the event is executed every 15
minutes.

» If no, continue with Step 4.

Do you want to use a predefined calendar?

» Ifyes, select that calendar from the Calendar list and continue
with Step 5.

» Ifno, continue with Step 5.

Note

A calendar enables you to specify days in each month that you do not
want the selected session to be run. If you select a calendar, you can
also select specific days of the week on which you want this session
to run on. However, if you select a calendar, you cannot specify a day
in the Date box.

Reference
If you need to define a calendar, please see Creating and Editing
Calendars on page 11 - 41.

(Continued on next page)
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Editing Events

Step

Action

Do you want to select a day or days of the week on which you want
this session to be scheduled?

» Ifyes, click the check box next to those days and continue with
Step 6.

» If no, continue with Step 6.

Note

By default, every day of the week is selected. If any days are selected
in this section, then the schedule is executed only on those days. If
you select days from this section, you cannot use the Date box.

Do you want to specify a day in which you want this session to run
one time only?

» Ifyes, type that date in the Date box and continue with saving the
event.

» If no, continue with saving the event.

Note

This box enables you to specify a date on which this session should
run one time only and then be removed from the database by the
system. If you type a date in this box, you cannot select from the days
of the week check boxes.

Format

You can enter this date in any format, but the sequence of the date
you enter must correspond to the international Windows date formats
(for example, in the United States, dates must be entered in
MM/DD/YY format, and in the United Kingdom, dates must be
entered in DD/MM/YY).

Complete this section if the event is polled

Click the Polled tab on the Event Setup dialog box.

System response
The system displays the polled options.

In the File name box, complete only one of the following:

» Type the path and name of the file for which you want the system
to check.

» Click Browse to select the file from the appropriate drive and
directory.

Note
You can use a wildcard (*) to specify the name.

(Continued on next page)
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Step Action

3 From the Result list, select True or False.

Note

» Ifyou select True, you are indicating that the event should only
be executed when the specified file is present.

» Ifyou select False, you are indicating that the event should be
executed only when the specified file does not exist.

Saving the event

1 Click OK.

System response
The event is saved and you exit the Event Setup dialog box.

2 Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Deleting Events

Deleting Events

Introduction  You are not able to delete an event unless the event is suspended.

Reference
See Procedure: suspending an event on page 11 - 37 for more information.

Procedure  To delete an event, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

Select an event and click Delete to delete the current selection.

System response
The Gentran:Server Process Control dialog box asks you to confirm
the delete operation.

Click OK.

System response
The event is deleted.

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Viewing Events

Events tab

Active Events tab

The Gentran:Server Process Control dialog enables you to view all the events
defined in your system.

On the Events tab, the following specifications are listed for each event:
» Event description

» Time

» Parameters (day of week if timed or result if polled)

» Controller on which the event runs

» Time started

» Time ended

» Session name

» Calendar name (timed events only)

» File name (polled events only)

Filtering event display

You can filter the display of events on the Events tab by the controller on which

the events are scheduled to run. You can also sort the events by description,
controller, and status.

The Active Events tab enables you to view only the events that are currently
processing. This feature also allows you to view currently processing system
events (such as temporary communication sessions).

Event list

On the Active Events tab, all currently processing events and the controller on
which each event are being processed are listed in the Event list (on the left side of
the dialog).

Session list

The Session list (on the right side of the Active Events tab) displays the session
script for the event that is currently selected in the Events list. The Session list
also contains all of the parameters for each command. This detailed view enables
you to see which programs are currently being executed by the Gentran
Executive. The session command that is currently being processed is indicated
with a green arrow.
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Viewing Events

Procedure:  To view all events, complete the following steps:

viewing all events

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog
box.

Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

If you want to filter events by the controller on which the events are
run, select that controller from the Controller list.

Use the following table to select the appropriate sort key from the
Sort list.

THEN select this from
IF you want to sort by... the Sort list...

the events listed in alphabetic order of | Description.

the event descriptions
Note

This is the default.

the events listed in alphabetic order of | Controller.
the controller

the events listed by: Status.

1. currently processing events (red
indicator)

2. blocked events (green indicator
with red “x”)

3. activated events (green indicator)

4. suspended events (yellow
indicator)

(Continued on next page)
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Step

Action

If necessary, change the Refresh options:

» If you want to change the interval in which the dialog box is
automatically refreshed, type the interval (in seconds) at which
you want the system to refresh the dialog box (the default is 20
seconds) in the Seconds box. Valid values are 2 — 300 seconds.

Note

This value is saved when you change focus on the dialog box
(click another box). The Auto Refresh check box must be
selected (checked) for the Seconds box to be available.

» Ifyou do not want the Events tab on the Gentran:Server
Process Control dialog box to automatically refresh (so you
have to manually click Refresh), click the Auto Refresh check
box to deselect it.

Note
The default for automatic refresh (so you do not have to click
Refresh) is enabled (checked).

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.

Procedure To view active events, complete the following steps:

viewing active

events Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

From the Event list, select the event for which you want to view
further detail.

Note

The system displays each command and its associated parameters in
the session script for that event in the Session list. The session
command currently being processed is indicated with a green arrow.

(Continued on next page)
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Viewing Events

Step

Action

If necessary, change the Refresh options:

If you want to change the interval in which the dialog box is

automatically refreshed, type the interval (in seconds) at which
you want the system to refresh the dialog box (the default is 20
seconds) in the Seconds box. Valid values are 2 — 300 seconds.

Note

This value is saved when you change focus on the dialog box
(click another box). The Auto Refresh check box must be
selected for the Seconds box to be available.

If you do not want the Active Events tab on the Gentran:Server
Process Control dialog box to automatically refresh (so you have
to manually click Refresh), click the Auto Refresh check box to
deselect it.

Notes

The default for automatic refresh (so you do not have to click
Refresh) is enabled (checked).

The default interval for refreshing the Event list is 10 seconds.

The default for refreshing the display of the Session list is 2
seconds.

If the Active Events tab has not been refreshed after an event has
expired (is no longer active), the system displays the event on the
Active Events tab (even though it is inactive), until the Active
Events tab is refreshed.

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Activating and Suspending Events

Introduction  The Events tab of the Gentran:Server Process Control dialog enables you to
change the status of an event by activating or suspending the event. The indicator
in the far left column of the list on the Events tab registers the status of the event.
The indicator can be one of the following colors:

» Red—the event is currently executing and you are not able to edit the event
until processing completes.

» Yellow—the event is suspended (and is not processed until activated).

» Green—the event is activated for processing.

» Green with red “x”—the event is activated for processing but is currently
blocked because the number of currently processing events is equal to the
limit of events that may concurrently execute.

Reference

See How to Change Controller Settings in the Administration Guide for more
information about setting a limit for the number of process control events that can
execute concurrently.

Procedure:  To activate an event, complete the following steps:

activating an
event Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

Select the suspended event that you want to activate and click
Activate.

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Activating and Suspending Events

Procedure:  To suspend an event, complete the following steps:

suspending an

event Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Process Control dialog box (Active Events
tab).

Click the Events tab to display the event options.

System response
The system displays the Process Control dialog box (Events tab).

Select the activated event that you want to suspend and click
Suspend.

Note
If an event is currently processing, you are not able to suspend it until
processing has terminated.

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Executing an Event Immediately

Introduction  The Events tab of the Gentran:Server Process Control dialog enables you to
execute the selected event immediately. This function allows you to manually
invoke an unattended session and also enables you to test a new event or an event
that failed.

Procedure To execute an event immediately, complete the following steps:
Step Action

1 Click Process Control on The Desk.
System response
The system displays the Process Control dialog box (Active Events
tab).

2 Click the Events tab to display the event options.
System response
The system displays the Process Control dialog box (Events tab).

3 Select the suspended event that you want to execute immediately
and click Execute.
System response
Use this table to determine the system response.
IF the system displays this
message... THEN you should...
This event is scheduled to » Click OK to run the event
execute next at <scheduled immediately.
time>. Do you want to run it OR
now anyway? » Click Cancel to cancel the
Run <event name> request (the evenF will execute
. . at its scheduled time).
immediately?

4 Click OK.
System response
The system exits the Gentran:Server Process Control dialog box.

6
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Calendars

Overview

Introduction

Process Control
dialog box
(Calendars tab)

Calendars tab
parts and
functions

Gentran:Server for Windows User’s Guide

Overview

The process control Calendar feature enables you to configure system calendars
that excludes specific dates (such as holidays) or days of the week from
processing.

Like session definitions, these calendars are defined independently from the
event, so that they can be “attached” to multiple event entries. The calendar begins
with the current month and year.

The following illustrates the Calendars tab of the Process Control dialog box:

[ Gentran:Server Process Control I 3
Active Events | Events Calendars | Sessions |
Calendar: |In\-'0ic:e Mew
Drders —February 2000 - Excluds
Sum Mon Tue  Wed Thur  Fii Sat ™ Sunday il
1 2 34 ]
= ™ Monday &l
[ 7 g 9 wm oMn 12
™ Tuesd Delete |
13014 15 e 17 18 14 uesaay
20 21 22 A S 26 [ wednesday
27 28 23
~ W Thursday
[ Friday
LLPTesonE Memts > [ Saturday

[Fafize] Help

The following lists the parts of the Process Control dialog box Calendars tab and
their functions:

Part Function
(Calendars list) Displays a list of all defined calendars.
(Calendar) Displays the current month of the selected calendar.
(Continued on next page)
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Part

Function

Previous

Displays the previous month in the calendar.

Note
This button is only activated if a calendar is selected
and a previous month exists for the calendar.

Next

Displays the next month in the calendar.

Note
This button is only activated if a calendar is selected.

Exclude

Select which days of the week to exclude from
processing. These are displayed with red Xs through
them.

New

Accesses the New Calendar dialog box so you can
create a new calendar.

Save

Saves the current calendar.

Note
The Save command is only active if a calendar is
displayed in the middle of the dialog box.

Save As

Saves the current calendar under another name.

Note
The Save As command is only active if a calendar is
displayed in the middle of the dialog box.

Delete

Deletes the selected calendar.

6
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Creating and Editing Calendars

Procedure To create or edit a calendar, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Calendars tab.

System response
The system displays the Process Control dialog box (Calendars tab).

Do you want to create a new calendar?

» Ifyes, click New.

System response
The system displays the New Calendar dialog box.

» Ifno, select the calendar that you want to edit and continue with
Step 6.

System response
The system displays the calendar in the center of the Calendars
tab.

In the Calendar Name box, type the new calendar name using up to 8
alphanumeric characters.

Click OK to add the new calendar.

System response
The system displays the new calendar in the middle of the Calendars
tab.

Do you want to exclude a specific date from processing?

» Ifyes, click that date on the calendar and continue with Step 7.
» Ifno, continue with Step 7.

Note

The system displays a mark for that date on the calendar to signify

that it is excluded from processing. Click Previous or Next to access
the preceding or succeeding calendar months in the calendar.

(Continued on next page)
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Step Action

7 Do you want to exclude a specific day or days of the week?

» Ifyes, select the check box in the Exclude section for each day of
the week that you want to exclude from processing and continue
with Step 8.

» If no, continue with Step 8.

Notes

» You can select one or more days of the week on which you never
want processing to occur.

» The system allows you to exclude all seven days of the week, if
that is your intention. In this situation, processing never occurs.

» To deselect a day, clear the check box.

8 Click Save to save the new calendar.

9 Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.
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Using Process Control

Deleting Calendars

Deleting Calendars

Procedure  To delete a calendar, complete the following steps:

Step

Action

1

Click Process Control on The Desk.

System response
The system displays the Gentran:Server Process Control dialog box.

Click the Calendars tab.

System response
The system displays the Process Control dialog box (Calendars tab).

Select a calendar and click Delete to delete the current selection.

System response
The Gentran:Server Process Control dialog box asks you to confirm
the delete operation.

Click Yes to delete the current selection.

Click OK.

System response
The system exits the Gentran:Server Process Control dialog box.

Gentran:Server for Windows User’s Guide
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Deleting Calendars Using Process Control
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?2In Documents

?20ut Documents

acknowledgement

ack

AIAG

ANA

ANSI

application
system

asynchronous

audit log
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GLOSSARY
Glossary

This browser contains a list of documents that were received by the system but
failed compliance checking or that do not have an identifiable partner or
transaction set.

This browser contains a list of documents that were imported into the system but
are invalid.

Indicates the ANSI 997 functional acknowledgement, the EDIA 999 acceptance/
rejection advice, and the EDIFACT CNTRL.

This function enables you to manually change the status of documents in the Out
Drawer to “Ack’d” (acknowledged).

The Automotive Industry Action Group (AIAG) is the standards-setting group for
the automotive industry. The standards form a subset of the ANSI X12 standard.

Article Numbering Association.

American National Standards Institute. ANSI sets standards for many products
and services. The ANSI X12 committee is the main EDI standards-setting
organization for the United States.

Computer systems designed to fulfill specific business functions. These include
accounting, purchasing, materials control, human resources, shipping, and other
systems.

Communication among distributed processes in which data can be transmitted
intermittently rather than in a steady stream.

This function enables you to view system audit log information.
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authorization

browser

click

cluster

communications

session

Communicator

compliance

compliant

component data

element

Permission to access a protected resource, service, or sensitive information.

A window that displays a list of items, such as documents (transaction sets),
interchanges, or translation objects. A document browser displays only
documents.

Indicates that you should position your cursor on top of the designated item and
press and release your primary mouse button. The primary mouse button is the
button you access with your index finger, regardless of whether you are using
right-handed or left-handed mouse operation.

A set of computers that work together to provide a service. The use of a cluster
enhances both the availability and scalability of the service. The Windows
operating systems provide a software solution for clustering multiple computers
running networked client/server applications.

Everything sent and received to/from one telephone number in one continuous
period of connection. This could include sending two or three interchange
envelopes to a network, each for a different trading partner.

The Gentran:Server communications software. The Communicator enables you to
send, receive, resend, establish communication port definitions, establish
communication profiles, establish communication scripts, and view and delete
communication sessions.

An implementation is compliant if and only if it fully meets each and every
requirement of the standards specification. Specifically, each transaction, action,
or data element produced by the implementation must be valid as defined by the
standard. Compliance testing is the act of comparing the operation of an
implementation against the specified requirements to determine compliance or
noncompliance.

This means that the document conforms to the EDI standards as defined by the
translation object.

A simple data element that belongs to a composite data element. Component data
elements are also called sub-elements.

6
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composite data A data element that is made up of multiple component elements.
element

cryptographic  Cryptographic keys are central to cryptographic operations and must be kept
keys  secret because whoever possesses a particular key has access to any data with
which the key is associated. For example, if a key is used to encrypt a file, anyone
with a copy of that key can decrypt the file. Furthermore, anyone possessing a key
used to sign messages can forge that message signature.

copy This function enables you to copy one or more documents from the Out Drawer to
the Workspace.

data-view  The following are data-view windows in the Gentran:Server:
windows ),  Aydit Log
» Document Tracking
» Interchange Tracking
» Raw data-view of an interchange

» Raw data-view of a document

default A predefined value. Programs use these built-in values unless you specifically
override them.

Desk, The  This is a graphic representation of Gentran:Server that provides an easy way to
access some of the most commonly used browsers, functions, and subsystems of
Gentran:Server. You can click the appropriate part of The Desk any time you need
to access a browser, function, or subsystem represented there. The following are
the browsers you can access:

» In Documents

» ?In Documents

» Workspace

» Out Documents
» ?0ut Documents
» Interchanges

» In Drawer

» Out Drawer
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dialog box

digital certificate

digital signature

Each browser icon displays a graphic representation of paper if the document
location contains documents. The Desk also allows you to access the Partner
Editor subsystem, the Help system, the Process Control function (clock icon), and
the Send/Receive functions (phone icon), and allows you to quit Gentran:Server
(EXIT/door icon).

You can turn the display of The Desk off by clicking The Desk on the View menu.
This toggles the display of The Desk “on” and “off.” A checkmark next to that
item means it is “on.”

A dialog box (or dialog) contains additional information or options that you need
to act on. If you specify any options, you can select a button to execute the
command. Some dialog boxes display warnings or messages indicating why a
requested task cannot be accomplished. If the dialog box has a title bar, you can
move it to another location on your desktop. To close a dialog box, double-click
the Control menu box or select Close Active Window from the File menu.

A digital certificate is a common credential that provides a means to verify
identity. A certificate is a set of data that identifies an entity. A trusted
organization assigns a certificate to an individual or an entity that associates a
public key with the individual. The individual or entity to which a certificate is
issued is known as the subject of that certificate. The trusted organization that
issues the certificate is a Certification Authority (CA) and is known as the
certificate’s issuer. A trustworthy CA will only issue a certificate after verifying
the identity of the certificate’s subject. The data in a certificate includes the public
cryptographic key from the certificate subject’s public/private key pair.

The essence of public key encryption is that your data is encoded with a complex
mathematical formula that returns two keys. Data encrypted with the first key can
only be decrypted with the second key and data encrypted with the second key can
only be decrypted with the first. You distribute your first key as a public key that
anyone can have and keep your second key as a private key that no one but you
has access to. The reciprocal relationship between the keys allows anyone to
encrypt data with your public key, and then you can decrypt it with your private
key. No one else has access to the data once it is encrypted, including the person
who encrypted it. Similarly, you can encrypt data with your private key, and then
anyone can decrypt that data with your public key. Although this makes the data
freely available, but it ensures that only you could have created it.
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document  One transaction set containing data and treated as a single entity. The amount of
data does not affect whether something is a document or not, only the fact that it is
treated as a single entity. For example, regardless of whether a purchase order
contains one item or ten thousand items, if it is one purchase order, it is one
document.

If a trading partner sends you a communication containing 10 purchase orders,
you have received 10 documents. If the communication contains 15 invoices, you
have received 15 documents.

double-click  Indicates that you should position your cursor on top of the designated item and
quickly press and release your primary mouse button twice. The primary mouse
button is the button you access with your index finger, regardless of whether you
are using right-handed or left-handed mouse operation.

DTD A DTD (document type definition) is a type of schema used to specify the
structure and semantics of an XML document or message.

EANA  International Article Numbering Association, based in Brussels, Belgium.

EDI  Electronic Data Interchange (EDI) is the process by which companies can
exchange business documents directly from application to application by
computer without paper documents being produced.

EDI standard  The rules for translating a business document into an EDI document.

EDIA  The Electronic Data Interchange Association, formerly known as the
Transportation Data Coordinating Committee (TDCC).

EDIFACT  Electronic Data Interchange for Administration, Commerce, and Transport.

element  The smallest piece of usable information defined by the standards. Examples
might include a quantity, unit price, or description.

An individual element can have somewhat different meanings depending on
context. Therefore, elements are normally not considered to have useful meaning
until they are combined into segments.
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There are three types of data elements, as illustrated in the table below:

Data Element Definition
Simple data element A single piece of information defined by the
standards.
Composite data element A data element that is made up of multiple

component elements.

Component data element A simple data element that belongs to a
composite data element. Component data
elements are also called sub-elements.

envelope A way of separating information in transmissions for ease of processing. Each
envelope contains a header segment and a trailer segment, which separate the
envelope from other envelopes and provide information about the contents of the
envelope. There are three levels of envelopes:

Transaction Set
Each transaction set (business document) is contained within a transaction set
envelope.

Functional Group
An envelope containing related business documents. The standards define which
transaction sets should be placed together into a functional group envelope.

Interchange Envelope

All material being sent to one trading partner in one communication. The term
Interchange Envelope is the term used by ANSI. EDIA uses the term
Transmission Envelope to refer to this level of envelope. Since we use the term
transmission for other uses, we refer to Interchange Envelope only.

Note

A communications session could easily include a number of interchange
envelopes. For this reason, the standards-setting bodies are considering a fourth
level of envelope to cover an entire communications session.

export  This function enables you to write a document or documents to an external file for
processing by another application. There must be a system or a partner-specific
export translation object for the document.
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fail over

find

functional group

header

import

In Documents

In Drawer

interchange

Interchanges
browser

label
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A failover system is a backup operation that automatically switches to a standby
database, server, or network if the primary system fails or is temporarily shut
down for servicing. Fail over is an important fault tolerance function of mission-
critical systems that rely on constant accessibility. Fail over automatically (and, to
the user, transparently) redirects requests from the failed or down system to the
backup system that mimics the operations of the primary system.

This function enables you to find specified text in the active data-view window.

A group of transaction sets that the standards-setting body (such as ANSI) has
defined as fitting together with other related transaction sets. For example, a
Functional Group may be defined as containing all purchasing transaction sets.

Control information prepended to data content, normally used to describe the data
or the relationship of the data with the applications.

This command enables you to import data from an external application file.
Depending on the content of the file, the system may prompt you for partner,
transaction, or translation object information.

This browser contains a list of documents that the system received but that have
not yet been processed by the user. Once the documents are processed (printed or
exported), they are transferred to the In Drawer.

This browser contains a list of documents that were received and processed.

Contains all functional groups of documents (transaction sets) sent from one
sender to one receiver in the same transmission.

This browser enables you to view a hierarchical list of all the interchanges that
were sent or received. It contains status information about the interchanges (such
as whether or not a functional acknowledgement was received and the status of
that acknowledgement). This browser also enables you to access the documents
within the interchanges. The Interchanges browser can always be accessed.

Descriptions of information that can be almost anything on a translation object
that is not an element, a keyword title, or an information indicator. They can also
be used as information dividers, such as a line of dashes.
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menu

menu bar

move

network

non-repudiation

ODETTE

Out Documents

Out Drawer

partner

Partner Editor

A list of actions from which you can choose. Unavailable items on a menu are
dimmed to inform you they are disabled.

Displays the list of menus for the application.

This functions enables you to move a document or group of documents either
from In Documents or ?In Documents to the In Drawer or from ?Out Documents
to the Workspace.

Also known as a Third Party Network or Value-Added Network (VAN). A
service, such as Sterling Information Broker, that accepts and holds transmissions
from companies until it is convenient for a trading partner to accept them.

Non-repudiation is the ability of a message transfer system to provide unforgeable
evidence that a specific action occurred. The following are the three most
common types of non-repudiation services:

» Non-repudiation of origin—Protects against any attempt by a message
originator to deny sending a message.

» Non-repudiation of submission—Protects against any attempt by a message
transfer agent to deny that a message was submitted for delivery.

» Non-repudiation of delivery—Protects against any attempt by a message
recipient to deny receiving a message.

The Organization for Data Exchange by Tele-Transmission, based in Europe.

This browser contains a list of documents that are ready to be sent. After the
documents are successfully sent, they are automatically transferred to the Out
Drawer.

This browser contains a list of documents that were successfully sent by the
system.

Another firm with which your company trades documents. Also referred to as a
trading partner.

This function enables you to define, edit, and delete partner information for your
company and your trading partners.
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post

predefined

print

printout

receive

respond

responsible
agency

segments

send

This function enables you to move compliant documents from the Workspace to
Out Documents.

On a data entry translation object, a default value for a particular element. You can
change the value as necessary.

This command enables you to print a formatted or unformatted version of the
selected documents using the print translation object set up in the partner
relationship for those documents. This command also enables you to print a
summary list of the documents.

Produced when data received from a trading partner passes through a print
translation object. You do not have to print the data; it can be “printed” to a file on
your hard disk.

This function enables you to manually initiate a communications session to
receive data from your trading partner.

This function enables you to create a turnaround document (using the Turn
Around translation object in the partner relationship) in response to one or more
selected documents in the In Drawer.

An organization that develops and updates standards for EDI communications.
These organizations include ANSI, EDIA, AIAG, UCS, and VICS.

A number of elements combined to communicate useful data. For example, a
catalog price segment might consist of elements for item description, volume,
price, and lead time. By themselves, none of these elements would communicate
useful information. Together, they provide useful information. Segments are
defined by the EDI standards. A number of segments together form a transaction
set.

This function enables you to manually start a communications session to send data
to your trading partner. Only selected documents are enveloped and sent. If no
documents are selected, a/l documents are sent. Successfully sent documents are
moved to the Out Drawer.
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Send Queue  This function enables you to display a list of documents currently queued to be
sent.

set See Transaction Set.

sort  This function enables you to sort the list of documents in a document browser into
one of the following sequences:

» partner/type/name
» partner/name/type

» type/partner/name

status  The processing stage of a document or interchange, indicated in the “Status” box.

?In Documents

NotOK All documents in the ?In Documents have this status. This code
indicates one of the following:

» The document failed to comply with the EDI standard. If this is
the cause of the error, the errors are indicated on a translator
report associated with the document. Despite the fact that the
document is not fully compliant, it is eligible for further
processing.

» The received document could not be associated with a specific
trading partner. If this is the case, the partner listed for the
document in question is “Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchanges browser.

» A suitable trading relationship or translation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
translation object is listed in the audit log. To correct this
problem, a valid relationship must be established using the
Partner Editor and a valid export, print, or turn-around translation
object must be defined for that relationship.

» A major error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the translator report for the interchange containing the
documents.
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?0ut Documents
NotOK This code indicates that the document does not comply with the
EDI standard definition. The errors that are causing the
compliance failure can be determined by viewing the translator
report for the document.

In Documents

OK All documents in the In Documents have a status of “OK.” These
documents are fully compliant and are eligible for further
processing.

In Drawer
OK This code indicates that the documents are fully compliant with

the EDI standard and are eligible for further processing.

NotOK All documents in the ?In Documents have this status. This code
indicates one of the following:

» The document failed to comply with the EDI standard. If this is
the cause of the error, the errors are indicated on a translator
report associated with the document. Despite the fact that the
document is not fully compliant it is eligible for further
processing.

» The received document could not be associated with a specific
trading partner. If this is the case, the partner listed for the
document in question is “Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchanges browser.

» A suitable trading relationship or translation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
translation object is listed in the audit log. To correct this
problem, a valid relationship must be established using the
Partner Editor and a valid export, print, or turn-around translation
object must be defined for that relationship.

» A major error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the translator report for the interchange containing the
documents.

Interchanges

The Interchanges browser contains graphics that represent the interchange process
status, interchange network status, interchange, group, document
acknowledgement status, and document compliance status. When you highlight
an entry in the Interchanges browser, an explanation of the status codes for that
line is displayed in the Gentran:Server status bar.
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Interchange Process Status
Received (green) Indicates that the interchange was received by the system.

Sent (green) Indicates that the interchange was successfully
transmitted to the appropriate partner.

Ready to Send
(blue) Indicates that an attempt was made to send this
interchange, but the communication session was not successful.
This interchange will be sent during the next appropriate
communication session.

Queued  Indicates that the document is queued to be sent.
Hold Indicates that the document is on hold (not sent).

Overdue Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement but has exceeded the
number of hours by which that acknowledgement is deemed late.

Send Failed (red) Indicates that the send attempt failed due to an error during
the communications process.

Interchange Network Status

On Network
Indicates that the interchange was successfully delivered to a
value-added network (VAN). (To obtain this status using Sterling
Information Broker, you must have your mailbox configured to
receive the 20 report in data format).

Network Warning

Indicates that the interchange was delivered to a VAN, which detected non-critical
errors in the data. The data is available to be picked up by the designated trading
partner. (To obtain this status using Sterling Information Broker, you must have
your mailbox configured to receive the 20 report in data format).

Network Error

Indicates that the interchange was delivered to a VAN, which detected critical
errors in the data. The data is not available to be picked up by the designated
trading partner. (To obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 20 report in data format).

Picked Up

Indicates that the interchange was successfully delivered to a trading partner
through a VAN. (To obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 70 report in data format).

Transmitted to third-party network
Indicates that the interchange was transmitted to a third-party network.
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Interchange, Group, and Document Acknowledgement Status

Waiting

Overdue

Rejected

Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement.

Indicates that the interchange is waiting to be reconciled with an
inbound functional acknowledgement but has exceeded the
number of hours by which that acknowledgement is deemed late.

Indicates that the interchange was acknowledged by your partner
and there were errors. The interchange was rejected by your
partner.

Acknowledged

Indicates that the interchange was acknowledged by your partner
and there were no errors.

Acknowledged with Errors

Indicates that the interchange was acknowledged by your partner
and there were errors. It was accepted by your partner in spite of
the errors.

Partially Acknowledged

Indicates that the interchange was successfully received by the
trading partner and some of the documents within the interchange
were accepted or accepted with errors and other documents
within the interchange were rejected.

Document Compliance Status

B oK

Ll NotOK
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This code indicates that the documents are fully compliant with
the EDI standard and are eligible for further processing.

This code indicates one of the following:

The document failed to comply with the EDI standard. If this is
the cause of the error, the errors are indicated on a translator
report associated with the document. Despite the fact that the
document is not fully compliant it is eligible for further
processing.

The received document could not be associated with a specific
trading partner. If this is the case, the partner listed for the
document in question is “Unknown.” To associate this document
and the other documents received in the interchange with a
partner, attach the documents from the Interchange browser.

A suitable trading relationship or translation object could not be
associated with the document. Detailed information concerning
what information was used to locate the relationship and/or the
translation object is listed in the audit log. To correct this
problem, a valid relationship must be established using the
Partner Editor and a valid export, print, or turn-around translation
object must be defined for that relationship.
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» A major error occurred while processing the interchange,
functional group, or transaction level enveloping structures. This
error may include header and trailer control numbers that do not
match, an invalid trailer control count, or a control number
sequence checking error. If any of these errors occur, they are
listed on the translator report for the interchange containing the
document.

E Duplicate The document has the same name as another document on the
system.

Out Documents

OK This code indicates that the document is fully compliant with the
EDI standard. Documents with this status can be sent.

Out Drawer

Sent This code indicates that the document was successfully
transmitted to the appropriate partner.

Waiting  This code indicates that the document is waiting to be reconciled
with an inbound functional acknowledgement.

Overdue  This code indicates that the document is waiting to be reconciled
with an inbound functional acknowledgement, but has exceeded
the number of hours by which that acknowledgement is deemed
late.

Ack’d This code indicates that the document was acknowledged by your
partner and there were no errors.

AckErr This code indicates that the document was acknowledged by your
partner and there were errors, but it was accepted by your partner
in spite of the errors.

Reject This code indicates that the document was acknowledged by your
partner and there were errors. The document was rejected by your
partner.

~Ack This status is only displayed if there were no acknowledgements

expected for this document and either the group or the
interchange was partially acknowledged. If your partner is going
to issue partial acknowledgements at the interchange or group
level, he/she should also indicate acceptance or rejection at the
transaction level.

OnNet This code indicates that the document was successfully delivered
to a VAN. (To obtain this status using Sterling Information
Broker, you must have your mailbox configured to receive the 20
report in data format).
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PickedUp

NetWarn

NetErr

Send Queue
Queued

This code indicates that the document was successfully delivered
to a trading partner through a VAN. (To obtain this status using
Sterling Information Broker, you must have your mailbox
configured to receive the 70 report in data format).

This code indicates that the document was delivered to a VAN,
which detected non-critical errors in the data. The data is
available to be picked up by the designated trading partner. (To
obtain this status using Sterling Information Broker, you must
have your mailbox configured to receive the 20 report in data
format).

This code indicates that the document was delivered to a VAN,
which detected critical errors in the data. The data is not available
to be picked up by the designated trading partner. (To obtain this
status using Sterling Information Broker, you must have your
mailbox configured to receive the 20 report in data format).

This code indicates that the document was successfully
interchanged in preparation for sending, but the interchange was
not transferred correctly to your partner. The interchange will be
automatically sent in the next communication session with this
partner.

Ready to Send

Send Failed

Workspace
OK

NotOK

Indicates that a document is ready to send but a mailbox message
has not yet been created for the data.

Indicates that the send attempt failed due to an error during the
communications process.

This code indicates that the document is fully compliant with the
EDI standard. Documents with this status can be posted to Out
Documents and sent.

This code indicates that the document does not comply with the
EDI standard definition. You can determine the errors that are
causing the compliance failure by viewing the translator report
for the document.

status bar  The status bar of an application window defines information about a selection,
command, or process, defines Menu Bar items as the user highlights each item,
and indicates any current keyboard-initiated modes for typing (such as CAP for
the “Caps Lock” key or NUM for the “Num Lock” key).
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synchronous

TDCC

translation object

third-party
network

title bar

toolbar

track

TRADACOMS

A mode of coordination of communication among distributed processes that
requires request-reply pairs to occur within the bounds of a specified time interval
in which the communication session is “live.”

See EDIA.

A predesigned layout set up to ensure that input or output for a particular
transaction set exists and is presented in a usable fashion. You must specify which
translation objects are used by each partner relationship.

Inbound Translation Objects

Turn Around: This translation object is used when a document is received to
create the natural response document that contains as many elements from the
received document as possible.

Export File: This translation object indicates that when a document is received, it
is exported to a specified file format.

Print: This translation object is used to print documents.

Outbound Translation Objects
Import: This translation object is used to import data from an application file.

Print: This translation object is used to print documents.

Data Entry: This translation object is used to enter data into the Document Editor
facility.

See Network.

The title bar of an application window contains the name of the application and
enables you to move the window to another position on your desktop.

Contains buttons that graphically represent commands available in the Menu Bar.
This function displays tracking information for a single selected document.

This function displays tracking information for a single selected document.

The U. K. standards for EDI that are published by the Article Numbering
Association (UK), LTD.
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trading partner

transaction set
(document)

turnaround
document

turnaround map

UCsS

UnPost

version

view

VICS

Workspace

X12
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Another company with which your company trades documents. Also referred to
as a partner.

A business form as defined by the standards. Examples include an ANSI 850
purchase order or an UCS 880 invoice. The standards define each transaction set
in terms of the segments and elements that make up the form, the order in which
they appear, and the relationships among them. This is also known as a “message”
in Europe.

A document into which data elements from the source document have been
automatically transferred using a turnaround map.

A series of instructions that the system uses to create a turnaround document (a
logical response document to the source) from an inbound (source) document, by
transferring data from the source document to elements in the target document
(translation object).

The Uniform Communications Standard is the standard used by the grocery
industry.

This function enables you to move a document previously posted to the Out
Documents back to the Workspace for further processing.

A formal update of an EDI standard. Each standards-setting body updates its
standards on a regular basis.

For documents, this function enables you to display the raw EDI data, a formatted
document using a translation object, or a translator report, depending on the
format selected. For interchanges, this function enables you to display the raw
EDI data or a translator report, depending on the format selected.

The Voluntary Inter-industry Communication Standards is the standards-setting
body for the retail industry, a subset of ANSI X12.

The Workspace contains a list of outbound “Work in Progress” documents. It also
contains recently imported or data entry documents.

The ANSI committee that sets and publishes standards for EDI.
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